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What’s new in MxMC 2.7.2?

Improved Management of Smart Data Sources
The Smart Data sources management now has new improvements:

 n Multiple cameras can be added as one Smart Data source,

 n Filter events by time periods within a time interval.

See Smart Data Sources and Searching in the Smart Data Search View, p. 167.

Formatting SD Cards of Devices from the Cameras Toolbar
SD Cards in MOBOTIX cameras can be easily formatted in the camera settings. 

See Components View - Camera Toolbar  , p. 278.

Define User Rights on Event Types
Now user rights can be granted to certain event types.

See Event Handling: Select the events the user should be able to handle:, p. 245.

What’s new in MxMC 2.7.2?
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Support

Support
If you need technical support, please contact your MOBOTIX dealer. If your dealer cannot help you, he will 
contact the support channel to get an answer for you as quickly as possible.

If you have internet access, you can open the MOBOTIX help desk to find additional information and software 
updates. Please visit:

www.mobotix.com > Support > Help Desk
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Basics/Introduction 
This chapter provides an overview of the features in MxMC and provides guidance on using 
the online help. You will also find explanations of the program structure and operating 
concept of MxMC.

MxManagementCenter Function Overview
MxManagementCenter is a video management software for setting up and using a complete 
video surveillance system that offers a variety of features for different tasks and user 
groups:

Area Features

Camera Man-
agement

Unlimited number of cameras, definition of hierarchical camera groups, 
different system environments (e.g., with different network addresses)
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Live Video Sur-
veillance

Display of individual cameras and freely definable grid views (with up to 
80 cameras simultaneously), user-defined graphics and info views, auto-
matic camera switching (camera sequencer and group sequencer), multi-
monitor support (number of available display devices can be further exten-
ded with MxThinClient devices), manual recording of live images (live 
recorder)

Alarm Pro-
cessing

Visual and audible alerting to new events, alarm filtering (specific alarms 
for specific types of alarms), background monitoring of cameras

Research, Ana-
lysis and 
Recording 
Playback

Search and playback for individual cameras in the Playback view, time-syn-
chronized search for several cameras simultaneously (grid playback), spe-
cial search view with the latest alarm images of selected cameras, 
research and playback of data directly using the camera or via direct con-
nection to the file server, fast display of the latest alarm images during live 
display (instant playback), subsequent distortion correction of hemi-
spheric camera images, special search functions (subsequent video 
motion detection, histogram, Smart Data System) 

Smart Data 
System, p. 
167

Use the Smart Data Search View to search all recorded events and related 
images.

Data Export Export of single or multiple time ranges in the recording at the same time, 
export of the data by the camera or via direct connection to the file server, 
export of individual image areas (subsequent PTZ), export at variable 
frame rates, resolution with and without audio

Door Station 
Functions

Bell signaling and live two-way communication, open doors and switch 
lights, play back mailbox messages

Security Func-
tions

Definition of users and user rights, supervisor function (dual control), sys-
tem security check, health check 

Special Pro-
gram Func-
tions

Softbuttons for executing special functions, action logs, remote control

Program Oper-
ation

Fast switching between different views with different functions, fast dis-
play of cameras via drag & drop, touchscreen operation supported, vari-
ous program behavior settings
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Camera Feature Overview

MxMC allows MOBOTIX MOVE cameras and third-party cameras providing an ONVIF-S/G-compatible interface 
to be integrated and operated. However, the full range of MxMC features is not available for all camera types.
The following table briefly lists the functions that be used with the different camera types.

Function MOBOTIX 
Camera

MOBOTIX MOVE Camera ONVIF-S/G Camera

Camera Configuration yes no no

Alarm Processing yes no no

Recording Access unlimited only via MOBOTIX NAS only via MOBOTIX NAS

Recording Playback unlimited only forward playback only forward playback

Export unlimited only as MJPEG and H.264 (H.264 
with corresponding license)

only as MJPEG and H.264 (H.264 
with corresponding license)

Smart Data Search yes no no

Special Search Functions
        (post-VM, histogram, 
Smart Data)

yes no no

Check System Security yes no no

PTZ Camera 
PTZ

mechanical PTZ mechanical PTZ

Subsequent Equalization of 
Hemispherical Images

yes no no

Live Recorder yes no no

Camera Groups unlimited group functions group functions

Door Station Functions and 
        Switching Functions

yes no no

MxThinClient Devices yes no no

Snapshots yes no no

Working With The Live View

The Live view allows you to control the live images of individual cameras. This also includes switching various 
functions, e.g. opening doors or switching lights.

Basics/Introduction
MxManagementCenter Function Overview
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Showing Cameras

Fig. 1: Showing cameras

To view a camera, you can use the Device or Camera bar. To do this, either drag and drop the desired camera 
from the Device bar into the display area or click on the desired camera in the Camera bar. The displayed 
camera is marked with a yellow bar in the Device bar as well as in the Camera bar.
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Customizing Image Settings

Fig. 2: Customizing image settings

Use the Brightness  and Contrast  controls to adjust the image display of the displayed camera to the 

current environment.
Move the corresponding slider upwards or downwards. The new settings are stored automatically for the cur-
rent camera. The default values can be restored by double-clicking on the corresponding slider.

NOTE! Adjusting the image settings does not have any effect on the camera settings. These will not be 
changed

Basics/Introduction
MxManagementCenter Function Overview
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Performing PTZ Actions

Fig. 3: Performing PTZ actions

NOTE! On a secondary monitor, a single camera image can only be zoomed with the mouse wheel or 
panned with the mouse button pressed down. PTZ controls are only available on the MxMC main screen or 
on the secondary monitor in Grid View.

To better identify objects in an image section, you can zoom the live image and move the resulting image 
area around (PTZ). To facilitate quick loading of these image sections, several image positions are already 

pre-configured for loading using the slider .

The program also shows the  slider on Dual cameras. Use this slider to show the live images of either the 

right, the left or both image sensors.

When showing the live images of hemispheric cameras, you can configure different display modes (slider ).

Zooming and Moving Image Sections
You can zoom using the slider  or the mouse wheel. Zooming with the slider takes place only on the com-

puter. This means that only the image section of the current live image is modified.
To see other image sections, you can move the live image using the mouse.

If you want to execute the PTZ actions on the camera, you can also switch to camera PTZ. In this case, the 
PTZ actions are applied to the camera's live image and also influence the recordings (but only if the camera 

does not record the full image). To use this feature, click on the slider  and keep it pressed until it starts 
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flashing. You can now adjust the zoom level as needed. To store the setting, click again on the slider and keep 
it pressed until the slider stops flashing.

Selecting and Adjusting Image Sections
Selecting Image Sections

To quickly focus on a specific image section, you can use one of the factory default image positions that are 
predefined in the camera. 

 n Preview , detail , overview  and point of interest 

 n Top , bottom , left , right 

The camera will then move to the selected position. Note that the PTZ actions are executed on the camera 

and also influence the recordings (only if the camera does not record the full image).  Move the  slider to 

the next position or until you have found a suitable position.

Adjusting Image Sections

You can adjust the pre-defined image positions of the factory default. Select a position and modify it as 
needed. Keep the slider on this position until it flashes once. The new image section has been stored.

Choosing a Sensor
If you want to show the live images of only the right or the left image sensor, you can move the  slider to 

the right to  (left sensor) or further to the right to  (right sensor).

Correcting The Distortion Of Hemispherical Images
When showing the live images of hemispheric cameras or cameras with the lenses L12/B016, L23/B036, 
L25/B041, you can select different display modes. This requires that you enabled OpenGL in the settings 
(Mac: MxManagementCenter > Settings > General menu; Windows: File > Settings > General menu). In 
order to get naturally-looking images, the camera will automatically correct the distortion in these modes. 
This distortion correction can be refined even further when using the panorama correction. The selection of a 
display mode is always done locally and thus does not influence the camera settings. However, the selection 
is also applied to the other program views. When selecting a display mode in the live view for a specific cam-
era, this mode is also applied if the camera shows up in the focus window of the Grid view as well as in the 
live images of the Graphic view. Consequently, the alarm images in the Alarm bar and in the Smart Data 
Search View are also shown in the selected display mode.

Selecting The Distortion Correction Mode

 n  Full image: Shows the entire (distorted) full image.

 n  Normal: Shows a distortion-corrected image and allows executing PTZ actions. 

Basics/Introduction
MxManagementCenter Function Overview
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 n  Panorama: Shows the entire distortion-corrected image (corrected 180° panorama) from the left to 

the right border. The aspect ratio (width to height) is 8:3. 

 n  Surround: This option shows four image sections (one for each cardinal direction: N, E, S, W) in one 

joint view. Note that you can use PTZ actions to modify all four views independently from one another.

 n  Double panorama: This mode shows a panorama view for the North half of the image and a 

second panorama view of the South half of the image using an aspect ratio (width to height) of 4:3. 
This mode makes sense for a hemispheric camera that is mounted to the ceiling. It can be sub-
sequently customized to use local PTZ.

 n  Panorama focus: This display mode combines the panorama view (aspect ratio 8:3) with two smal-

ler images (each with aspect ratio 4:3) in one large image.

To select a mode, move the slider  to the right until you reach the desired position. This slider position will 

be stored automatically until you change it again.

Panorama Correction

The distortion-corrected images of the different display modes can be further refined. For example, if the 
image in Panorama mode is not centered, you may see a trapezoidal distortion. The panorama correction 
allows adjusting the skewed (vertical) lines of the image to produce a more naturally-looking image. To do so, 

move the  slider to the right to  and use the mouse to correct the image. To store the corrected setting, 

click on the  slider and hold it until the slider icon briefly appears in the center of the image.

Status Display
The Status bar displays different states by means of icons. The status displays always refer to the displayed 
camera. This gives you an up-to-date overview, e.g., showing you at a glance whether a door has been closed 
again or is still open.
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Fig. 4: Status display

Icons in the Status Display

Door Status Dis-
play

 door is closed.

 door is open.

 door is locked.

 door lock switch is locked, but the door is open! 

Light Status Dis-
play

 light is off.

 icon is lit: Lights are on, needs to be switched off manually. 

Microphone Status 
Display

 microphone is switched off, no announcement possible.

 microphone is on, announcements are possible.

 microphone connection is blocked, possibly because a connection has been estab-

lished to a different remote station. 

Switching additional devices via Softbuttons
Softbuttons can be used to switch additional devices or to send HTTP requests. 

Basics/Introduction
MxManagementCenter Function Overview
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Fig. 5: Switching additional devices via Softbuttons

To execute a Softbutton, click on   to open the Softbutton menu, then click a Softbutton accordingly.

To edit Softbuttons see Softbuttons Settings.

Manually recording live images
In the Live view as well as in the Grid view, you can start manual recording at any time, such as when you 
observe a suspicious situation that should be recorded. While you keep track of the situation in the live 
image, the images are recorded and saved as a MXG file. 
   Users with administrator rights can specify where the clips are saved and how long the recordings can be in 
the Program Settings (Mac: MxManagementCenter > Preferences > Live Recorder menu, Windows: File > 
Settings > Live Recorder menu).

NOTE! This feature is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an 
ONVIF-S-compatible interface. For an overview of how the camera functions differ, see Camera Feature 
Overview.             

Audio can only be recorded with the Live Recorder under these conditions:

 n Audio transmission must be activated on the camera side.

 n In the Live View of MxManagementCenter, the audio connection must be activated by clicking on .
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Fig. 6: Manually recording live images

Starting And Stopping Recordings

To start recording, click on Live Recorder . Recording will stop automatically after the recording time set 

in the program settings has expired. Just before this time expires, a message will be displayed. You can stop 
the recording from within this message or extend the set period of time. To stop recording before the time 

expires, click on  again.

NOTE! If you change the view, the recording is automatically stopped. However, a camera change within 
the Live view does not stop the recording.

Play Clip

The live image data is stored in a MXG file at the location specified in Program Settings during recording. The 
clip file is automatically imported into the current project when the recording stops and the Device bar shows 

it alongside the  icon in the Clips section. You can click on the clip name to playback the MXG clip file via 

the Device bar.             

Working With the Graphic View

You can define a floor plan (ground plan) in the Graphic view and place the cameras or camera groups 
according to their actual positions. The icon of the corresponding camera turns red in case of an alarm (or 

Basics/Introduction
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green upon a bell event). A simple click is enough to show the current live image of the triggering camera, 
allowing you to quickly check the situation.

Temporarily showing the live image of a camera
To temporarily display the live image of a camera, move the mouse pointer over the camera icon. In addition, 
the live image of another camera group can also be displayed in the Graphic view. Drag & drop the desired 
camera from the Camera bar onto the floor plan. When changing the view, the live image disappears.

Automatically display all live images of a group
To keep track of all live images in the current group, you can activate the camera sequencer or the group 
sequencer. When the sequencer is activated, all live images of the camera group are displayed one after 
another in a small window. You can move this window to any location and enlarge it or make it smaller. 

Camera Sequencer

If you want to see a different camera in the focus window, simply drag that camera to the focus window. Note 
that the camera sequencer can also switch cameras automatically.

Instructions:

 1. Click on the camera sequencer icon  to activate the automatic switching. 

 2. Right-click on  to change the following settings:

 n Duration Slider: Move the slider to the desired duration (1 sec to 60 sec) to show each camera.

 n Autostart: Once you switch to the Grid view, the sequencer starts automatically.

 n Stop at event: The sequencer stops when an event has occurred, allowing you to further investigate 

the situation. To start again, click on .

 n Restart after confirmation: Activate this option if you want to avoid having to restart the sequencer 
over and over again.

Group Sequencer

If you want to display a different camera group in the focus window, drag and drop that camera group into 
the focus window. A grid with all cameras of the group will be displayed and each camera of the group will be 
shown sequentially in the grids focus window for a defined time. You can automate this camera group change 
with the group sequencer.

Instructions:

 1. Click on the group sequencer icon  to activate the group sequencer.

 2. To change the sequencer settings right-click on :
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 n Duration: set the duration to show each group. You can set a value between 1 sec and 60.  The “Com-
bined Sequencer”  activates the group sequencer together with the camera sequencer (“Autostart” on 
the camera sequencer is not needed). The group sequencer waits until all cameras on a grid or graphic 
have been cycled before switching to the next group. When the “Combined Sequencer” is active then 
the camera sequencers “Stop at Event” and “Restart after Confirmation” also apply to the group 
sequencer.

 n Autostart: Once you switch to the Grid view, the group sequencer will start automatically.

Switching group functions
At the bottom of the program window is a Command bar with controls that change depending on the selec-
ted view. In the Graphic view, you can use the group buttons of the Command bar to control the functions of 
a camera group (Prerequisite: Group functions were assigned in the Group Functions dialog box). This means 
that you can switch on/off lights, open a door and make an announcement for a predefined camera of this 
group, regardless of the currently displayed camera. You can also assign the functions for switching on/off 
lights and opening doors to several cameras of this group, enabling you to switch on/off several lights or 
open several doors.
    In addition, you can right-click on the group buttons to open the shortcut menu in order to control cameras 
that are not part of the current group. Before you can do this, the cameras have to be set up accordingly, that 
is, they need to be connected to door openers/light contacts and have to be configured properly.

Fig. 7: Switching group functions

Basics/Introduction
MxManagementCenter Function Overview
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Smart Data System

With the MOBOTIX Smart Data System, transactions in MxMC can be linked to the video recordings made at 
the time of the transactions. Use the Smart Data Search to search all recorded events and related images. You 
can filter the results by all kinds of events.  You can reduce the results to the events you have marked as 
"important". The search results are displayed as list and/or as preview images including camera name, time 
stamp and type of event trigger. You can play back the recording to an event directly from the event image. 
From the Smart Data Search View you can easily access  the Playback View or the Export View (see Searching 
in the Smart Data Search View, p. 167).

NOTE! In order to use the MOBOTIX Smart Data System for third party systems - e.g. cash point systems, 
you must purchase a Smart Data License. No license is required for P7 IoT App data. The MOBOTIX IoT App 
Interface is integrated into MxMC by default.

NOTE! The Smart Data Search View is not available for MOBOTIX MOVE cameras and third-party cameras 
that provide an ONVIF-S-compatible interface. For an overview of how the camera functions differ, see Cam-
era Feature Overview, p. 9.

Exporting Recordings

Using the Playback view, you can export recorded video data from one camera, while the Grid Playback 
allows exporting from several cameras at once. Use the Export bar to combine several clips to one export. You 
can save individual images with the Snapshot function.

Saving Snapshot Images
Snapshot images can be created in the Live and the Playback views for the displayed camera, and in the Grid 
view and Grid Playback for all displayed cameras.
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Fig. 8: Saving Snapshot Images

To do so, click on the Snapshot  button in the Command bar. By default, images are saved in the image 

folder of the user account. The destination path and the image settings for saved images can be selected via 
the MxManagementCenter > Settings > Snapshot Images (Mac) or File > Settings > Snapshot Images (Win-
dows) menu item.

Exporting Camera Recordings
The Playback view allows setting a time range for a recording (event recording or continuous recording) in 
order to select it for exporting.

 1. Open the Playback view.

 2. Drag the desired camera from the Camera bar or the Device bar.

 3. Find the start of the relevant recording.

 4. Specify the export range. There are two possibilities for this export:

Select export range using visual markers:

 1. Mark the start of the clip by clicking on the gray flag on the left .

 2. Play the recording until you have reached the end of the clip you want to export. Mark the end of the clip 
by clicking on the gray flag on the right. Both flags are now green.

 3. Click on Export  and select the export profile.

Basics/Introduction
MxManagementCenter Function Overview
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 4. The Export dialog box appears. Select a target folder and enter a file name.

Manually capture export range:

First, make sure that no export area has yet been set using the "export flag." If an export area has already 
been defined, you can delete it. Do so by right-clicking on a flag and selecting Delete Time Range.

 1. Click on Export . Then click on the desired export profile ① . The dialog box used for defining the 

export range appears.
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 2. Specify the export range ② .

 3. Click on OK and then on Save.

NOTE! If you select the Automatically Import After Export checkbox in the Export dialog, the exported 
clip will be automatically added to the Camera bar and in the Device bar to the Clips & Recordings section.

Exporting Camera Group Recordings
The Grid Playback allows for setting a time range for a recording (event or continuous recording) in order to 
select it for exporting from multiple cameras.

 1. Open the Grid Playback.

 2. Drag & drop the desired camera group from the Group bar or the Device bar.

 3. Find the start of the relevant recording for the camera in the focus window. At the same, the search is 
extended to the other cameras in the group, and the recordings with the closest relevance to those in the 
focus window recording will be displayed in the tiles.

 4. Specify the export range. There are two possibilities for this export:

Basics/Introduction
MxManagementCenter Function Overview

23 / 350



Basics/Introduction
MxManagementCenter Function Overview

Select export range using visual markers:

 1. Mark the start of the clip by clicking on the gray flag on the left .

 2. Play the recording until you have reached the end of the clip you want to export. Mark the end of the clip 
by clicking on the gray flag on the right. Both flags are now green.

 3. Instead of exporting all cameras of this group, you can also select one or more cameras for exporting. To 

do so, right-click on Export . A circle appears on the camera images in the top left corner. Select the 

desired cameras by clicking on the corresponding circles ① .

 4. Then click on Export  and select the export profile ② . The Export dialog box appears.

Fig. 9: Select export range using visual markers

 5. Select a target folder and enter a file name.

Manually capture export range:

Make sure that no export area has yet been set using the "export flag." If an export area has already been set, 
you can delete it. Do so by right-clicking on a flag and selecting Delete Time Range.

 1. Before you define the export range, you can limit the selection if you do not want to export all of the 

recordings that appear in the tiles. To do so, right-click on Export . A circle appears on the tiles in the 

top left corner. Select the desired cameras by clicking on the corresponding circles ① .
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 2. Click on Export  and select the export profile ② . The dialog box used for defining the export range 

appears.

Fig. 10: Manually capture export range

 3. Specify the export range ③ .

 4. Click on OK and then on Save.

NOTE! If you activate the Automatically Import After Export option, the exported clips are automatically 
added to the Group bar.

Exporting Recordings From The Export Bar
The Export bar provides a quick and easy way to take camera recordings and MXG clips by dragging and drop-
ping and create a list of recordings for subsequent exporting. From the bar, you can export recording time 
ranges as combined clips. You can add the clips in the Playback view, in Grid Playback and in the Smart Data 
Search View. After an export, the clips are not deleted automatically. It is deleted when the program is closed.

Adding Clips for Exporting in the Playback View

 1. Drag the desired camera or the desired clip from the camera bar or from the Device bar.

 2. Find the recording you are interested in.

Basics/Introduction
MxManagementCenter Function Overview
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Fig. 11: Adding Clips for Exporting in the Playback View

 3. Mark the start of the time range by clicking on the gray flag on the left . Play the recording until you 

have reached the end of the clip you want to export. Mark the end of the time range by clicking on the 

gray flag on the right . Both flags are now green ① .

   You can set the end marker first (gray flag on the right), then play the recording from the beginning so 
you can set the start marker (gray flag on the left) at the desired point.

 4. Click on the image of the recording and maintain the position until you see a scaled-down image of the 
recording ② .

 5. Drag this image to the Alarm bar (regardless of whether or not it is open). The Export bar will open auto-
matically, allowing you to save the image there.

Adding Clips for Exporting in Grid Playback

The Export bar in Grid Playback is useful for combining sequential time ranges of different cameras.

 1. Drag the desired camera to the focus window in the grid and find the relevant recording.

 2. Mark the start of the time range by clicking on the gray flag on the left . Play the recording until you 

have reached the end of the clip you want to export. Mark the end of the time range by clicking on the 

gray flag on the right . Both flags are now green.
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 3. Click on the image of the recording in the focus window and maintain the position until you see a scaled-
down image. Drag this image to the Alarm bar (regardless of whether or not it is open). The Export bar 
will open automatically, allowing you to save the image there.

 4. After you have set the end marker of the time range, the recordings of all other cameras will reposition to 
show the same time. Drag the camera with the next recording in the sequence of events into the focus 
window. Mark the start and the end of the clip as described above, then drag the recording into the 
Export bar.

 5. Repeat these steps until you have added all recordings you want to export.

You can also add time ranges from several cameras in the Export bar.

 1. Simply drag the desired camera group from the Group bar or from the Device bar and search for the rel-
evant recording.

 2. Mark the start and the end of the clip as described above. The recordings of the other cameras will repos-
ition accordingly.

 3. Right-click on Export . A selection box with a checkmark appears in the top left corner of the record-

ings. If you do not want to add the recording range of a specific camera to the list, uncheck the selection 
box for that camera.

 4. Click on the image of the recording in the focus window and maintain the position until you see a scaled-
down image. Drag this image to the Alarm bar (regardless of whether or not it is open). The Export bar 
will open automatically, allowing you to save the image there. The selected clips will be copied to the 
Export bar.

 5. Repeat these steps until you have added all time ranges you want to export.

You can also add clips for the individual preview images of the selected transaction to the Export bar:

 1. Drag the transaction preview image in the Preview Image section and drop it on the Export bar.

Basics/Introduction
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NOTE! If the following image is shown in the player view, there is no video data saved for the selected 
export period.

Fig. 12: No video data available for export

Editing Clips
If you have added a recording to the Export bar for which you previously used distortion correction or zoom 
features during playback, you can choose to export the clip with or without zoom. Likewise, you can export 
the clip with or without audio. To do so, move the mouse pointer over the recording in the Export bar. Three 
icons appear:

28 / 350



 

 n : Clip is exported with zoom.

Click on  to export the clip without zoom. The icon is disabled.

 n : By default, the clips are exported with audio (provided that audio had been recorded).

To export without audio, click on . The icon is disabled.

 n : Note that you can play back the individual clips directly in the Export bar before exporting.

Click on   to do so.

Right-click on a clip to open a context menu with these functions: Manually adjust time range, activ-
ate/deactivate audio and zoom for all clips, duplicate a clip, delete one or all clips.

Exporting Clips
Click on Export , then select MOBOTIX to export an MXG clip. Select a different profile to create an AVI, 

MP4 or MKV file. However, depending on the data source (e.g. MOBOTIX NAS) not all export profiles are avail-
able.
    Select a destination path in the Export dialog and enter a file name. Activate the Automatically Import After 
Export checkbox in the file selection dialog to automatically add the MXG clips to the Export bar after export-
ing.
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Operate Door Stations

Door Stations can also be integrated and operated with the MxManagementCenter. For this purpose, Door Sta-
tion-specific functions are provided in addition to the program functions for cameras.

NOTE! Door Station functions are not supported by MOBOTIX MOVE cameras and third-party cameras that 
provide an ONVIF-S/G-compatible interface. For an overview of how the camera functions differ, see:   

 n Camera Feature Overview, p. 9.

 n Door Station Settings, p. 209

Bell Signaling
If someone rings the doorbell, it can be indicated in different places of the application.
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Where? Explanation

Alarm bar 
and Alarm 
Info bar

A bell event is indicated by coloring the Alarm and Alarm info bar green. The prerequisite for 
this is that the Door Station bell events have been configured as alarms in the Camera Con-
figuration dialog. The Alarm bar ①  is located at the bottom of the MxManagementCenter and 
the Alarm Info bar ②  below the camera image of the corresponding door camera.
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Where? Explanation

Doorbell 
notification

When the bell is rung, a ringing notification is displayed, no matter which view you are in. The 
prerequisite for this is that the Door Station bell events were configured as alarms in the Cam-

era Configuration dialog and that the Notification  was not deactivated in the header.

NOTE! 
The notification can be temporarily disabled by an administrator by clicking on Notification 

 in the application header.
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Where? Explanation

Counter on 
the bell icon

The counter next to the bell icon  in the Live view is increased by one.

Setting Bell Signaling
Go to Door Station Settings, p. 209 to find out which signaling options can be combined and where they can 
be configured.

Open Door and Switch Lights
If the door camera has been set up properly, you can use MxMC to open the door and to switch the lights. To 

do this, use the  and  keys in the Live view Command bar and in the Command bar of the Grid view 

focus box.

Checking System Security

After completing the basic configuration of the system, it is recommended to check its security.  The Secure 
System Wizard is in the  Camera Toolbar of the The Components View, p. 61. It analyzes the security settings 
of the cameras and assesses their status based on common best practices. If test criteria are not met, pos-
sible measures to protect the cameras are provided. 

NOTE! The system security check feature is not available for MOBOTIX MOVE cameras and third-party cam-
eras that provide an ONVIF-S/G-compatible interface. For an overview of how the camera functions differ, 
see    Camera Feature Overview, p. 9   .
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Verifying Settings for System Security

 1. In menu View open the Components View.

 2. Select the desired cameras ① .

 3. In the Camera Toolbar ②  click  Secure System. The following criteria are checked:
 n Usage of the "meinsm" password with standard or ONVIF user accounts on MOBOTIX cameras. It is 

easy for cyber attackers to guess the standard "meinsm" password.

 n Enabled Public Access: If Public Access is enabled, a number of different camera functions can be 
used without a password.

 n Activated HTTP web server: It is possible for data, including user data such as passwords and images, 
to be transmitted via the network without encryption when HTTP is used. 
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The result of the check is displayed for each camera in the Secure System dialog. It will also show all cases in 
which cameras were not checked due to a connection error, for example.

Status Explanation

 Not secured There was at least one criterion that was listed as not secure.

 Software too 

old

Please check the camera software and update it, if necessary.

 Connection 

error

Check your network connection to the camera and perform the security check again. 

 Not supported The camera (s) cannot be analyzed or secured using the wizard.

 Secured Camera is secure; no further action is necessary.

 4. In the Secure System dialog, click on Next. Cameras resulting in a Not secure status are displayed 
together with whichever of the three criteria that were fulfilled as well as the measures that need to be 
taken to properly secure the cameras: 

Criterion Explanation

Password Changes the password of all user accounts on the cameras that use the standard “meinsm” 
password. It also include ONVIF users whose passwords have never been changed.
      Enter a new password and confirm it. A suitable password has at least eight characters. It can 
consist of lowercase and uppercase letters, digits and special characters (see ). If you set a 

password that does not meet these criteria, a red frame appears around the text field. The 
frame turns green once you have entered a valid password.
     The new password is automatically entered in the MxMC project data. 

SSL encryp-
tion

Disables camera connections via unencrypted HTTP and configures the cameras to accept 
HTTPs connections only.
      The TCP port and the SSL setting will be automatically updated in the MxMC project data, if 
necessary. 
      The TCP port will not be updated for cameras that are connected via a remote URL. For 
remote URL connections, you may need to change port forwarding in the router to the appro-
priate setting.
Please note that different services, such as network messaging etc., will no longer work when 
you disable HTTP. 

Public 
Access

Disables access that does not require password entry to the web interface and the APIs of the 
cameras. 
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 5. Click on OK in the dialog box. The selected security measures will be performed. The security status for 
the selected camera or camera group will be analyzed once again and the result for each camera is dis-
played. 

Working With The Grid View

The Grid view consists of a grid of live images and one focus window. This grid (tile) structure is ideal for get-
ting a quick overview of all cameras of a group. You can drag the camera image that is most interesting to 
you onto the focus window. Use the controls at the bottom to operate the camera.

Showing a group
To view another group, you can use the Device bar or the Group bar. To do this, either drag and drop the 
desired group from the Device bar into the display area or click on the desired group in the Group bar. The dis-
played group is indicated by a yellow bar in the Device bar as well as in the Group bar.

Fig. 13: Showing a group

Working With The Focus Window
At the bottom of the focus window is a Command bar with controls that allow you to operate the camera in 
the focus window. If you move the mouse pointer over the Command bar, further controls are displayed.
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Fig. 14: Camera in a focus window

Zooming And Moving Image Sections

Use the slider  to zoom. The zoomed image sections can then be moved with the mouse. These actions 

take place in the application. This means that only the image section of the current live image is modified. 
The camera will not move and therefore zooming will not affect the possible recording of the generated cam-
era image. 

 1. Drag the slider  to zoom in on or out of the live image.

 2. Move the image with the mouse to focus on individual image sections.

Select predefined image sections.

To quickly focus on a specific image section, you can use one of the factory default image positions that are 
predefined in the camera.

 n Overview , point of interest , preview  and detail view 

 n Top , bottom , left , right 

Move the slider Standard  to the next position or until you have found a suitable position. 

Accept and end calls.

To talk to visitors at the door, click on . To end an audio connection, click on .
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Opening Doors And Switching Lights

If a camera is connected to a door station and has been configured accordingly, you can open the door by 

clicking on . If the camera is also connected to a light switch and configured accordingly, the light can be 

turned on and off by clicking on .

Show Temperature

MOBOTIX cameras have a built-in temperature sensor that measures the temperature inside the housing. If an 
ExtIO module or an MX-GPS-Box is connected to the camera, you can also measure the ambient temperature 

of the module or the box and view it by clicking on .

Executing Softbuttons

Softbuttons can be used to switch additional devices or to send HTTP requests.

To execute a Softbutton, click on   to open the Softbutton menu, then click a Softbutton accordingly.

To edit Softbuttons see Softbuttons Settings.

Camera Sequencer

If you want to see a different camera in the focus window, simply drag that camera to the focus window. Note 
that the camera sequencer can also switch cameras automatically.

Instructions:

 1. Click on the camera sequencer icon  to activate the automatic switching. 

 2. Right-click on  to change the following settings:

 n Duration Slider: Move the slider to the desired duration (1 sec to 60 sec) to show each camera.

 n Autostart: Once you switch to the Grid view, the sequencer starts automatically.

 n Stop at event: The sequencer stops when an event has occurred, allowing you to further investigate 

the situation. To start again, click on .

 n Restart after confirmation: Activate this option if you want to avoid having to restart the sequencer 
over and over again.

Group Sequencer

If you want to display a different camera group in the focus window, drag and drop that camera group into 
the focus window. A grid with all cameras of the group will be displayed and each camera of the group will be 
shown sequentially in the grids focus window for a defined time. You can automate this camera group change 
with the group sequencer.
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Instructions:

 1. Click on the group sequencer icon  to activate the group sequencer.

 2. To change the sequencer settings right-click on :

 n Duration: set the duration to show each group. You can set a value between 1 sec and 60.  The “Com-
bined Sequencer”  activates the group sequencer together with the camera sequencer (“Autostart” on 
the camera sequencer is not needed). The group sequencer waits until all cameras on a grid or graphic 
have been cycled before switching to the next group. When the “Combined Sequencer” is active then 
the camera sequencers “Stop at Event” and “Restart after Confirmation” also apply to the group 
sequencer.

 n Autostart: Once you switch to the Grid view, the group sequencer will start automatically.

Switching group functions
At the bottom of the program window is a Command bar with controls that change depending on the selec-
ted view. In the Grid view, you can use the group buttons of the Command bar to control the functions of a 
camera group (Prerequisite: Group functions were assigned in the Group Functions dialog box). This means 
that you can switch on/off lights, open a door and make an announcement for a predefined camera of this 
group, regardless of the currently displayed camera. You can also assign the functions for switching on/off 
lights and opening doors to several cameras of this group, enabling you to switch on/off several lights or 
open several doors. 
    In addition, you can right-click on the group buttons to open the shortcut menu in order to control cameras 
that are not part of the current group. Before you can do this, the cameras have to be set up accordingly, that 
is, they need to be connected to door openers/light contacts and have to be configured properly.
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Fig. 15: Switching group functions

Manually recording live images
In the Grid view as well as in the Live view, you can start manual recording at any time, such as when you 
observe a suspicious situation that should be recorded. While you keep track of the situation in the live 
image, the images are recorded and saved as an MXG file. The camera's live image that is in the focus window 
is always recorded. For this reason, live recording can also only be used in the Grid view when there is a focus 
window.
     Users with administrator rights can specify where the clips are saved and how long the recordings can be in 
the      Preferences, p. 251     (Mac: menu: MxManagementCenter > Preferences > Live Recorder, Windows menu: 
File > Settings > Live Recorder). 

NOTE! This feature is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an 
ONVIF S-compatible interface. For an overview of how the camera functions differ, see      Camera Feature Over-
view, p. 9     .
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Fig. 16: Manually recording live images

Starting And Stopping Recordings

To start recording, click on Live Recorder . Recording will stop automatically after the recording time set 

in the program settings has expired. Just before this time expires, a message will be displayed. You can stop 
the recording from within this message or extend the set period of time. To stop recording before the time 

expires, click on  again.

NOTE! The recording ends automatically when switching to another view. However, changing the group 
within the Grid view will not result in an early termination of the recording, unless that group has no focus 
window. In the latter case, the recording will end. 

Play Clip

The live image data is stored in an MXG file at the location specified in Program Settings during recording. 
The clip file is automatically imported into the current project when the recording stops and the Device bar 

shows it alongside the  icon in the Clips section. You can click on the clip name to playback the *MXG clip 

file via the Device bar. 
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Program Structure and Operating Concept

Program Structure
MxManagementCenter provides functions for different user groups:

 n System administrators (installers):
This user group uses MxMC to build and configure a monitoring system that consists of the application 
itself, cameras, recorders and other components.

 n End users:
These use the application for their monitoring tasks, such as live video surveillance, searches in and 
playback of recordings, video exports etc.

Despite these different tasks performed by the two user groups, the program structure and operating concept 
are largely the same.

Operating Concept

Program window

There are multiple views that allow the user groups to complete their tasks. These consist of a Menu bar, a 
main area in which most of the task is executed, four bars that can be opened and closed, a Header bar at 
the top and a Command bar at the bottom of the program window. 

The following functional bars are available:

 n The Device Bar, p. 44

 n Camera Bar and Camera Group Bar, p. 48

 n The Alarm Bar, p. 50 (contains Searching in the Smart Data Search View, p. 167)

 n The Export Bar, p. 54 (contains The Histogram Bar, p. 172)

The Configuring Basic Camera Settings, p. 92 provides functions for changing the settings of multiple cameras 
in a group without having to change the camera or camera group.

The Command bar at the bottom contains the icons and buttons relevant to the current view. The contents of 
the Header bar as well as the Menu bar are the same for all views.

NOTE! If the Menu bar is not visible under Windows, it can be displayed by pressing the Alt key.
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Fig. 17: Program window

MxMC can be operated on Working With Multiple Monitors, p. 143. Double-click on a live image, for instance, 
to display it on a second monitor. If several monitors are connected, they are recognized and can be selected 
as required.
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The Device Bar

Fig. 18: Device Bar

The Device Bar at the left margin of the MxManagementCenter is the central place for creating camera 
groups and for adding and grouping cameras and clips. Its tree structure design provides a quick overview of 
the contents and the composition of the individual projects by allowing you to open and close the individual 
branches and view the hierarchical structure. 

Adding Cameras, Creating Groups and Importing Clips

 1. Open the edit mode at the bottom of the Device bar by clicking on .

 2. Next, click on . The Adding devices and sources, p. 84 dialog opens. 

Adding Cameras to a Camera Group

 1. Open the edit mode at the bottom of the Device bar by clicking on .

 2. Drag & drop the desired camera from the Cameras section to the appropriate group in the Camera 
Group section. 

NOTE! If you have assigned a camera to one group, you can copy this assignment to other groups by 
dragging the assignment from the first group to other groups.
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 3. Once you have assigned the cameras to the desired groups, you can deactivate the edit mode by clicking 

on .

Setting Group Functions

 1. Open the edit mode at the bottom of the Device bar by clicking on .

 2. To do so, move the mouse pointer over the group name. Three icons appear. Click on  .

 3. The Group Functions dialog opens.

 4. Assign the desired functions to the cameras by activating the respective checkboxes.

 5. Once you have defined all group functions, you can deactivate the edit mode by clicking on .

Deleting Cameras, Removing Cameras from Groups, Deleting Groups

Deleting Cameras

 1. Open the edit mode at the bottom of the Device bar by clicking on .

 2. Drag the camera from the Cameras section to .

 3. Once you have deleted the cameras, you can deactivate the edit mode by clicking on .

NOTE! Deleting a camera from the Cameras section will also delete the group assignments of that camera.

Removing Cameras from Groups

 1. Open the edit mode at the bottom of the Device bar by clicking on .

 2. Drag the camera from the Camera Groups section to .

 3. Once you have deleted the cameras from the groups, you can deactivate the edit mode by clicking on .

Deleting Groups

 1. Open the edit mode at the bottom of the Device bar by clicking on .

 2. Drag the camera group from the Camera Groups section to .

 3. Next, activate the edit mode by clicking on .

Working With the Device Bar

Configure Screen

Various features support the customization of the Device bar or the arrangement of items in the Device bar.
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Feature Explanation

Opening/Closing 
Sections

Click on  to close a section, click on  to open it again.

Moving Sections If you move the mouse over the upper part of the section, the  icon appears and the 

mouse pointer changes to the Move cursor. You can now click and drag the section up or 
down.

Setting Display 
Options

You can select how the cameras are listed, i.e., by camera name, IP address, factory IP 
address or reference image. Note that you can set different display options for the Cam-
eras and Camera Groups sections. For clips, you can choose to list the clips by name or 
by path.

Click on  and select the desired display option.

Sorting The Cam-
eras

The Cameras section allows sorting the list. Click on  and select the desired sorting 

mode. 

Editing Project Data

Set favorites for display in the Camera/Group bar and change the names of cameras and groups.

Special 
Feature

Explanation

Selecting 
Favorites 
from Cameras 
and Groups

You can filter the displayed cameras in the Camera Bar and Camera Group Bar, p. 48 using 
different filter criteria (by favorites, for example). Before you can use favorites, however, you 
need to label the desired cameras and groups in the device bar as favorites.
      Activate the Edit mode by clicking on . Move the mouse pointer over the camera or group 

name. Several icons are shown. Click on  . Next, deactivate the edit mode by clicking on 

.

Editing 
Names

Using the device bar, you can quickly modify the names of cameras and groups. Activate the 
Edit mode by clicking . Click on the camera or group name you want to change – it will 

turn yellow. Click again on the name and edit it as needed. Deactivate the edit mode by click-
ing on .
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Navigation: Targeted Selection of Views

Special Feature Explanation

Selecting Views The Device bar allows for selecting a specific view for a group of cameras or one camera. 
Move the mouse pointer over the camera or group name. Different icons will appear 
depending on whether you have moved the mouse over a camera or a group name. Click 
on the icon of the view you want to use.

Camera views

   Live view

   Playback view

   Smart Data Search View

Group views

   Grid view

   Graphic view

   Grid Playback

   further views (Smart Data Search View, Info view)

Overview of the Different Camera Statuses

An icon next to the camera name or the camera IP address indicates the current status of the camera.

Icon Explanation

Camera is not active.

Camera is not reachable.

Wrong camera password.

Privacy mode is active.

Limited functionality (only live image access) due to old firmware (<4.0), old camera model      (M/D/V12, 
M/D/Q22M) or proxy issue.

Camera password does not grant administrative access.

No license for this camera.
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Camera Bar and Camera Group Bar

Fig. 19: The camera- and camera group bars

The Group or Camera bar at the upper margin of MxManagementCenter provides the means for quickly 
selecting individual cameras/camera groups or for switching views.
   In addition, icons in the camera images of the camera bar indicate the current status of the corresponding 
camera:
  The height of the bar and thus the size of the images can be increased to cover two lines. To do this, pull 
down the lower frame border until it locks into place.

Camera Bar
The Camera bar displays the cameras with the image that was transferred from the camera when the camera 
was added. The camera name that was captured when the camera was added is shown in the gray Info bar at 
the bottom of the camera image.

Sorting the Cameras

By default, the cameras are displayed according to the order in which they were added to the Device bar. In 
order to make it easier to locate single cameras, you can change this order and sort the cameras. Do so by 

moving the slider  on the lower frame border to the desired position:

 n  unchanged order

 n  alphabetical sorting
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 n  sorted by IP address

Showing Camera States

The following camera states can be displayed in the camera image: 

 n  Camera is not active

 n  Camera is not reachable.

 n  Wrong camera password

 n  Privacy mode is active

 n  Limited functionality (only live image access) due to old firmware (<4.0), old camera model 

(M/D/V12, M/D/Q22M) or proxy issue.

 n  Camera password does not grant administrator rights.

Selecting Cameras

Select the desired camera either with a single click or drag and drop the camera into the display area. The 
Info bar of the selected camera turns yellow.

Switching To The Group Or Camera Bar

By clicking on the top frame border of the bar, you can switch from the Camera bar with individual cameras 
to the Group bar for managing camera groups.

Group or Camera Bar
The Group bar displays the camera groups with the reference image or icon configured in the camera man-
agement section (see Setting Up Camera Groups, p. 87). The name that was entered when creating the cam-
era group is shown at the bottom of the reference image or icon.

Sorting The Camera Group Display

The camera groups are displayed according to the order in which they were added to the Device bar. You can 
change this order and sort the camera groups alphabetically. 

    To do this, move the slider  on the lower frame border until the slider indicates alphabetical sorting: .

Select a camera group

Click on the desired camera group. The Info bar of the selected camera group turns yellow.

Switching To The Camera Bar

Click on the upper frame border of the bar to change from the Group bar with camera groups to the Camera 
bar for managing individual cameras. 
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The Alarm Bar

The Alarm Bar ①  is located at the right  of MxManagementCenter. It turns red when there is an unac-
knowledged alarm event. This happens only if the Alarms option has been activated in the Camera Con-
figuration dialog box and if the event types responsible for triggering an alarm have been activated. 
Clicking on the bottom frame border of the open Alarm bar will open the Export bar. Using drag & drop, the 
Export bar provides a quick and easy way to collect recordings for subsequent exporting.

NOTE! Depending on the user configuration only events for which the user has the authorization will be dis-
played in the Alarm Bar (see User Configuration, p. 241). 

Recognizing and Acknowledging New Alarms
If the bar is hidden, new alerts will be indicated by a red frame border . If the bar is open, the 

Info bar of the event image turns red. A ringing at the door bell will color the bar in green .

To acknowledge a new alarm, right-click on the event image and select Confirm. To acknowledge all new 
alarms at once, select Confirm All.

Filtering Alarm Images
The alarm images in the Alarm bar are sorted chronologically. You can filter the event images by camera, by 
group or by event type. There are two sliders for this purpose: the group/camera slider  and the event type 

slider . To set the filter, move the sliders until you see the desired results:
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 n Group/Camera: Group , camera 
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 n Event 
Icon

Event Type Explanation

MxActivitySensor Triggered by continuous movement of people or objects in certain 
image areas.

Video Motion 
Sensor

Triggered by movements in predefined motion windows.

Behavioral Detec-
tion

The sensor reacts to different behavior profiles of the tracked objects in 
the image. Triggered by deviations from the recorded behavioral pro-
files.

Shock Detector Triggered by shocks on the camera (e.g., vandalism).

Illumination Triggered by exceeding or falling below the specified illumination.

Microphone Triggered by exceeding the set volume of the sounds picked up by the 
microphone.

PIR Sensor Triggered by a Passive Infrared Sensor which registers objects with a 
heat signature moving within the sensor area. Triggered by exceeding 
the set threshold. 

Temperature Triggered by exceeding or falling below certain temperature thresholds.

 Action Group Ter-
mination

Triggered by the completed execution of an action group.

Internal Events Triggered by internal camera events

MxMessageSystem Triggered by receiving a message from the MxMessageSystem via the 
MxBus or from the network.

Meta events Triggered by Meta events

Signal Events Triggered by state changes of user-defined signals.

Time Events Triggers at certain points in time.

Ringing event Triggered by activation of the door bell.

Mailbox Message Triggered by leaving a voice mailbox message.

Door Station Events Triggered by opening the door.

RFID Card Rejected Triggered by the use of an invalid RFID card.
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Event 
Icon

Event Type Explanation

PIN denied Triggered by entering an invalid PIN.

All Events (default) No Filter - all events are shown

Playing Back Recordings

 n To play back the alarm recording directly from the Alarm Bar (instant playback) move the mouse 

pointer over the alarm image and click on  .

 n To play back the alarm in the Playback View, move the mouse pointer over the alarm image and click 

on  to switch to the Playback View.

Deactivating Alarms
You can use the Camera Configuration dialog box or the Alarm Bar to deactivate alarms.

 n Deactivating alarms for a specific camera and event type: 
Right-click on the desired alarm image and select Deactivate As Alarm.

 n Disable alarms for all event types of a camera: 
Right-click on an alarm image and select Deactivate All Alarms of This Camera.
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The Export Bar

The Export Bar ① is located at the bottom of the MxManagementCenter. It contains the The Histogram Bar, p. 
172 which visualizes the distribution of event frequency.

Clicking on the frame of the open Export Bar will open the Histogram Bar and vice versa. The Export Bar 
provides a quick and easy way to collect recordings for subsequent exporting.

Basic functions of the Export Bar
The Export bar can be opened in all views, and clips that have already been added can be edited in the bar. 
To do so, right-click on a clip. A shortcut menu with the following functions opens:

 n : Manually adjusting the time range

 n : Turning audio and PTZ on or off for all clips

 n : Duplicating a clip

 n : Deleting one or all clips

You can add the clips  in the Playback view, in Grid Playback and in the Smart Data Search View (see Exporting 
Recordings, p. 186).

NOTE! The Export bar will not be deleted automatically after exporting, but only when closing the applic-
ation.
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Controls and Buttons

Icons, sliders and buttons are available for working with the views.

Elements Examples Explanation

Icons Icons are mainly used in the Graphic view. They are either assigned predefined func-
tions or can be freely defined (hyperlinks). Icons can be freely placed in the Graphic 
view. Clicking on these buttons directly performs a function, for example, open a 
door. Icons used to control camera functions indicate their status, if available, 
such as "Door is locked" at the door icon of a Door Station. 

Buttons Buttons appear in many places in the application, including the Command bar or 
Header bar. Similar to the icons, clicking on the button performs a function directly. 
Buttons with a small white triangle at the bottom of the button indicate shortcut 
menus that provide additional options. The shortcut menus can be opened by right-
clicking, long-clicking or clicking on the triangle.

Slider Sliders are also used in many places for operation. Clicking & dragging a slider per-
forms actions, such as scrolling through the last records. Available setting options 
can be listed and selected by clicking on the slider.

The name of the controls and buttons is displayed by moving the mouse pointer over it. Explanations with 

links to quick help are displayed when clicking the question mark icon  in the Header bar.

NOTE! In some places in MxMC, multiple cameras can be selected at once. Do so by using CMD + click 
(Mac) or CTRL + click (Windows).

MxMC Views
The basic structure of the views is always the same. Each view, however, contains additional elements cor-
responding to the respective functional area. The following views are available:

 n The Grid View, p. 56

 n The Graphic View, p. 56

 n The Live View, p. 57

 n The Playback View, p. 58

 n The Grid Playback, p. 59

 n The Smart Data Search View, p. 60

 n The Components View, p. 61
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 n The AI Camera Apps View, p. 63

 n The Info View, p. 63

 n Configuration: Overview, p. 336

The Grid View

The Grid view consists of a grid of live images and a focus window. This grid display is ideal for getting a 
quick overview of all cameras of a group. You can drag the camera image that is most interesting to you onto 
the focus window. Use the controls at the bottom to operate the camera.

You will always notice when a camera registers an event, regardless of whether or not the camera is in the cur-
rent group. The alarm info bar at the bottom of the camera's live image signals an event within the group. 
The alarm info bar at the bottom of the Grid view shows the events of all attached cameras. To investigate 
the event, simply drag the live image from the Grid view, or the event image from the alarm bar, into the 
focus window.

Fig. 20: The Grid View

The Graphic View

You can define a floor plan (ground plan) in the Graphic view and place the cameras or camera groups 
according to their actual positions. The icon of the corresponding camera turns red in case of an alarm (or 
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green upon a bell event). Move the mouse pointer over the camera icon to show the live image of the trig-
gering camera, allowing you to quickly monitor the situation.
   You can use the group buttons of the Command bar to switch on/off the lights of several cameras at once, 
to open several doors or to make an announcement over several speakers for one or more cameras of the 
group, regardless of the displayed camera. In addition, you can right-click on the group buttons and open the 
shortcut menu to control cameras that are not part of the current group.

To make work easier, you can drag elements from the Command bar onto the floor plan and operate them 
directly in the floor plan by clicking on them.

In case you want to monitor the live images of cameras of other camera groups in the Graphic view, you can 
temporarily drag these live images onto the floor plan.

Fig. 21: The Graphic View

The Live View

The Live view allows you to control the live images of individual cameras. This includes switching various 
functions, e.g., opening doors or switching lights.

In order to better recognize objects in an image area, the live image in the Live view can be zoomed and 
image areas can be moved (PTZ). To facilitate quick loading of these image sections, several image positions 
are already configured for loading using the slider  in the Live view. On Dual cameras, the program also 

shows the  slider. Use this slider to show the live images of either the right, the left or both image sensors.

When showing the live images of hemispheric cameras, you can select different display modes (slider ).
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You can also make settings for the Door Station cameras in the Live view (e.g., voice mailbox announce-
ments).

Fig. 22: The Live View

The Playback View

The Playback view provides a quick and easy way to search for recordings and play back found sequences. 
There are various options available. The way that you search depends on whether you want to search the 
recordings for specific events, or if you want to search for events at specific times.

When searching for events, select a suitable playback mode   (e.g. event images only) and start playback 

  (backward or forward) or use the  (previous/next image) buttons to jump through the sequences.

When looking for incidents at specific points in time, you can search for a specific time or you can perform a 
search using "time leaps" and time-lapse playback. Furthermore, it is possible to play back any date and time 
and store that point in time so that the recordings of other cameras can be quickly searched for events at 
that time.

The recordings can be played back forward or backward at different speeds, which makes it easier to search 
for individual events.
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Fig. 23: Playback View

The Grid Playback

If a camera registers an event and you want to know if and what other cameras in that camera group were 
recording at that time, you can use Grid Playback to view the recordings of multiple cameras synchronously. 
  The camera in the focus window is the lead camera. So, if you are browsing the recordings on this camera to 
find events or specific situations or if you are playing back recordings, the other cameras will follow the lead-
ing camera as soon as playback is paused. The program always shows the event images that are closest to 
the time stamp of the leading camera. If the time of the other cameras differs from the leading camera, the 
difference will be displayed at the lower border of the event images.
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Fig. 24: The Grid Playback

The Smart Data Search View

With the MOBOTIX Smart Data System event data from MOBOTIX cameras, MOBOTIX IoT App events or trans-
action data, for example from POS systems, can be linked to the related video recordings  in MxMC. This 
enables conspicuous activities to be found and checked quickly. 

In the Smart Data Search View, you can perform a detailed search (see Searching in the Smart Data Search 
View, p. 167). Advanced search options and complete video documentation assist you in maintaining a com-
prehensive overview of, for example, POS systems, video-based license plate recognition or access control sys-
tems. Smart Data sources can be added and configured in Smart Data Sources, p. 309. 

The Smart Data Search View also includes the Post Video Motion Detection Search (see Searching With Post 
Video Motion Detection (Post VM), p. 176)
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Fig. 25: The Smart Data Search View

The Components View

In the  Component View, you can manage the following components:

 n Cameras

 n File Servers that are used to store video recordings. 

 n Smart Data Sources (license required) from which you can read transaction data, e.g. from MOBOTIX 
P7 Apps (no license required), POS systems or license plate recognition systems.

 n MxThinClients,  which allow you to display live images from MOBOTIX cameras on a monitor or TV set 
with HDMI connection.
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Fig. 26: The Components View

  ①  User Management, p. 238 / Notifications / Bandwidth
  ②  Header Bar
  ③  Camera Bar and Camera Group Bar, p. 48
  ④  Context Help / Update / Network Environments, p. 215 / Connection Monitoring
  ⑤  Smart Data Bar
  ⑥  Histogram Bar
  ⑦  Components View - Camera Toolbar  , p. 278
  ⑧  Home View / Previous View / Next View / Select View
  ⑨  The Device Bar, p. 44
  ⑩  Camera Settings, p. 269
  ⑪  File Server Settings, p. 303
  ⑫  Smart Data Sources, p. 309
  ⑬  MxThinClient Settings, p. 312
  ⑭  Softbuttons Settings, p. 315
  ⑮  Settings Area for Camera Settings, p. 269, File Server Settings, p. 303, Smart Data Sources, p. 309, MxTh-

inClient Settings, p. 312 and Softbuttons Settings, p. 315.
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The AI Camera Apps View

The AI Camera Apps view you can display the AI Apps Web GUI within MxMC to configure the corresponding AI 
App or to open the Apps Dashboard for statistical and analytical purposes.

Fig. 27: The AI Camera Apps View

The Info View

You can add an information page to every camera group in order to show special instructions for operating 
this camera group or instructions for a notification chain in case of an alarm, for example. To show the inform-
ation in the Info view, you can compile the information and save it in a PDF or JPG file and then load the file 
in the Group Management dialog box. 

If you want to show up-to-date information that is presented on a web server, you also do this in the Info 
view.  Simply activate the edit mode and pull the URL into the Info view.
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Fig. 28: The Info View

Configuration: Overview

The Configuration view you to directly access and make settings for MOBOTIX cameras. In general, the view is 
divided into a Basic Settings section and an Advanced Configuration section containing Configuration 
Groups.
The controls at the bottom can be used for actions such as storing the changed settings permanently or reset-
ting the parameter values to their factory settings.
The settings are made for one camera at a time. The Configuration bar on the right margin also offers the pos-
sibility to change the settings of several cameras of a group simultaneously without having to change the cam-
era or the camera group.

NOTE! The Configuration view is not supported by MOBOTIX MOVE cameras and third-party cameras that 
provide an ONVIF-S/G-compatible interface. For an overview of how the camera functions differ, see Cam-
era Feature Overview, p. 9.
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Structure of the camera configuration view

Fig. 29: Structure of the camera configuration view

Basic Settings
The Basic Settings ①  contain basic configuration settings that are important for the setup of cameras and 
camera system. The Basic Settings include the following areas: 

 n General Settings,

 n Network,

 n Time,

 n Image Settings,

 n MxActivitySensor and Recording.

The parameters of the respective topic areas are grouped in tabs. For information about each tab, see Con-
figuring Basic Camera Settings, p. 92.
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Fig. 30: Basic settings

Advanced Configuration
The available configuration parameters are thematically grouped in tiles ② . Clicking on a tile opens the topic 
area and tabs for the associated sub-topics.
Some of the topics contain graphical configuration items, such as those for defining exposure windows or 
detection areas. For more information on how to operate these configuration items see Graphical Operation, 
p. 344.

Extensive information on the setting options and parameters of the individual subject areas are currently 
available only via the help pages of the camera. You can access the camera help table of contents directly 
from MxMC by pressing CMD+Shift+H (Mac) / CTRL+Shift+H (Windows).
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Fig. 31: Advanced Configuration

Fig. 32: Advanced Configuration - Users and Groups
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Configuring Advanced Settings

CAUTION! By modifying User Settings, you can loose access to your cameras. Make sure you do not delete 
or move user or passwords you do not know!

 1. Click on the respective tab to open the corresponding topic area.

 2. Make your settings as required by topic. 

NOTE! Clicking on the relevant topic area in the table opens an information page for the individual 
topic areas of the Advanced Configuration settings. 

Fig. 33: Advanced Configuration - Users and Groups

Applying and saving changed settings

CAUTION! By modifying User Settings, you can loose access to your cameras. Make sure you do not delete 
or move user or passwords you do not know!
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Fig. 34: Applying and saving changed settings

You can use the controls at the bottom of the view to permanently save changed settings or to reset the para-
meter values to factory settings, among other things:

Resetting To Factory Settings

Click on  to reset all parameters for the current camera tab to the factory settings.

Undo/Redo Last Change

Click on  to undo the last change. Click on   to redo the change you previously undid.

Apply Changes

You can make changes by pressing Enter or selecting the new value in the Configuration view. The changes 
made here are not automatically adopted because it could potentially cause problems with the network set-
tings.
    When a value is changed, the checkmark in the Command bar turns red, indicating that the change has not 

been implemented yet. Click  to make this change.

Saving Configurations

If parameter values are changed, the Store Configuration  icon turns red in the Command bar. Initially, 

changes are always temporarily stored in the camera. To ensure that the current settings are also used after 
the next restart, the changes must be saved permanently.
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 1. To do so, click on Store configuration . The program opens a system prompt. In the prompt, click on 

Store.

 2. If you do not want to keep the changes, click on Discard. This discards the changes and restores the last 
permanently saved overall configuration.

Expert Settings

Various sections of the configuration provide additional settings that can be used to change parameters that 
are not necessary for the daily work with MxMC. Note that these settings have been combined as expert set-

tings in the different sections. Click on    to open the expert settings.

Changing Parameter Values For Multiple Cameras In The Configuration 
Bar

CAUTION! By modifying User Settings, you can loose access to your cameras. Make sure you do not delete 
or move user or passwords you do not know!

You can enter parameters for a single camera in the Configuration view. You can use the Configuration bar to 
check which parameter values are available for the other cameras in the group. There you can also change 
the settings of one or multiple cameras in the group without having to switch to a different camera or cam-
era group.

Checking parameter values of other cameras in the group

Fig. 35: Checking parameter values of other cameras in the group

70 / 350



EXAMPLE: 
Check arming for multiple cameras

 1. Click on the relevant parameter name ① .

 2. It turns yellow and the Configuration bar shows all values associated with this parameter that were 
defined for cameras in this group ② .

Changing a value for one camera or for multiple cameras

Fig. 36: Changing a value for one camera or for multiple cameras

EXAMPLE: 
Change a value using the Configuration bar

 1. Click the appropriate parameter name in the Configuration view ① . It turns yellow and the Con-
figuration bar shows all values associated with this parameter for this group ② . The cameras for which 
this value is set are assigned to the individual values.

 2. Highlight the desired camera and drag it onto the parameter value you want to set. The destination 
area turns yellow.

 3. If the same value is set for several cameras and you want to change this value, click on the parameter 
selection field in the Configuration bar ③ . Then select the desired value.
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Setup
Setting up a MxManagementCenter-based video surveillance system can be costly and will 
usually be done by an administrator / system installer. This section addresses admin-
istrators and system installers and provides an overview of the tasks that must be per-
formed to efficiently set up a system.
 However, not all of these tasks are mandatory for a basic installation (see Basic Install-
ation: Overview, p. 74).

Step Explanation

Adding Cameras, p. 75 Integrate cameras with the Welcome wizard or in the 
Device bar
Set alarm filters
Set up recording paths

Setting Up Camera Groups, p. 87 Create camera groups
Add cameras to groups
Define group functions

Adding Users, p. 90 Create users
Assign permissions

3



Setup
Basic Installation: Overview

Step Explanation

Configuring Basic Camera Set-
tings, p. 92

General settings
Network
Time
Image settings
MxActivitySensor
Recording

Checking System Security, p. 280 Verify system security settings
Secure the system

Backing Up And Exporting, p. 119 Save the settings made

Import Existing Project, p. 114 Import an MxControlCenter file (INI file)
Import an MxEasy file (NDB file)

Basic Installation: Overview
The Setup section describes the steps required to set up a system. For a basic installation, however, not all 
the steps shown are mandatory. The following list gives an overview of the most important steps of a basic 
installation.

Step Explanation

Adding Cameras, p. 75 When starting MxMC for the first time, the Welcome Wizard opens and auto-
matically starts searching for MOBOTIX cameras. Cameras in the local network are 
automatically detected and listed.

Cameras can also be added in the Device bar. Cameras that are in the local network 
are also automatically detected and listed here. Cameras outside the local network 
need to be added manually (see Adding devices and sources, p. 84).

Setting Up Camera 
Groups, p. 87

Create camera groups to group your cameras. By organizing in groups, entire sur-
veillance areas are always recognizable at a glance.

Assign the cameras to the desired groups. 

Set the layout for the Grid view and Graphic view.

Adding Users, p. 90 After you have added the cameras and organized them into groups, create the users 
and any other administrators and set their access permissions.
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Step Explanation

MxMC Licensing, p. 
318

Industry-specific solutions and special functions, such as the integration of cash 
point systems, are subject to licensing. To be able to use them, the purchased 
licenses must be activated.

Configuring Basic Cam-
era Settings, p. 92

Make sure that the main arming option has been activated (see Basic Camera Set-
tings: General Settings, p. 97. Synchronize the time (see Basic Camera Settings: 
Time, p. 99), arm the recording (see Basic Camera Settings: Recordings, p. 104) and 
specify a recording destination if necessary (see Adding Cameras, p. 75).

Checking System 
Security, p. 280

After completing the basic configuration of the system, it's recommended to check 
it's security.

Backing Up And 
Exporting, p. 119

Finally, you should save your settings. (You can save the settings locally as a project 
file.) The Device Backup function can be used to save the settings across the entire 
system.

Adding cameras, devices and sources
This section describes the necessary steps to add and configure cameras, devices and other sources.

Adding Cameras

The cameras and Door Stations can either be integrated with the Welcome wizard or added to the Device bar. 
These cameras also include MOBOTIX MOVE cameras and third-party cameras that provide an ONVIF-S/G-com-
patible interface.

Integrating cameras with the Welcome Wizard
When starting MxMC for the first time, the Welcome wizard opens and automatically starts searching for cam-
eras. The number of found cameras is shown next to the Add button . This number is updated auto-

matically if the number of MOBOTIX cameras on the network has changed (i.e., by connecting 
new/disconnecting existing cameras).
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Fig. 37: Integrating cameras with the Welcome Wizard

 1. Click on Add Devices .

      All found cameras are displayed either in a list or as tiles. Whether the cameras are displayed in a list or 
as tiles is determined by clicking on either the
tiles  or list  button.

 2. The respective camera status is automatically tested and displayed:       
 n  = The camera cannot be interacted with under the found or entered IP address.

 n  = The camera is in a different network than the computer.

 n  = The camera firmware is not up to date.

 n  = The camera is password protected.

 n  = Incorrect user data was entered.

 n  = Preview image not available.

 3. Select the cameras you would like to integrate. 
 n If some of the selected cameras are password protected, click on Change Camera Access  and enter 

the user name and password. 

 n If some of the selected cameras are not in the correct network, click on Edit Network Settings . 

Here you can choose whether the IP address is automatically determined or whether a fixed IP 
address is used.

 n Determining an IP Address Automatically: If your computer automatically gets its IP address 
from a DHCP server (e.g., DSL router), then it also makes sense to have the system determine 
the camera's IP address automatically. To do so, enable the Get IP Address Automatically 
option.
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 n Using a Fixed IP Address: If you have assigned a fixed IP address to your computer, you will 
probably prefer to assign a fixed IP address to the camera as well. To do so, enter the IP address 
and the subnet mask.

 4. Click on Apply and wait for the cameras to be reconfigured.

NOTE! If the  icon is displayed instead of the preview image, the camera could not be reconfigured due 

to incorrect user data. In this case, correct the user data and try again.

 5. The number of selected cameras is shown near the Next Page button. Go to the next page.

 6. Click on Done. The selected cameras are now integrated.

NOTE! Clicking on Start New Project opens the application directly, and you can add the cameras using 
the Device bar.

Adding cameras via the Device Bar

Fig. 38: Adding cameras via the Device Bar

The first time you start MxMC , the Welcome wizard automatically opens, allowing you to add your cameras 
and Door Stations. These can also be added using the Device bar. If you prefer to use the Device bar instead 
of the Welcome wizard, click on Start New Project in the dialog. This opens MxMC directly in live view, and 
the Device bar is open.

 1. Open the edit mode at the bottom of the Device bar by clicking on .

 2. Next, click on . The Add and Import dialog opens. 
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 n  Adding Cameras In The Local Network

All cameras and Door Stations in the local network can be detected and displayed automatically.

 n  Adding Cameras Manually

Cameras outside of the local network (for example, on the Internet) need to be added manually.

Capturing the data of many cameras
The authentication data used by MxMC as well as the environment settings can be changed in one step for 
many cameras in the  Multi-Camera Configuration  dialog. 

 1. To do this, open the edit mode in the Device bar by clicking on .

 2. Select the cameras as needed.
   Mac: CMD + click, Windows: CTRL + click

 3. Right-click on one of the selected cameras. The Multi-Camera Configuration dialog opens (see     Multi-Cam-
era Configuration, p. 237).

Setting Alarm Filters

NOTE! For MOBOTIX MOVE cameras and third-party cameras that provide an ONVIF-S/G-compatible inter-
face, there is no alarm function available and you can thus neither activate background monitoring nor set 
alarm filters. For an overview of how the camera functions differ, see      Camera Feature Overview, p. 9     .
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Events that lead to an alarm will change the background color of the Alarm bar, Alarm Info bar (see      The Alarm 
Bar, p. 50 and Alarm Processing, p. 148     ) and other UI items to red. You can set the event types that trigger a 
signal for specific cameras in the Camera Configuration dialog.

 1. To open the Device bar, click on  at the bottom of the bar.

 2. Then either right-click on individual cameras or click on the  icon, which is shown when you position 

the mouse pointer over the camera name.

 3. Click on Alarms to adjust the settings to your needs. The Alarm Events dialog opens.

  

Fig. 39: Setting Alarm Filters

 4. Make sure that the Alarms option has been activated.

 5. Select the event types that should create an alarm.
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 6. In addition, you can select a weekly profile for every event type that should trigger an alarm. As long as 
no other weekly profile has been selected, the setting is valid from Monday 00:00 to Sunday 24:00.       

 n Click on Edit weekly profiles to create new weekly profiles. The Weekly Profiles dialog opens. 
Several predefined profiles are available, such as the Weekend profile (Saturday 00:00 to Sunday 
24:00).

 n To add a profile, click on  . Enter a description. Next, highlight the desired active times in the 

table using the mouse. You can resize an active time block by clicking on the time block and then 
moving the borders accordingly It is also possible to move a block. Click on the block to select it, 
then drag the block to the new position. To delete a time block, click on  .

Fig. 40: Alarm Filter profiles

 7. You can change the description of an existing profile. Right-click on the name and overwrite it.

 8. To select a weekly profile, click on the Weekly Profile drop down list next to the event type and select 
the desired profile.

 9. Click on the calendar icon to easily invert the settings of the weekly profile. For example, if you have cre-
ated a profile with opening hours and would like to activate the alarms for the closing times, click on the 
Invert weekly profile checkbox and the profile is used in inverted fashion.

Setting Up Recording Paths
The program can access the stored recordings using the following methods: Access to recordings via the cam-
era (remote playback) or to a local directory where the recordings are stored or directly to a file server. 

When accessing via the camera (MOBOTIX camera), no further settings are required. If you want to access the 
recordings directly (file server or local directory), you need to define recordings paths and assign these to 
the cameras. Direct access offers the advantage of an extremely fast playback speed (up to 60x).
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NOTE! Recordings of MOBOTIX MOVE cameras and third-party cameras that provide an ONVIF-S/G-com-
patible interface can only be saved on MOBOTIX NAS. To do this, first configure the MOBOTIX NAS and then 
set up the recording path in MxMC.

Defining the Recording Path

Fig. 41: Defining the Recording Path

 1. Open Settings in the MxManagementCenter > Settings > Recording Paths (Mac) or File > Settings > 
Recording Paths (Windows) menu.

 2. Click on "+" and enter the desired name. Under this name, the path can be selected as the recording path 
in the Camera Configuration dialog.
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 3. Select the type:
 n Local

Contains a local folder on this computer or on a connected network drive. You can either enter the 
folder path manually, drag & drop a folder to the input field or select the local or linked folder.
Path: You must select the path that contains the recording folders created by the camera.

 n Network Share
The program directly accesses a shared folder on a file server. In this case, you need to enter the 
computer, the folder and the access data.
File Server (IP): IP address or DNS name of the file server with the share.
Directory: Name of the share on the file server. 
Important: Make sure that the path ends before the folder containing the factory IP address of the 
camera.
User Name/Password: Access data for the network share.

 n MOBOTIX NAS
Data is accessed directly on a shared folder on a MOBOTIX NAS.
File Server (IP): IP address or DNS name and port of the MOBOTIX NAS.
Directory: Name of the share on the MOBOTIX NAS.
Important: Make sure that the path ends before the folder containing the factory IP address of the 
camera.
User Name/Password: Access data for the MOBOTIX NAS.

 n MOBOTIX NAS (ONVIF-S/G)
The ONVIF-S/G recordings are accessed on a MOBOTIX NAS.
File Server (IP): IP address or DNS name of the file server.
User Name/Password: Access data for the file server.
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Assigning recording paths to the cameras

Fig. 42: Assigning recording paths to the cameras

 1. Open the Camera Configuration dialog in the Device bar. To do so, click on  at the bottom of the bar.

 2. Then either right-click on individual cameras or click on the  icon, which is shown when you position 

the mouse pointer over the camera name.

 3. Select the appropriate recording path in the recording settings. The following options are available:
 n Via camera: When accessing via the camera (MOBOTIX camera), no further settings are required.

 n Local Path: Set the appropriate recording format: Use MxFFS, if the recordings have been stored in an 
MxFFS archive. Use MxFileServer, if the recordings have been stored in the classic MOBOTIX folder/file 
structure. Then enter the local directory in the Device Directory text box.

NOTE! Click on the pen icon in the text field to open a file selection dialog.

 n File Server: If file server access is used, MxMC searches the specified file server path for sub folders 
with the corresponding recordings. Once the search has been completed, you can select the folder for 
this camera in the Device Directory selection box.

 n MOBOTIX NAS: When accessing a MOBOTIX NAS, select the appropriate camera IP in the Device Dir-
ectory selection box.
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Adding devices and sources

Fig. 43: Adding devices and sources

Select the desired action:

Adding Cameras in the Local Network
All cameras and door stations in the local network are detected automatically.

 1. Click on  . The Welcome wizard opens and lists all cameras that were found on the local network.

 2. Select the camera you want to add (use CMD-click on a Mac or CTRL-click on Windows to select several 
cameras).

 3. Specify a user name and a password. Click on   to do so. When multiple cameras have been selected, 

all of these cameras will get this user name and password.

 4. Click on  and then on Finish. All new cameras are shown in the device bar in the Cameras section and 

you can already see the live images of the cameras.

 5. You should now complete the data for the individual cameras. Open the Camera Configuration dialog 
for this purpose. To open the dialog box, you can either right-click onto individual cameras or you click 

on the  icon, which is shown if you position the mouse pointer over the camera name. The Camera 

Configuration dialog opens (see Camera Configuration, p. 223).

 6. Close the dialog once you have completely filled in the camera data in the Camera Configuration dialog. 

Then deactivate the edit mode of the device bar by clicking on .
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Adding Cameras Manually
Cameras outside of the local network (for example, on the Internet) need to be added manually. 

 1. Click on  . The Camera Configuration dialog opens.

 2. Enter the camera access data:

Name: Enter a descriptive camera name.

URL: IP address of the camera.

Remote URL: To access the camera from outside of the local network, you can enter the corresponding 
external address of the camera (such as a DynDNS name). Make sure that you also activate the Remote 
option.

User name, password: Enter the user name and password of the camera.

 3. Complete the network data and set up alarm notification as described in Camera Configuration, p. 223.

 4. Close the dialog once you have completely filled in the data in the Camera Configuration dialog. Then 
deactivate the edit mode of the device bar by clicking on .

Creating Camera Groups

 1. To create a camera group, click on . The Group Configuration dialog opens.

 2. Fill in the data as described in Setting Up Camera Groups, p. 87.

 3. Close the dialog once you have completely filled in the data in the Group Configuration dialog. Then 
deactivate the edit mode of the device bar by clicking on .

Importing Clips
You can use MxMC to play back exported MxPEG clips. Click on   to do so. The Load Clips dialog opens: 

Select the desired MXG file and click on Open. The clip appears in the device bar in the Clips section. 

Importing recordings
This function allows you to add storage paths generated by MOBOTIX cameras.

 1. Click Recordings.

 2. Select the desired directory with the camera's recording structure and click Open.

The recordings are displayed in the Device Bar in the Clips & Recordings section.

MxFFS Medium
This function allows you to access a MOBOTIX storage device connected to the USB port with recordings in 
MxFFS format.
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NOTE! To be able to read MxFFS media, you must start MxManagementCenter with administrator rights 
(see Integrating MOBOTIX Storage Devices, p. 327). Without administrator rights, the storage medium will 
not be recognized.

 1. Click MxFFS Medium.

 2. Select the desired directory and click Open.

The recordings in MxFFS-Format are displayed in the Device Bar in the Clips & Recordings section.

Creating Clips-/ Recording groups
Clips and recordings can be organized into groups.

 1. Click Create Clips / Recording Group.

 2. Specify a name for the group.

 3. Move the desired clips and recordings into the group.

Connecting MxThinClients
Edit the MxThinClient setting here. The MxThinClient is a compact solution for displaying the live image of a 
MOBOTIX camera on a monitor or TV set with HDMI connection. 

Name
Enter the name for the MxThinClient here.

URL
Enter the URL or IP address of the ThinClient.

User Name
 Enter the user name of the MxThinClient user here.

Password
 Enter the password of the ThinClient user here.

Display resolution
Select the resolution of the camera image to be displayed on the monitor of the MxThinClient.

Camera display
Select here how long the assigned camera image should be displayed on the monitor of the ThinClient. After 
the selected time period the ThinClient will display the configured setting (e. g. sequences, still images etc.).

MxThinClients can also be added via the Component view (see The Components View, p. 61).
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Setting Up Camera Groups
You can combine individual cameras into camera groups. For example, you can combine all cameras situated 
on the same floor in one group.  This allows checking on entire surveillance areas at one glance and – in case 
of an alarm, you are quicker to access the relevant cameras.

Creating camera groups

Fig. 44: Creating camera groups

 1. Open the edit mode in the Device bar by clicking on  at the bottom of the bar. Next, click on . The 

Add and Import dialog opens.

 2. Click on  . The Group Configuration dialog opens.

 3. Enter a group name and – if desired – add an image or an icon that will be used to represent the group in 
the group bar later on. To do so, click on the gray field and select one of the predefined icons. If you want 
to use one of your own images, click on Custom.

 4. Add a background image: Move the slider  to the right until you reach the  position. Click on the 

arrow in the gray field and select the file with the background image (for example, ground or floor plan). 

 5. You can add an information page to a camera group in order to show special instructions for this camera 

group, for example.  Move the slider  to the right until you reach the  position. Click on the arrow in 

the gray field and select the file you want to use.
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 6. Grid Tiles Bandwidth Limits: If a very large number of cameras is displayed in the Grid view, the per-
formance may decline. To avoid this, you can limit the frame rate of the live images within the grid 
frames. Note that this limit does not apply to the camera displayed in the focus window.
Use ONVIF-S/G LoRes Profile: Use this checkbox to limit the frame rate for MOBOTIX MOVE cameras and 
for third-party cameras that provide an ONVIF-S/G-compatible interface. If the checkbox is enabled, the 
settings for the live images in the tiles captured in the Bandwidth Settings as the LoRes profile for these 
cameras will be used.

 7. Close the dialog once you have completely filled in the data in the dialog. Then deactivate the edit mode 

of the device bar by clicking on .

Adding Cameras to a Camera Group
After you have added cameras and created camera groups, you now should assign cameras to the proper 
groups.

 1. Open the edit mode in the Device bar by clicking on  at the bottom of the bar.

 2. Drag and drop the corresponding camera to the desired group.

 3. Once you have assigned the cameras to the desired groups, you can deactivate the edit mode by clicking 

on .

Setting the Group View layout
To view and work with camera groups, there are two views available: the Grid view (grouping the cameras      by 
any criteria in raster form) and the Graphics view (realistic arrangement of the cameras on a graphic back-
ground). For each camera group you have the option of defining the Grid view grid layout and      positioning the 
cameras on the background image (e.g., building plan) in the Graphics view as desired.

NOTE! 

If you have created a group and have not added any cameras yet, the application will show      the icon  in 

the     Group and Device bar.

Setting the layout for the Grid View
    When you first open the Grid view after you have created a camera group, the cameras belonging to the 
group are displayed in the following grid layout by default:

 n The aspect ratio of the camera images is 4:3.

 n The Grid view is in auto grid mode. In auto grid mode, MxMC always tries to distribute the available 
space as well as possible according to the specified camera image format, the size of the focus window 
and the number of cameras. If you change the size of the window, the grid layout adapts automatically.

 n The focus box displays the camera that is in the Device bar at the top of the group.

 n The focus window size is twice as large as that of the camera images.
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Fig. 45: Setting the layout for the Grid View

 1. To change the format of the camera images or the size of the focus window, open the edit mode by click-

ing on  in the Command bar. The following sliders for adjusting the grid layout appear at the bottom 

of the bar:      
 n  = Format of the camera images and the focus window (4:3, 16:9, 8:3) 

 n  = Size of the focus window (1x, 2x, ..., 8x the size of the camera images)

 n  = Maximum number of cameras

 2. Move the sliders to the desired settings. To close the edit mode, click on .

See also: Group Views, p. 202

Configuring the Graph View layout 

When you open the Graphic view for the first time after creating a camera group, all cameras in that group are 

listed at the right margin of the previously defined background image with a camera icon . 
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Fig. 46: Configuring the Graph View layout

 1. To arrange the cameras according to their actual positions on the background image, open the edit mode 

by clicking on .

 2. To do so, move the mouse pointer over the camera icon. Two icons are shown.

 3. Click on  and drag the camera icon to the desired location. 

 4. Click on  to save the changes.

See also: Group Views, p. 202

Adding Users
After you have added the cameras and organized them into groups, set up users You can define different user 
types (User Types, p. 246) like regular Users, Administrators or Supervisors with specific access and con-
figuration rights. You define access permissions based on time schedules. 

CAUTION! An administrator possesses all rights.
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Fig. 47: Users settings

Users can be managed in the User Management section. To open the User Management section click on  

①  in the header bar.

The following steps show how to quickly add a user with default settings. For more details see: User Man-
agement, p. 238.

 Adding Users
To add a user open the User Management and click on the Add icon ② .

User basic settings

 1. Enter the corresponding user name. 

 2. Select the  user type: User, Administrator or Supervisor.

NOTE! The user type is set to User by default.

 3. Check the Active option to enable the user to lock in.

Password
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 1. Enter a password and confirm it.

 2. The Force Complex Password option ensures that users can only set strong passwords.

Requirements for a strong password:

 n At least eight characters

 n Includes lowercase and uppercase letters

 n Includes numbers

 n Includes at least one special character e.g. ,! @ # ? ]

 n Cannot be one of the last thirteen passwords used on this user account.

NOTE! If you are trying to set a password that does not meet the criteria, a red frame around the text field 
will appear.

Further settings vary depending on the user type. For more details see: User Management, p. 238

Configuring Basic Camera Settings
MxMC offers the possibility to adjust settings directly on the cameras. Some of the configuration options are 
summarized in the Configuration view under the green Basic Settings tile. This area includes all topics that 
are important or necessary for commissioning. Unlike "Advanced Features," the basic camera settings do not 
require a license and are therefore always available. 

NOTE! MOBOTIX MOVE cameras and third-party cameras that provide an ONVIF-S/G-compliant interface 
cannot be configured using MxMC. For an overview of how the camera functions differ, see Camera Feature 
Overview, p. 9.

Opening Basic Settings

 1. Open the Configuration view by right-clicking on the navigation key in the Command bar. Select the Con-
figuration view. 

NOTE! When opening this view, the system always loads the configuration of a camera group.
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 2. If you did not purchase a license to use "Advanced Features," the Basic Settings section is opened by 
default.

 3. If you have purchased an "Advanced Features" license, the Configuration view entry page will open. Click 
on the Basic Settings tile.
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Configuring Basic Settings

 1. Click on the respective tab to open the corresponding topic area.

 2. Make your settings as required by topic. 
More detailed information on editing the settings can be found in the table below. Clicking on the rel-
evant topic area in the table opens an information page for the individual topic areas of the basic set-
tings.
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Default setting Associated Parameters

Basic Camera Settings: Gen-
eral Settings, p. 97

Arming, Frequency of power supply, Audio source

Basic Camera Settings: Net-
work, p. 108

Internal host name, BOOTP/DHCP, Second IP address 

Basic Camera Settings: Time, 
p. 99

Automatically synchronize using a time server, Do not adjust automatically

Basic Camera Settings: 
Image settings, p. 100

Image size, JPEG quality, Camera selection, Display mode, Installation, Expos-
ure window, Exposure program, Max. exposure time

Basic Camera Settings: 
MxActivitySensor, p. 107                             

Active, Profile name, Event dead time, Edit detection area 

Basic Camera Settings: 
Recordings, p. 104

Arming, Recording mode 

Applying And Saving Changed Settings
The controls at the bottom of the configuration view can be used to perform actions such as permanently 
storing the changed settings or to reset the parameter values to their factory settings.
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Applying Changes

Normally, the changes in the Configuration view take effect when you type or select the new value. The 
changes made here are not automatically adopted because they could potentially cause problems with the 
Network Settings. Instead, the Apply Changes  icon in the Command bar turns red, indicating that the 

change is not yet in effect. To apply your changes, click on .

Storing the Configuration
If parameter values are changed, the Store Configuration icon  turns red in the Command bar. Changes to 

the configuration are always stored in the camera temporarily. To ensure that the current settings are also 
used after the next restart, the changes must be saved permanently.

 1. Click on Store Configuration . The program opens a system prompt. In the prompt, click on Store.

 2. If you do not want to keep the changes, click on Discard. This discards the changes and restores the last 
permanently saved overall configuration.

Resetting to Factory Settings                 

The parameter values of the opened tab can be reset to the factory default settings. Click on   to do so.

Undoing or Repeating Changes
Click on  to undo the last change. Click on  to repeat the last change.
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Changing Parameter Values for Multiple Cameras in the Configuration Bar
The Configuration bar on the right margin offers the possibility to change the settings of several cameras of a 
group without having to change the camera or the camera group.

Changing the Value for a Camera

 1. If the Configuration bar is not already open, open it by clicking on the right margin in the application.

 2. Click on the desired parameter name in the Basic Settings. It turns yellow and the Configuration bar 
shows all values associated with this parameter for this group. The cameras for which this value is set are 
assigned to the individual values.

 3. Highlight the desired camera and drag it onto the parameter value you want to set. The destination area 
turns yellow.

Changing a Value for Multiple Cameras

If the same value is set for several cameras and you want to change this value, click on the parameter selec-
tion field in the Configuration bar. Then change the parameter value for the cameras configured the same 
way at once.

Basic Camera Settings: General Settings

The general topics on operating the cameras are found in the general settings.
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Fig. 48: Camera Settings: General Settings

Arming
The main arming feature needs to be activated in order to process events, execute actions and notifications 
and record images and audio data. 

Parameter Explanation

Activated The camera is always armed.

Off The camera is not armed: no image storage, actions or messages.

CS Arming is controlled via a custom signal that needs to be previously configured on the cam-
era. The camera can use a signal input, for example, as the main switch for arming by using 
the custom signal. 

From master The camera is armed only when the master camera is armed.

See also:  n Recording

 n MxActivitySensor

Frequency of Power Supply
If the camera’s exposure control is not matched to the frequency of the power supply, sources of artificial 
lighting may lead to image interference. This parameter sets the camera to the power supply frequency of the 
respective country to prevent interference.
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Parameter Explanation

No artificial 
light

If the camera is used in daylight conditions (rather than with artificial lighting), you can also 
use the No artificial light setting.

50 Hz The factory default setting for Europe is 50 Hz.

60 Hz Set the power supply frequency to 60 Hz for Canada, the U.S. and Japan. 

Audio Source
Select the desired audio source. It is also possible to integrate an external audio source in addition to using 
the camera's microphone. The audio source is used for two-way communication and recording audio data, 
for example.

Basic Camera Settings: Time

The date and time can be manually set, adopted from the computer, or continuously synchronized through a 
time server. If you use a time server, the clock can be synchronized using a time server over the Internet, a 
time server service in the local network or another MOBOTIX camera. In this case, the camera's time server 
must first be set in the camera web UI Admin menu (Admin Menu > Camera Administration > 
Time & Date > Use Camera as Time Server).

Fig. 49: Basic Camera Settings: Time
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Automatically Synchronize Using a Time Server
Two protocols are available for synchronizing the camera using a time server: NTP and Time Protocol. 

Parameter Explanation

Time 
Server
      and 
     Time 
Server 
Address

 n NTP: With this protocol, the camera continuously synchronizes with one or more NTP 
time servers. If the NTP protocol has been selected, you can enter up to five time servers 
under Time server address. Theses servers must support the protocol specified in RFC 
1305. A green dot to the right of the time server address indicates that the time server is 
accessible and offers an NTP service. It can take a moment for the camera to connect to 
the time server and the dot to turn green.

 n Time Protocol: With this protocol, the camera synchronizes every six hours (and when it 
is rebooted). If Time Protocol (RFC 868) is selected, enter the Time server address in 
this box. The server must support the protocol specified in RFC 868.

Current 
Time

Display time of the current camera

Time Zone Select the correct time zone for the camera location.

Do not adjust automatically
Deactivate automatic synchronization if the date and time are set automatically or if they are adopted from 
the computer. 

Parameter Explanation

Current Time Display time of the current camera
     If the camera’s time deviates from the computer’s time, click on Use PC time to adopt the 
computer’s time.

Set time manu-
ally

Capture the desired data to manually set the date and time and click on Set time to con-
firm the entry.

Time Zone Select the correct time zone for the camera location.

Basic Camera Settings: Image settings

To display the camera live images, you can set camera views, image and exposure settings in this tab and cre-
ate and edit custom exposure windows directly in the live image.
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Fig. 50: Image settings

JPEG quality
The JPEG quality influences both the image quality as well as the file size of the JPEG and MxPEG files gen-
erated by the camera.

Using a compression of 60% (default) will usually deliver good-quality images that are suitable for most pur-
poses. If the value is lower than 20%, you can see pixelation within the image. For values higher than 70%, dif-
ferences to the uncompressed original image are hardly visible. The file size, however, may increase to more 
than 100 kB (for a 640x480 pixel image).

Camera selection
On Dual cameras, select the image sensor to use when displaying the images: right image sensor, left image 
sensor, both image sensors or automatic day/night switching. When configuring the image settings for both 
sensors, first select the sensor you want to configure using the left or right checkbox in the live image preview 
window and enter the settings you want. 

Display mode
There are various display modes available depending on the camera model.
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All Cameras Except Hemispheric Models

 n  Full image: The entire live image from the camera is displayed.

 n  Lens correction: This option displays a portion of the live camera image (with lens correction). This 
option is only available for L22 lenses, provided that the camera configuration is adjusted accordingly.

 n  Picture-in-Picture: This option displays a small image from one camera sensor inset in the large 
image of the other. This setting is available on MOBOTIX Dual models only.

 n  Picture in Zoom: This option displays a small version of the entire live camera image in the lower 
right corner of the large live camera image. This way, the entire image is visible even when the live 
image is zoomed.

 n  Event in Picture: This option displays a small version of the latest event image in the lower right 
corner of the large live camera image.

Hemispheric Models

 n  Full image: The entire (distorted) full image of the image sensor is displayed.

 n  Normal: A corrected image is displayed. This image can be panned and tilted. This is the factory 
default setting for hemispheric cameras.

 n  Surround: This option shows four image sections (one for each cardinal direction: N, E, S, W) in one 
joint view. Note that you can use PTZ actions to modify all four views independently from one another.

 n  Panorama: This option shows the distortion-corrected image of an entire room (corrected 180° pan-
orama view) from the left to the right wall. The aspect ratio (width to height) is 8:3.

 n  Panorama focus: This display mode combines the panorama view (aspect ratio 8:3) with two smaller 
images (each with aspect ratio 4:3) in one large image.

 n  Double panorama: This mode shows a panorama view for the North half of the image and a second 
panorama view of the South half of the image using an aspect ratio (width to height) of 4:3. This view 
only makes sense for the ceiling-mounted MOBOTIX Hemispheric model. Both partial views (North and 
South) can be changed independently of each other using PTZ commands.

Installation
You can set the mounting position of a MOBOTIX Hemispheric camera: wall, ceiling or floor. The mounting 
positions are set separately for the left and right lenses for cameras with two active image sensors.

Exposure window
It is set to ensure the proper exposure/brightness for the live camera image. 
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Custom

Creating And Editing Custom Exposure Windows Select the Custom option and then click on the window in 
the live image preview.     

Action Explanation

Create expos-
ure windows

Draw a window using the mouse pointer.

Move expos-
ure windows

Left-click on the exposure window and move it to the desired position.

Modify expos-
ure windows

Move the mouse pointer over one of the white "handles" until the  icon is displayed. Left-

click with the mouse and drag the window making it larger or smaller.

Delete expos-
ure windows

Click .

Exclude 
areas from 
exposure 
metering

Pull open a window of the appropriate size at the position that should be excluded from 
exposure metering. Click in the window and keep the mouse button depressed until two icons 
appear. Click on  to determine the exclusion window. The window turns red.

Visible image area

This setting enables you to use the current visible image section as the exposure window.

Predefined

You can use a number of predefined exposure windows: When you select the corresponding window, it will be 
displayed in the live image for review. A predefined exposure window is always applied to the full-image area, 
that is, the entire image of the sensor.

 1. Full image: Entire area of the image.

 2. Quarter: An exposure window at the image center that covers a quarter of the viewable image area.

 3. Center: One exposure window at the image center.

 4. Spot: One small exposure window at the image center.

 5. Top: One horizontal exposure window at the top of the image.

 6. Center: One horizontal exposure window at the image center.

 7. Bottom: One horizontal exposure window at the bottom of the image.

 8. Right: One vertical exposure window at the right border of the image.

 9. Vertical: One vertical exposure window at the image center.
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 10. Left: One vertical exposure window at the left border of the image.

 11. Right AND left: Two vertical exposure windows at the left and right borders of the image.

Exposure program
These parameters influence the balance between an exposure time that is as short as possible and hardware 
aperture that is as small as possible. The objective is to reach a fair compromise between clear images of 
moving objects (short exposure time, high amplification) and as little image noise as possible (long exposure 
time, low amplification).

 n  0: Default program.

 n  Negative: The programs will reduce exposure times to decrease motion blurring; could increase image 
noise.

 n  Positive: The programs will increase exposure times to reduce image noise; exposure in very bright 
environments is not impacted.

Maximum exposure time
This parameter determines the longest exposure time used by the camera. This setting enables you to either 
avoid motion blurring as lighting conditions decrease, or even specifically allow it.  Select shorter maximum 
exposure times if you do not want motion blurring. You can use a longer maximum exposure time (max. of 
1/1 = 1 second, for example) if you want the camera to produce images with good exposure (with motion blur-
ring), even in low light situations. 

Basic Camera Settings: Recordings

In this tab, the most important recording settings can be made, such as selecting the recording mode or set-
ting the recording speed.
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Arming: The arming feature for event control handles camera recording. However, the main arming of the 
camera needs to be activated in order to make the recordings in the first place.

Parameter Explanation

Off The recording feature is deactivated.
     No further parameters will be displayed.

Activated The recording features of the camera are activated (default setting). 

CS The recording is activated by a custom signal (CS).

From master The recording feature of the camera will only be enabled if recording has also been activated 
on the master camera.

Recording mode: You can select the type of recording for events and story images. The availability of the 
parameters will depend on the recording mode you select.
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Recording 
Type

Parameter

Snapshot 
Recording

This option will save individual pre- and post-alarm images (JPEG images), but without sound. 

  Snap shot interval: This option determines the amount of time between the individual pre-
alarm and post-alarm images. You can set values from zero to ten minutes (max.). 

  Pre-alarm images: Number of the image that are recorded before the event.
  Post-alarm images: Number of the image that are recorded after the event.
  Unlimited time to keep: The time to keep is set to unlimited by default. You can select a 

maximum time to keep, expressed in hours and days, if you deactivate this option. 
      The maximum value for time to keep indicates how long images and video clips need to be 
stored.

Event record-
ing

This option stores clip files for every event using the MxPEG codec with variable frame rate 
and optional audio data.

  Record audio data: If available in the camera, audio data can also be recorded. Set this 
option to active to enable audio recording.

  Event frame rate: Recording speed in frames per second (fps).
  Recording time before event: Time (in seconds) to include in recorded stream before an 

event has occurred.
  Recording time after event: Time (in seconds or minutes) to include in recorded stream after 

an event has occurred.
  Unlimited time to keep: The time to keep is set to unlimited by default. You can select a 

maximum time to keep, expressed in hours and days, if you deactivate this option. 
The maximum value for time to keep indicates how long images and video clips need to be 
stored.

Continuous 
Recording

Continually saves video and (optionally) audio data as MxPEG clips.     

  Record audio data: Similar to Event Recording, audio data from the camera be recorded with 
the same quality, regardless of the frame rate. Set this option to active to activate the micro-
phone.

  Frame rate: Recording speed for continuous recording.
  Unlimited time to keep: The time to keep is set to unlimited by default. You can select a 

maximum time to keep, expressed in hours and days, if you deactivate this option. 
The maximum value for time to keep indicates how long images and video clips need to be 
stored. 
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Basic Camera Settings: MxActivitySensor

The MxActivitySensor is a camera-internal video motion detector that can identify direction of motion detec-
tion and object size while blocking out any undesired interference (such as trees swaying in the wind) when 
detecting motion.  By default, a MOBOTIX camera ships with a predefined MxActivitySensor profile.

You can activate and deactivate this profile in this tab, change the name of the profile, adjust the event dead 
time, change the detection range and define new areas. 

 

Fig. 51: The MxActivitySensor 

Active

The MxActivitySensor profile is also activated when the Arming feature is enabled in the general settings. 

Profile name

You can change the preset profile name.

Event Dead Time

The event dead time defines a period of time (0–3600 sec.) after an event during which no new events from 
the same profile are detected. By defining an event dead time you can avoid, for example, that a complex 
action (person walks through the active image area) triggers multiple events. You can adjust the preset event 
dead time (5 sec.).

Edit detection area

Proceed as follows to adjust the default detection area or to define additional image areas:

Click on the green detection area in the live image preview.
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Action Explanation

Change 
shape of 
detection 
area

Position the mouse pointer on one of the white "handles" until the  icon is displayed. Click 

and hold the left mouse button and drag the frame to make the detection area larger or smaller.

Move 
detection 
area

Left-click on the detection area and move it to the desired position.

Rotate 
detection 
area

Click on  and, while holding the mouse button down, rotate the detection area clockwise or 

counterclockwise.

Change 
shape of 
detection 
area

Switch to polygon mode by clicking on . You will see white corner points on the corners. 

Drag the corner points to the desired position. You can insert new corner points by right-clicking 
on the white line or in the detection area. Right-click on a dot to delete a corner point. Then 
click on .

Deleting a 
Detection 
Window

Click on  .

Create a 
detection 
window

Use the mouse to pull open a new window in an area that is not yet covered by another win-
dow. 

Exclude 
area from 
analysis

Pull open a window of the appropriate size at the position that should be excluded from the ana-
lysis. Click in the window and keep the mouse button depressed until two icons appear. Click on 

 to determine the exclusion window. The window turns red. 

Basic Camera Settings: Network

Your network interface settings determine how the camera can communicate with the “outside” world and 
how the camera can be accessed from outside of the local network. When changing parameter values, please 
note that the changed values are not automatically applied as in the other tabs of the Configuration view. For 
changes to take effect, you must click on  in the Command bar.
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Internal host name

The host name is the unique camera name in the network under which it is accessible.

BOOTP/DHCP

BOOTP and DHCP are protocols with which IP addresses can be managed in a network and automatically 
assigned. The camera can use them to automatically obtain its network configuration. 
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Parameter Explanation

Off The camera’s network configuration is manually established. Enter the appropriate information 
in the IP address and subnet mask boxes and, if necessary, change the standard route or gate-
way and the DNS server.

IP Address: You can access the camera in the network via its IP address. Ask your network 
administrator which IP address is available.

Subnet Mask:: A matching subnet mask needs to be entered for the IP address in order for com-
puters to be able to communicate in a network. Again, it is your network administrator who will 
tell you which subnet mask to use.

Default Gateway:
The gateway acts a relay between individual networks and it coordinates the data traffic 
between these networks. Enter the IP address of the gateway that should be used.

DNS Server:
A Domain Name Service (DNS) resolves computer names to IP addresses. If you have a DNS on 
your network, you can specify up to three IP addresses of DNS servers. This is only necessary if 
you want to address computers using their name instead of their IP address for other con-
figurations (FTP, email). 

On
client 
mode 

Use BOOTP/DHCP to set the IP address and network configuration automatically. The gateways 
and the default route are automatically determined via BOOTP/DHCP and configured.

On
server 
mode 

This camera provides DHCP service to clients on the local network. The IP address of the cam-
era will be 192.168.0.19 with subnet mask 255.255.255.0 by default.

Default Gateway:
Enter the IP address of the gateway that should be used.

DNS Server:
A Domain Name Service (DNS) resolves computer names to IP addresses. If you have a DNS on 
your network, you can specify up to three IP addresses of DNS servers. This is only necessary if 
you want to address computers using their name instead of their IP address for other con-
figurations (FTP, email). 

Additional IP address

The camera can manage two different network configurations. If you enable this checkbox, the factory default 
IP address and the subnet mask will also be used, ensuring that the camera remains accessible at all times.
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Checking System Security
After completing the basic configuration of the system, it is recommended to check its security.  The Secure 
System Wizard is in the  Camera Toolbar of the The Components View, p. 61. It analyzes the security settings 
of the cameras and assesses their status based on common best practices. If test criteria are not met, pos-
sible measures to protect the cameras are provided. 

NOTE! The system security check feature is not available for MOBOTIX MOVE cameras and third-party cam-
eras that provide an ONVIF-S/G-compatible interface. For an overview of how the camera functions differ, 
see    Camera Feature Overview, p. 9   .
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Verifying Settings for System Security

 1. In menu View open the Components View.

 2. Select the desired cameras ① .

 3. In the Camera Toolbar ②  click  Secure System. The following criteria are checked:
 n Usage of the "meinsm" password with standard or ONVIF user accounts on MOBOTIX cameras. It is 

easy for cyber attackers to guess the standard "meinsm" password.

 n Enabled Public Access: If Public Access is enabled, a number of different camera functions can be 
used without a password.

 n Activated HTTP web server: It is possible for data, including user data such as passwords and images, 
to be transmitted via the network without encryption when HTTP is used. 
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The result of the check is displayed for each camera in the Secure System dialog. It will also show all cases in 
which cameras were not checked due to a connection error, for example.

Status Explanation

 Not secured There was at least one criterion that was listed as not secure.

 Software too 

old

Please check the camera software and update it, if necessary.

 Connection 

error

Check your network connection to the camera and perform the security check again. 

 Not supported The camera (s) cannot be analyzed or secured using the wizard.

 Secured Camera is secure; no further action is necessary.

 4. In the Secure System dialog, click on Next. Cameras resulting in a Not secure status are displayed 
together with whichever of the three criteria that were fulfilled as well as the measures that need to be 
taken to properly secure the cameras: 

Criterion Explanation

Password Changes the password of all user accounts on the cameras that use the standard “meinsm” 
password. It also include ONVIF users whose passwords have never been changed.
      Enter a new password and confirm it. A suitable password has at least eight characters. It can 
consist of lowercase and uppercase letters, digits and special characters (see ). If you set a 

password that does not meet these criteria, a red frame appears around the text field. The 
frame turns green once you have entered a valid password.
     The new password is automatically entered in the MxMC project data. 

SSL encryp-
tion

Disables camera connections via unencrypted HTTP and configures the cameras to accept 
HTTPs connections only.
      The TCP port and the SSL setting will be automatically updated in the MxMC project data, if 
necessary. 
      The TCP port will not be updated for cameras that are connected via a remote URL. For 
remote URL connections, you may need to change port forwarding in the router to the appro-
priate setting.
Please note that different services, such as network messaging etc., will no longer work when 
you disable HTTP. 

Public 
Access

Disables access that does not require password entry to the web interface and the APIs of the 
cameras. 
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 5. Click on OK in the dialog box. The selected security measures will be performed. The security status for 
the selected camera or camera group will be analyzed once again and the result for each camera is dis-
played. 

Import Existing Project
If you have already used MxControlCenter or MxEasy, you can import an existing MxControlCenter.ini file 
from the MxControlCenter or the MxEasy.ndb camera list from an MxEasy installation. In both cases, the cam-
eras already integrated in the MxControlCenter (MxCC) or MxEasy are automatically transferred to the 
MxManagementCenter with their access data.

Furthermore, it is possible to quickly integrate a large number of cameras and camera groups into MxMC 
using a manually created list in MXU format. You need to adhere to specific rules for the format when creating 
the list in order to correctly export the contents of the MXU file.

Importing configurations from MxControlCenter
When importing an MxCC file, the following is taken into account: 

 n The layouts defined in MxCC are created as groups in MxMC.

 n The background layouts from MxCC, including the background graphics and definitions of the camera 
symbols, are transferred to the Graphic view of the associated group.

 n If a global password has been assigned, this will be entered for all cameras that do not have a user 
name.

 n For each hyperlink used, a softbutton is created in MxMC.

 n Furthermore, the tree structure from MxCC is shown in the Device bar and file servers configured in 
MxCC are created in the MxMC settings.
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Fig. 52: Importing configurations from MxControlCenter

 1. Open the Welcome Wizard from the File > Welcome menu.

 2. Click on Import MxCC. Decide if the current project should be saved.

 3. Import the desired INI file.

Importing Configurations From MxEasy

Fig. 53: Importing Configurations From MxEasy
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 1. Open the Welcome Wizard from the File > Welcome menu.

 2. Click on Import MxEasy. Decide if the current project should be saved.

 3. Import the desired NDB file.

Importing MXU Files
Using a manually created list in .MXU format, you can quickly add a large number of cameras and camera 
groups. You need to adhere to various formatting rules when creating the list in order to correctly export the 
contents of the MXU file (see Creating MXU Files for Imports, p. 116).

CAUTION! This list does not replace the project import, during which program settings, such as settings for 
the cameras and camera groups with assigned layouts, are imported.

 1. Click on Import MXU to import cameras and camera groups in the Welcome wizard. You can save the 
existing project, if necessary.

 2. Open the MXU file.

 3. Decide whether the cameras and groups from the MXU file should replace the entire configuration or they 
should be only added.

Creating MXU Files for Imports

You can quickly add a large number of cameras and camera groups to the MxMC using an MXU file. There are 
several format specifications that need to be followed when generating such an MXU file. 
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Format for Simple Imports
It needs to adhere to the following format for a simple import of cameras:

 n Unformatted UTF-8 text

 n One or more camera lines with the following structure:
Name<TAB>IP<TAB>Username<TAB>Password<CR LF/LF>

 n Elements in a camera line need to use TABs as separators.

 n Line breaks are either CR LF (Windows) or LF (UNIX).

 n Comment lines are preceded by a //.

 n Camera names need to be unique and cameras using the same name will not be added more than 
once.

Example:

 Main Entrance   10.6.37.25   admin   meinsm

 Side Entrance   10.6.15.206  admin   meinsm

 Entrance Gate   10.6.23.132  admin   meinsm

Format for Advanced Imports
Expanded Format

The file needs to use the following format for the advanced import of cameras, groups, clips and settings for 
graphics and grid view:

 n First line always #EXTMXU

 n Any additional commands must start with #EXT. Parameters use “:” as separators. 
Example: #EXTGROUP:Doorstations

Commands for advanced imports

#EXTMXU Marker to indicate the beginning of the file 

#EXTGROUP:name:f:r:icon:map:info                         Group “name” is created and all further cameras will be added to this 
group. 

f: Large focus window (0=0x, 1=1x, 2=2x ...) 

r: Tile ratio (0=4:3, 1=HD, 2=8:3) 

icon: If numeric, index of the internal group icons; otherwise, file name 
corresponding to the *.mxu file. 

map: File name of the background image 

info: File name of the information page 

Setup
Import Existing Project

117 / 350



Setup
Import Existing Project

#EXTGROUP: All further cameras will not be added to a group if no name is spe-
cified (unless “All cameras”). 

#EXTCLIP:clipMXG Camera demo clip is added. Clips need to be stored in the same dir-
ectory as the *.mxu file.

#EXTMXPEG:name:clipMXG                         MxPEG clip with “name” is added. This references the absolute path of 
the MXG file.

#EXTCURRENTCAMERA:name                         Select camera. 

#EXTCURRENTGROUP:name                         Select group. 

#EXTSUBGROUPS:name                         The following groups (each with the name in a line) are added to the 
group “name” as a subgroup.

#EXTINFO:Comment                         Comment line. 

#EXTEND End of file, all further lines are ignored. 

Example:

NOTE! 
To enable SSL, add https:// in front of the camera URLs.

#EXTMXU

 // To enable SSL, add "https://" in front of the camera URLs

 https://10.3.31.125       admin   meinsm

 https://10.3.31.126       admin   meinsm

 #EXTGROUP:Doorstations:2:2:2

 Main Entrance           10.6.37.25        admin   meinsm

 Side Entrance           10.6.15.206       admin   meinsm

 

 #EXTGROUP:Indoor:2:2:3

 Building East           https://10.3.31.251       admin   meinsm

 Building West           https://10.7.25.186       admin   meinsm

 Staircase               https://10.6.115.57       admin   meinsm

 Canteen                 https://10.12.32.65       admin   meinsm

 

 #EXTGROUP:Outdoor:2:2:4

 Parking Visitors        10.5.46.39        admin   meinsm

 Parking Employees       10.10.231.107     admin   meinsm

 

 #EXTGROUP:Dual Cams:2:2:10
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 Checkout1               10.10.106.26      admin   meinsm

 Checkout2               10.10.152.225     admin   meinsm

 Checkout3               10.13.242.195     admin   meinsm

 

 #EXTGROUP:Faststreams:2:0:11

 Ground Floor            10.2.2.169        admin   meinsm

 Second Floor            10.2.104.130      admin   meinsm

 Third Floor             10.3.11.51        admin   meinsm

 Elevator                10.3.209.198      admin   meinsm

 

 #EXTGROUP:Clips:2:2:groupIcon.png:groupMap.jpg

 #EXTCLIP:FiremanMXG

 #EXTCLIP:PoleMXG

 

 #EXTCURRENTCAMERA:Main Entrance

 #EXTCURRENTGROUP:Doorstations

 

 #EXTEND

Backing Up And Exporting
Once the system has been set up to add all the cameras, organize the cameras into groups, create the users, 
set their access permissions and verify system security, you should save the settings as a project. Everything 
is saved, except for settings that are only relevant for the local installation, such as the Remote Control port.

Secured system settings can be e-mailed directly from the application. You can also include the encrypted 
access data for each camera (user name and password). When opening the project in MxMC, these access 
data will be used automatically. If you do not supply the access data, the user name and password will have 
to be entered manually for each camera.

You can quickly export a tabular overview of all cameras and camera groups from MxMC and save it in MXU 
file format. The table lists the cameras with their IP addresses and the camera groups with the associated 
cameras.

Furthermore, you can export project data to easily import them in the MOBOTIX LIVE App.

Saving projects

 1. Click on  in the Header bar. The Projects and Network Environments dialog opens.

 2. Click on Save As  and complete the dialog.
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Providing projects via email
In the header bar, click on Projects and Environments  and then on Email to . This will generate a pro-

ject file which will be transferred to the mail program as an attachment within a new e-mail. 

NOTE! 
A properly configured email client is required for this purpose.         

Export MXU File
You can conveniently add large numbers of cameras, camera groups, devices and recordings/clips in MxMC 
using a list in MXU format. To create an MXU file based on the current project data, proceed as follows:

 1. Select File > Export MXU… from the Menu bar. 

 2. Click on Save. The table is saved as an MXU file.

Export project data for MOBOTIX LIVE App
To export project data for the MOBOTIX LIVE App proceed as follows:

 1. Optionally select a specific camera group to export.

 2. In the menu, select File > Export to MOBOTIX Live.
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 3. Click on All Cameras or Selected group.

 4. Enter and confirm a password for encryption  of the export data and click OK.

 5. Specify a storage location and save the export file.
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Using The Application
This section is for users. It provides assistance with daily MxMC operation, from monitoring 
one or more cameras to searching records.

Areas Topics

Live Surveillance  n Working with the Live view

 n Working with the Grid view

 n Working with the Graphic view

 n Using Door Stations

 n Working with multiple monitors

 n Working in different network environments

Alarm Processing  n Alarm notification

 n Setting up alarm notification

 n Filtering alarm images

 n Playing back alarm recordings 

Searching in MxMC  n Searching and playing back in the Playback View

 n Searching and playing back in the Grid Playback View

 n Smart Data System, p. 167

4
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 n The Histogram Bar, p. 172

 n Post Video Motion Detection (Post VM), p. 177

 n Searching and playing back door events

 n Exporting recordings

Live surveillance
The section describes basic scenarios and options of live surveillance.

Working With The Live View

The Live view allows you to control the live images of individual cameras. This also includes switching various 
functions, e.g. opening doors or switching lights.

Showing Cameras

Fig. 54: Showing cameras
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To view a camera, you can use the Device or Camera bar. To do this, either drag and drop the desired camera 
from the Device bar into the display area or click on the desired camera in the Camera bar. The displayed 
camera is marked with a yellow bar in the Device bar as well as in the Camera bar.

Customizing Image Settings

Fig. 55: Customizing image settings

Use the Brightness  and Contrast  controls to adjust the image display of the displayed camera to the 

current environment.
Move the corresponding slider upwards or downwards. The new settings are stored automatically for the cur-
rent camera. The default values can be restored by double-clicking on the corresponding slider.

NOTE! Adjusting the image settings does not have any effect on the camera settings. These will not be 
changed
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Performing PTZ Actions

Fig. 56: Performing PTZ actions

NOTE! On a secondary monitor, a single camera image can only be zoomed with the mouse wheel or 
panned with the mouse button pressed down. PTZ controls are only available on the MxMC main screen or 
on the secondary monitor in Grid View.

To better identify objects in an image section, you can zoom the live image and move the resulting image 
area around (PTZ). To facilitate quick loading of these image sections, several image positions are already 

pre-configured for loading using the slider .

The program also shows the  slider on Dual cameras. Use this slider to show the live images of either the 

right, the left or both image sensors.

When showing the live images of hemispheric cameras, you can configure different display modes (slider ).

Zooming and Moving Image Sections
You can zoom using the slider  or the mouse wheel. Zooming with the slider takes place only on the com-

puter. This means that only the image section of the current live image is modified.
To see other image sections, you can move the live image using the mouse.

If you want to execute the PTZ actions on the camera, you can also switch to camera PTZ. In this case, the 
PTZ actions are applied to the camera's live image and also influence the recordings (but only if the camera 

does not record the full image). To use this feature, click on the slider  and keep it pressed until it starts 
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flashing. You can now adjust the zoom level as needed. To store the setting, click again on the slider and keep 
it pressed until the slider stops flashing.

Selecting and Adjusting Image Sections
Selecting Image Sections

To quickly focus on a specific image section, you can use one of the factory default image positions that are 
predefined in the camera. 

 n Preview , detail , overview  and point of interest 

 n Top , bottom , left , right 

The camera will then move to the selected position. Note that the PTZ actions are executed on the camera 

and also influence the recordings (only if the camera does not record the full image).  Move the  slider to 

the next position or until you have found a suitable position.

Adjusting Image Sections

You can adjust the pre-defined image positions of the factory default. Select a position and modify it as 
needed. Keep the slider on this position until it flashes once. The new image section has been stored.

Choosing a Sensor
If you want to show the live images of only the right or the left image sensor, you can move the  slider to 

the right to  (left sensor) or further to the right to  (right sensor).

Correcting The Distortion Of Hemispherical Images
When showing the live images of hemispheric cameras or cameras with the lenses L12/B016, L23/B036, 
L25/B041, you can select different display modes. This requires that you enabled OpenGL in the settings 
(Mac: MxManagementCenter > Settings > General menu; Windows: File > Settings > General menu). In 
order to get naturally-looking images, the camera will automatically correct the distortion in these modes. 
This distortion correction can be refined even further when using the panorama correction. The selection of a 
display mode is always done locally and thus does not influence the camera settings. However, the selection 
is also applied to the other program views. When selecting a display mode in the live view for a specific cam-
era, this mode is also applied if the camera shows up in the focus window of the Grid view as well as in the 
live images of the Graphic view. Consequently, the alarm images in the Alarm bar and in the Smart Data 
Search View are also shown in the selected display mode.

Selecting The Distortion Correction Mode

 n  Full image: Shows the entire (distorted) full image.

 n  Normal: Shows a distortion-corrected image and allows executing PTZ actions. 
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 n  Panorama: Shows the entire distortion-corrected image (corrected 180° panorama) from the left to 

the right border. The aspect ratio (width to height) is 8:3. 

 n  Surround: This option shows four image sections (one for each cardinal direction: N, E, S, W) in one 

joint view. Note that you can use PTZ actions to modify all four views independently from one another.

 n  Double panorama: This mode shows a panorama view for the North half of the image and a 

second panorama view of the South half of the image using an aspect ratio (width to height) of 4:3. 
This mode makes sense for a hemispheric camera that is mounted to the ceiling. It can be sub-
sequently customized to use local PTZ.

 n  Panorama focus: This display mode combines the panorama view (aspect ratio 8:3) with two smal-

ler images (each with aspect ratio 4:3) in one large image.

To select a mode, move the slider  to the right until you reach the desired position. This slider position will 

be stored automatically until you change it again.

Panorama Correction

The distortion-corrected images of the different display modes can be further refined. For example, if the 
image in Panorama mode is not centered, you may see a trapezoidal distortion. The panorama correction 
allows adjusting the skewed (vertical) lines of the image to produce a more naturally-looking image. To do so, 

move the  slider to the right to  and use the mouse to correct the image. To store the corrected setting, 

click on the  slider and hold it until the slider icon briefly appears in the center of the image.

Status Display
The Status bar displays different states by means of icons. The status displays always refer to the displayed 
camera. This gives you an up-to-date overview, e.g., showing you at a glance whether a door has been closed 
again or is still open.
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Fig. 57: Status display

Icons in the Status Display

Door Status Dis-
play

 door is closed.

 door is open.

 door is locked.

 door lock switch is locked, but the door is open! 

Light Status Dis-
play

 light is off.

 icon is lit: Lights are on, needs to be switched off manually. 

Microphone Status 
Display

 microphone is switched off, no announcement possible.

 microphone is on, announcements are possible.

 microphone connection is blocked, possibly because a connection has been estab-

lished to a different remote station. 

Switching additional devices via Softbuttons
Softbuttons can be used to switch additional devices or to send HTTP requests. 

Using The Application
Live surveillance

129 / 350



Using The Application
Live surveillance

Fig. 58: Switching additional devices via Softbuttons

To execute a Softbutton, click on   to open the Softbutton menu, then click a Softbutton accordingly.

To edit Softbuttons see Softbuttons Settings.

Manually recording live images
In the Live view as well as in the Grid view, you can start manual recording at any time, such as when you 
observe a suspicious situation that should be recorded. While you keep track of the situation in the live 
image, the images are recorded and saved as a MXG file. 
   Users with administrator rights can specify where the clips are saved and how long the recordings can be in 
the Program Settings (Mac: MxManagementCenter > Preferences > Live Recorder menu, Windows: File > 
Settings > Live Recorder menu).

NOTE! This feature is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an 
ONVIF-S-compatible interface. For an overview of how the camera functions differ, see Camera Feature 
Overview.             

Audio can only be recorded with the Live Recorder under these conditions:

 n Audio transmission must be activated on the camera side.

 n In the Live View of MxManagementCenter, the audio connection must be activated by clicking on .
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Fig. 59: Manually recording live images

Starting And Stopping Recordings

To start recording, click on Live Recorder . Recording will stop automatically after the recording time set 

in the program settings has expired. Just before this time expires, a message will be displayed. You can stop 
the recording from within this message or extend the set period of time. To stop recording before the time 

expires, click on  again.

NOTE! If you change the view, the recording is automatically stopped. However, a camera change within 
the Live view does not stop the recording.

Play Clip

The live image data is stored in a MXG file at the location specified in Program Settings during recording. The 
clip file is automatically imported into the current project when the recording stops and the Device bar shows 

it alongside the  icon in the Clips section. You can click on the clip name to playback the MXG clip file via 

the Device bar.             

Working With The Grid View

The Grid view consists of a grid of live images and one focus window. This grid (tile) structure is ideal for get-
ting a quick overview of all cameras of a group. You can drag the camera image that is most interesting to 
you onto the focus window. Use the controls at the bottom to operate the camera.
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Showing a group
To view another group, you can use the Device bar or the Group bar. To do this, either drag and drop the 
desired group from the Device bar into the display area or click on the desired group in the Group bar. The dis-
played group is indicated by a yellow bar in the Device bar as well as in the Group bar.

Fig. 60: Showing a group

Working With The Focus Window
At the bottom of the focus window is a Command bar with controls that allow you to operate the camera in 
the focus window. If you move the mouse pointer over the Command bar, further controls are displayed.
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Fig. 61: Camera in a focus window

Zooming And Moving Image Sections

Use the slider  to zoom. The zoomed image sections can then be moved with the mouse. These actions 

take place in the application. This means that only the image section of the current live image is modified. 
The camera will not move and therefore zooming will not affect the possible recording of the generated cam-
era image. 

 1. Drag the slider  to zoom in on or out of the live image.

 2. Move the image with the mouse to focus on individual image sections.

Select predefined image sections.

To quickly focus on a specific image section, you can use one of the factory default image positions that are 
predefined in the camera.

 n Overview , point of interest , preview  and detail view 

 n Top , bottom , left , right 

Move the slider Standard  to the next position or until you have found a suitable position. 

Accept and end calls.

To talk to visitors at the door, click on . To end an audio connection, click on .
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Opening Doors And Switching Lights

If a camera is connected to a door station and has been configured accordingly, you can open the door by 

clicking on . If the camera is also connected to a light switch and configured accordingly, the light can be 

turned on and off by clicking on .

Show Temperature

MOBOTIX cameras have a built-in temperature sensor that measures the temperature inside the housing. If an 
ExtIO module or an MX-GPS-Box is connected to the camera, you can also measure the ambient temperature 

of the module or the box and view it by clicking on .

Executing Softbuttons

Softbuttons can be used to switch additional devices or to send HTTP requests.

To execute a Softbutton, click on   to open the Softbutton menu, then click a Softbutton accordingly.

To edit Softbuttons see Softbuttons Settings.

Camera Sequencer

If you want to see a different camera in the focus window, simply drag that camera to the focus window. Note 
that the camera sequencer can also switch cameras automatically.

Instructions:

 1. Click on the camera sequencer icon  to activate the automatic switching. 

 2. Right-click on  to change the following settings:

 n Duration Slider: Move the slider to the desired duration (1 sec to 60 sec) to show each camera.

 n Autostart: Once you switch to the Grid view, the sequencer starts automatically.

 n Stop at event: The sequencer stops when an event has occurred, allowing you to further investigate 

the situation. To start again, click on .

 n Restart after confirmation: Activate this option if you want to avoid having to restart the sequencer 
over and over again.

Group Sequencer

If you want to display a different camera group in the focus window, drag and drop that camera group into 
the focus window. A grid with all cameras of the group will be displayed and each camera of the group will be 
shown sequentially in the grids focus window for a defined time. You can automate this camera group change 
with the group sequencer.
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Instructions:

 1. Click on the group sequencer icon  to activate the group sequencer.

 2. To change the sequencer settings right-click on :

 n Duration: set the duration to show each group. You can set a value between 1 sec and 60.  The “Com-
bined Sequencer”  activates the group sequencer together with the camera sequencer (“Autostart” on 
the camera sequencer is not needed). The group sequencer waits until all cameras on a grid or graphic 
have been cycled before switching to the next group. When the “Combined Sequencer” is active then 
the camera sequencers “Stop at Event” and “Restart after Confirmation” also apply to the group 
sequencer.

 n Autostart: Once you switch to the Grid view, the group sequencer will start automatically.

Switching group functions
At the bottom of the program window is a Command bar with controls that change depending on the selec-
ted view. In the Grid view, you can use the group buttons of the Command bar to control the functions of a 
camera group (Prerequisite: Group functions were assigned in the Group Functions dialog box). This means 
that you can switch on/off lights, open a door and make an announcement for a predefined camera of this 
group, regardless of the currently displayed camera. You can also assign the functions for switching on/off 
lights and opening doors to several cameras of this group, enabling you to switch on/off several lights or 
open several doors. 
    In addition, you can right-click on the group buttons to open the shortcut menu in order to control cameras 
that are not part of the current group. Before you can do this, the cameras have to be set up accordingly, that 
is, they need to be connected to door openers/light contacts and have to be configured properly.
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Fig. 62: Switching group functions

Manually recording live images
In the Grid view as well as in the Live view, you can start manual recording at any time, such as when you 
observe a suspicious situation that should be recorded. While you keep track of the situation in the live 
image, the images are recorded and saved as an MXG file. The camera's live image that is in the focus window 
is always recorded. For this reason, live recording can also only be used in the Grid view when there is a focus 
window.
     Users with administrator rights can specify where the clips are saved and how long the recordings can be in 
the      Preferences, p. 251     (Mac: menu: MxManagementCenter > Preferences > Live Recorder, Windows menu: 
File > Settings > Live Recorder). 

NOTE! This feature is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an 
ONVIF S-compatible interface. For an overview of how the camera functions differ, see      Camera Feature Over-
view, p. 9     .
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Fig. 63: Manually recording live images

Starting And Stopping Recordings

To start recording, click on Live Recorder . Recording will stop automatically after the recording time set 

in the program settings has expired. Just before this time expires, a message will be displayed. You can stop 
the recording from within this message or extend the set period of time. To stop recording before the time 

expires, click on  again.

NOTE! The recording ends automatically when switching to another view. However, changing the group 
within the Grid view will not result in an early termination of the recording, unless that group has no focus 
window. In the latter case, the recording will end. 

Play Clip

The live image data is stored in an MXG file at the location specified in Program Settings during recording. 
The clip file is automatically imported into the current project when the recording stops and the Device bar 

shows it alongside the  icon in the Clips section. You can click on the clip name to playback the *MXG clip 

file via the Device bar. 

Working With the Graphic View

You can define a floor plan (ground plan) in the Graphic view and place the cameras or camera groups 
according to their actual positions. The icon of the corresponding camera turns red in case of an alarm (or 
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green upon a bell event). A simple click is enough to show the current live image of the triggering camera, 
allowing you to quickly check the situation.

Temporarily showing the live image of a camera
To temporarily display the live image of a camera, move the mouse pointer over the camera icon. In addition, 
the live image of another camera group can also be displayed in the Graphic view. Drag & drop the desired 
camera from the Camera bar onto the floor plan. When changing the view, the live image disappears.

Automatically display all live images of a group
To keep track of all live images in the current group, you can activate the camera sequencer or the group 
sequencer. When the sequencer is activated, all live images of the camera group are displayed one after 
another in a small window. You can move this window to any location and enlarge it or make it smaller. 

Camera Sequencer

If you want to see a different camera in the focus window, simply drag that camera to the focus window. Note 
that the camera sequencer can also switch cameras automatically.

Instructions:

 1. Click on the camera sequencer icon  to activate the automatic switching. 

 2. Right-click on  to change the following settings:

 n Duration Slider: Move the slider to the desired duration (1 sec to 60 sec) to show each camera.

 n Autostart: Once you switch to the Grid view, the sequencer starts automatically.

 n Stop at event: The sequencer stops when an event has occurred, allowing you to further investigate 

the situation. To start again, click on .

 n Restart after confirmation: Activate this option if you want to avoid having to restart the sequencer 
over and over again.

Group Sequencer

If you want to display a different camera group in the focus window, drag and drop that camera group into 
the focus window. A grid with all cameras of the group will be displayed and each camera of the group will be 
shown sequentially in the grids focus window for a defined time. You can automate this camera group change 
with the group sequencer.

Instructions:

 1. Click on the group sequencer icon  to activate the group sequencer.

 2. To change the sequencer settings right-click on :
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 n Duration: set the duration to show each group. You can set a value between 1 sec and 60.  The “Com-
bined Sequencer”  activates the group sequencer together with the camera sequencer (“Autostart” on 
the camera sequencer is not needed). The group sequencer waits until all cameras on a grid or graphic 
have been cycled before switching to the next group. When the “Combined Sequencer” is active then 
the camera sequencers “Stop at Event” and “Restart after Confirmation” also apply to the group 
sequencer.

 n Autostart: Once you switch to the Grid view, the group sequencer will start automatically.

Switching group functions
At the bottom of the program window is a Command bar with controls that change depending on the selec-
ted view. In the Graphic view, you can use the group buttons of the Command bar to control the functions of 
a camera group (Prerequisite: Group functions were assigned in the Group Functions dialog box). This means 
that you can switch on/off lights, open a door and make an announcement for a predefined camera of this 
group, regardless of the currently displayed camera. You can also assign the functions for switching on/off 
lights and opening doors to several cameras of this group, enabling you to switch on/off several lights or 
open several doors.
    In addition, you can right-click on the group buttons to open the shortcut menu in order to control cameras 
that are not part of the current group. Before you can do this, the cameras have to be set up accordingly, that 
is, they need to be connected to door openers/light contacts and have to be configured properly.

Fig. 64: Switching group functions
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Operate Door Stations

Door Stations can also be integrated and operated with the MxManagementCenter. For this purpose, Door Sta-
tion-specific functions are provided in addition to the program functions for cameras.

NOTE! Door Station functions are not supported by MOBOTIX MOVE cameras and third-party cameras that 
provide an ONVIF-S/G-compatible interface. For an overview of how the camera functions differ, see:   

 n Camera Feature Overview, p. 9.

 n Door Station Settings, p. 209

Bell Signaling
If someone rings the doorbell, it can be indicated in different places of the application.
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Where? Explanation

Alarm bar 
and Alarm 
Info bar

A bell event is indicated by coloring the Alarm and Alarm info bar green. The prerequisite for 
this is that the Door Station bell events have been configured as alarms in the Camera Con-
figuration dialog. The Alarm bar ①  is located at the bottom of the MxManagementCenter and 
the Alarm Info bar ②  below the camera image of the corresponding door camera.
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Where? Explanation

Doorbell 
notification

When the bell is rung, a ringing notification is displayed, no matter which view you are in. The 
prerequisite for this is that the Door Station bell events were configured as alarms in the Cam-

era Configuration dialog and that the Notification  was not deactivated in the header.

NOTE! 
The notification can be temporarily disabled by an administrator by clicking on Notification 

 in the application header.
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Where? Explanation

Counter on 
the bell icon

The counter next to the bell icon  in the Live view is increased by one.

Setting Bell Signaling
Go to Door Station Settings, p. 209 to find out which signaling options can be combined and where they can 
be configured.

Open Door and Switch Lights
If the door camera has been set up properly, you can use MxMC to open the door and to switch the lights. To 

do this, use the  and  keys in the Live view Command bar and in the Command bar of the Grid view 

focus box.

Working With Multiple Monitors

MxManagementCenter supports the use of multiple monitors. Camera live images can be displayed on mon-
itors directly connected to the computer running MxMC. Camera live images can also be switched to addi-
tional display devices using an MxThinClient.

Displaying Live Images On Monitors Connected To The Computer
If several monitors are connected to the computer running MxMC, the live images of individual cameras can 
be displayed by double-clicking on the different monitors. To do so, double-click either:
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 n on a camera image in the Camera bar

 n on an event image in the Alarm bar

 n on a camera image in the Grid view

 n or on a camera icon in the Graphic view

and select the monitor on which you want to view the live image.   

Fig. 65: Displaying Live Images On Monitors Connected To The Computer

Using MxThinClient To Display Live Images On Additional Monitors
As far as MxMC is concerned, any number of monitors can be connected and operated. However, the number 
is limited by the graphics card installed in the computer. By using one or more MxThinClient devices, you can 
increase the number of display devices available for MxMC. This allows you, for example, to switch to addi-
tional display devices (monitors or TV sets) by double-clicking on the camera live images from MxMC.

NOTE! MxThinClient devices are not supported by MOBOTIX MOVE cameras and third-party cameras that 
provide an ONVIF-S-compatible interface. For an overview of how the camera functions differ, see Camera 
Feature Overview, p. 9.
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Adding a MxThinClient

 1. The MxMessageSystem needs to be activated in the Preferences, p. 251 because the camera live images 
are connected via this system (Mac: MxManagementCenter > Settings > MxMessageSystem; Windows: 
File > Settings > MxMessageSystem). Also, make sure that the same parameters are set as in the MxTh-
inClient.
   Furthermore, you must make sure that MxThinClient and the computer running MxMC use the same time 
server.

 2. Open the edit mode in the Device bar by clicking on  at the bottom of the bar. Next, click on . The 

Add and Import dialog opens.

Fig. 66: Adding a MxThinClient

 3. Click on  . The MxThinClient Configuration dialog box opens.

 4. Enter a name for the MxThinClient that will be shown in the Device bar. You can freely select the name.

 5. Use the URL option to enter the current IP address or DNS domain name.

 6. Under Serial Number you need to enter the factory IP address printed on the MxThinClient housing. 
Remember that you need to enter the number correctly because it represents the address at which the 
MxThinClient is accessed in the MxMessageSystem.

 7. Enter the user name and password you used when installing the MxThinClient.
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 8. Select the resolution that the camera's live image uses when data is sent to the additional display unit. If 
you select a resolution that is not supported by the display device, the message Resolution Not Sup-
ported is shown on the display of the display device. In this case, select a lower display resolution.

 9. Select how long the live camera image will be displayed before the MxThinClient will continue to run in 
the configured mode.
    If you select Unlimited for the display length, the camera's live image is displayed until the MxThinClient 
receives a new command, such as when an event is triggered based on an event-controlled setting.
   If you want to stop the display of the camera’s live image before the set display length elapses, click on 
the  icon. It appears when you move the mouse pointer over the name of the MxThinClient in the 

Device bar.

 10. Close the dialog box. Then deactivate the edit mode of the device bar by clicking on .

Using MxThinClient

To switch a live camera image to an additional display device, either double-click on the desired camera 
image or drag and drop the camera image to the appropriate MxThinClient in the MxThinClient section of the 
Device bar. 

NOTE! The MxThinClient section is only visible in the Device bar if a MxThinClient has been integrated.
You need to possess administrator rights to add, manage or delete an MxThinClient.

Working In Different Network Environments

Using MxManagementCenter, you can access cameras from different locations. For example, you can monitor 
the cameras at home over the local area network (LAN) or while on the move via a pre-configured DynDNS 
access over the Internet.

See also: Network Environments

Selecting an Environment
If you want to access the cameras from a different location (different network), select the corresponding pre-
viously created environment. Switching to a different environment causes the network address data for con-
necting to the cameras to be switched automatically.
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Fig. 67: Selecting an Environment

 1. Right-click on  in the Header bar. The Projects and Network Environments dialog opens.

 2. Click on Environment.

 3. Select the desired environment.

Temporarily Adjusting the Bandwidth
By assigning a bandwidth to an environment, you can specify how the images are pulled from the cameras 
given different connection speeds. This basically controls how the images can be displayed for live viewing 
and event research. Selecting a bandwidth thus also controls the image quality. Note that you can tem-
porarily overwrite the bandwidth setting without actually changing the camera setting.

 1. Click on  in the Header bar. The Bandwidth Mode dialog opens.

 2. Select the desired setting:
 n  HiRes: The images are transferred using the settings made in the camera.

 n  LoRes: Images are delivered at the frame rate, resolution and image quality as defined in the Pro-

gram Settings for LoRes.

 n  Unchanged: Use this to return to the original setting of the camera.
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Alarm Processing
An important component of a video management system is the alarm function. It allows you to specify which 
events lead to alarms and how you are notified in the event of an alarm. In addition, you can define the alert-
ing behavior for individual time periods in weekly profiles.

NOTE! Alarm processing functions are not supported by MOBOTIX MOVE cameras and third-party cameras 
that provide an ONVIF-S-compatible interface. For an overview of how the camera functions differ, see Cam-
era Feature Overview.

Alarm Notification
Alarm-triggering events can be signaled at various points in the application.

Where? Explanation

Alarm bar 
and Alarm 
Info bar

If alarm notification has been activated in the Camera Configuration, the Alarm and Alarm 
Info bars will turn red and will inform you about the events that triggered the alert (green 
when a bell is rung). The Alarm bar ①  is located at the bottom of the MxManagementCenter 
and the Alarm Info bar ②  below the camera image of the corresponding camera.

Alarm Noti-
fication

In addition, you can choose to receive an alarm message and an alarm sound.
 This requires the alarm notification option to be enabled in the Camera Configuration dialog 
and the Alarms checkbox to be set in the Notifications section (Mac: 
MxManagementCenter > Settings menu, Windows: File > Settings ) menu.
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Camera icon 
and group 
icon in the 
Graphic 
view

When a camera detects an alarm, the corresponding camera icon turns red ②  or green (bell 
event). You can take a quick glance at the situation observed by the camera by showing a 
small live image (move mouse pointer over the icon) or by showing a live image on a second 
monitor, if available (double-click on the camera icon). 
If you positioned an additional camera group on the background image (floor plan), the cam-
era group turns red ②  or green when a camera in this camera group registers an alarm-trig-
gering event.

Setting Up Alarm Notification
The following table describes where and how the notification options can be set.
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Notifications Settings

Alarm bar, 
Alarm Info 
bar

For an alarm to be signaled in the Alarm bar and the Alarm Info bar, you must activate alarm 
notification for each camera and select the events that will trigger an alarm. 

 1. To do so, open the Camera Configuration dialog box by right-clicking on the cor-
responding camera in the Camera bar.

Optionally open the dialog box in the Device bar by clicking on  and then right-clicking 

on the corresponding camera.

 2. Click on Alarms, enable alarm notification and set the events that should trigger an 
alarm.
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Alarm Noti-
fication

In addition to signaling in the Alarm bar and Alarm Info bar, you can set up a visual and aud-
ible alert. Do so by navigating to the notifications (Mac: MxManagementCenter > Settings 
menu, Windows: File > Settings menu), selecting the Alarms option and then selecting the 
alarm sound, alarm duration and volume. 

Camera icon 
and group 
icon in the 
Graphic view

In order for the camera icon and group icon to turn red or green in the Graphics view when 
an alarm event occurs, the same settings must be made as for notification in the Alarm bar 
and Alarm Info bar.
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Setting time 
ranges for 
alarms

In addition, you can select a weekly profile for every event type that should trigger an alarm.

 1. To do so, open the Camera Configuration dialog box by right-clicking on the cor-
responding camera in the Camera bar.

 Another option is to open the dialog box in the Device bar by clicking on  and then 

right-clicking on the corresponding camera.

 2. Make sure that the Alarms option has been activated.

 3. As long as no other weekly profile has been selected, the setting is valid from Monday 
00:00 to Sunday 24:00.

 4. Click on Edit weekly profiles to create a weekly profile for an event type. See also Set-
ting Alarm Filters for information on how to create and select a weekly profile.                         

Filtering Alarm Images
All Alarm images are displayed in the Alarm bar and in the Smart Data Search View. To get a quick overview, 
you can filter the display of images according to different criteria.

Filtering Alarm Images In The Alarm Bar ("Filtering The Display Of Alarm Images" section):
The alarm images in the Alarm bar are sorted chronologically. You can filter the display of alarm images by 
camera, group, event type, and confirmation status. 

Filtering the Smart Data Search View by event types:
All event images of the selected cameras are shown in chronological order. You can filter the view according 
to event types.                 
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Playing Back Alarm Recordings
You can play the recording of an alarm directly in the Alarm bar ("Playing Back Recordings" section) or dir-
ectly in The Smart Data Search View, p. 60.         

Researching in MxMC
This section describes basic research functions of MxMC.

Searching And Playing Back In Playback View

Recorded clips cannot only be played in the player, but they can also be searched. The way that you search 
depends on whether you want to search for specific events within the recorded clips or whether you want to 
search for events at specific times.

General Playback View controls

Fig. 68: General playback view controls

To search and play back recordings, first activate Playback mode  or select the date and time and then 

use the Previous/Next Image buttons , to browse the recordings; alternatively, you can start the 
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playback using the Forward/Backward Playback buttons . Hold the Forward/Backward Playback to 

select a playback speed between 0.5 times and maximum.

General operation of the Playback View for MOBOTIX MOVE and ONVIF-
S/G cameras

Fig. 69: General operation of the Playback View for MOBOTIX MOVE and ONVIF-S/G cameras

NOTE! All playback capabilities are supported by MOBOTIX MOVE cameras and third-party cameras that 
provide an ONVIF-S-compatible interface. For these cameras, recordings can only be played forward.

    Therefore, first select Date/Time ① , and then start playback using Forward Playback  ② .
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Performing PTZ actions in recordings

Fig. 70: Performing PTZ actions in recordings

NOTE! On a secondary monitor, a single camera image can only be zoomed with the mouse wheel or 
panned with the mouse button pressed down. PTZ controls are only available on the MxMC main screen or 
on the secondary monitor in Grid View.

You can zoom and move the visible image area not only in live images but also in recorded images (PTZ). This 
enables you to examine specific image areas more closely while the recorded video stream is playing back. 

On Dual cameras, the program also shows the  slider. Use this slider to show the images of either the right, 

the left or both image sensors. When playing back the recordings of hemispheric cameras, you can set dif-

ferent display modes .

Zooming and moving image sections
You can zoom using the slider  or the mouse wheel. To see other image areas, you can move the recorded 

image using the mouse.

Choosing a sensor 
On Dual cameras, you can opt to see the recordings of the right, the left or both image sensors. To do so, 

move the  slider to the right to  (left sensor) or further to the right to  (right sensor).
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Subsequent distortion correction of hemispherical images
When showing recorded images of hemispheric cameras or cameras with the lenses L12/B016, L23/B036, 
L25/B041, you can select different display modes. In order to get naturally-looking images, the camera will 
automatically correct the distortion in these modes. This distortion correction can be refined even further 
when using the panorama correction. Note that this type of correction only takes place locally. This means 
that the distortion correction of the recorded images only takes place on this computer. The stored record-
ings (from the camera or a file server) are not influenced in any way.

 n  Full image: Shows the entire (distorted) full image.

 n  Normal: Shows a distortion-corrected image and allows executing PTZ actions.

 n  Panorama: This option shows the distortion-corrected image of an entire room (corrected 180° pan-

orama view) from the left to the right wall. The aspect ratio (width to height) is 8:3. 

 n  Surround: This option shows four image sections (one for each cardinal direction: N, E, S, W) in one 

joint view. Note that you can use PTZ actions to modify all four views independently from one another.

 n  Double panorama: This mode shows a panorama view for the North half of the image and a 

second panorama view of the South half of the image using an aspect ratio (width to height) of 4:3. 
This mode only makes sense for a hemispheric camera that is mounted to the ceiling.

 n  Panorama focus: This display mode combines the panorama view (aspect ratio 8:3) with two smal-

ler images (each with aspect ratio 4:3) in one large image.

Selecting The Distortion Correction Mode

Move the slider  to the right until you see the desired view. This slider position will be stored automatically 

until you change it again.

Panorama Correction

The distortion-corrected images of the different display modes can be further refined using the panorama cor-

rection. Move the  slider to the right to  and use the mouse to correct the image. To store the corrected 

setting, click on the  slider and hold it until the slider icon briefly appears in the center of the image.

Browsing recordings for event images
When searching for event images, first select the image playback type:

 n Event images: Only shows event images.

 n Pre-event images: Shows only the first recorded image for each event.

 n Highlighted images: Shows only the images, which had been marked as important before.
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NOTE! This feature is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an 
ONVIF-S-compatible interface. For an overview of how the camera functions differ, see Camera Feature 
Overview.

Fig. 71: Browsing recordings for event images

 1. In the Playback view, select the Playback mode by right-clicking on  ① and selecting the desired mode 

② .

 2. Browse the recordings using the  and  buttons. Starting with the current event image, these but-

tons show the previous or next event image.

Browsing recordings for a specific date and time
If you have set up a continuous recording for certain times and you want to check for events during those 
times, for example, you can limit the search to these times. You can search for events at a given time by using 
time leaps or time-lapse playback.
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Searching for a specific date and time

Fig. 72: Searching for a specific date and time

 1. Click on Date/Time ①  and enter the date and time to search for.

 2. The event image jumps to the event in the recordings that is closest to the specified date and time.

 3. Click on Playback .

     or     

 1. Click on the Calendar slider ② . The date and time will be shown above the slider. 

 2. Move the slider until you reach the date and time that is closest to the point in time you want to examine. 
The event image jumps to the event in the recordings with the specified date and time. If such a record-
ing is not available, the event image jumps to the event that is closest to the specified point in time (in 
the direction of searching). In the latter case, the slider turns read the time difference to the specified 
point in time is shown above the slider.

 3. Click on Playback .

NOTE! The farther away you move the mouse pointer from the slider, the more precise your setting will be.

Searching Several Cameras For Persons Or Objects

Scenario: Camera A is overlooking the gate and signals an event. The event image in the Alarm bar shows a 
delivery truck driving through the gate. You want to know if the truck has also passed the area monitored by 
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camera B.

 1. To do so, move the mouse pointer over the event image. Three icons are shown. 

 2. Open the Playback view mode by clicking on .

 3. Play back the recording (end of recording) ① .

Fig. 73: Playback the recording

 4. Drag&drop camera B from the camera bar into the Playback view.
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 5. The playback automatically selects the recording that follows the end of camera A's recording ② . You 
can continue this process for any number of cameras.

Investigating Multiple Cameras For A Specific Point In Time

You want to know if other cameras have recorded something at a specific point in time:
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 1. Set the reference time using the Pin button ① .

 2. Drag the cameras from the Camera bar ②  one by one.

 3. The application shows the event images of each camera that are closest to the specified point in time.

Limiting The Search Range For An Incident
Scenario: Your camera monitors a parking lot from which a car had been stolen during the day. Follow these 
steps to locate the event as quickly as possible:

 1. Start the Playback mode (right-click on ) and select an interval (e.g., 1 day ).

 2. Keep clicking on Previous Image  until the car can be seen again in the image.
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 3. Now select a shorter interval (e.g., 1 hour ).

 4. Keep clicking on Next Image  until the car has left the frame.

 5. Keep on using shorter intervals until you have found the exact point in time of the incident.

NOTE! You can also use the Forward/Backward Playback  buttons to play back using the same time 

leaps.
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NOTE! This feature is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an 
ONVIF-S/G-compatible interface. For an overview of how the camera functions differ, see Camera Feature 
Overview.

Playing Back Recordings

Playing Clips

To play the clips, the play buttons  and the       playback mode are available in the Command bar 

of the Playback view. First set the desired mode for playing the recordings, such as event images only or with 
one hour time-lapse, in the Playback mode. 

Next, use the Playback Buttons to browse and play back the images one-by-one  or continuously 

 in backward or forward direction.

NOTE! As mentioned in General Operation Of The Playback View For MOBOTIX MOVE And ONVIF Cameras, 
playback of recordings is limited when using MOBOTIX MOVE cameras and third-party cameras that provide 
an ONVIF S-compatible interface. Recordings of these cameras can only be played forward. For an overview 
of how the camera functions differ, see Camera Feature Overview.
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The following table summarizes the actions that you can perform with the playback buttons, depending on 
the playback mode:

Playback Mode Playback Buttons

 Complete Record-

ings 

 Jumps one image backward/forward.

 Plays back all recordings backward/forward.

 Event Recording  Jumps to the end/the start of the recorded sequence.

 Plays back until the start/the end of the recorded sequence has been 

reached.

 Event Images

 Pre-alarm Images 

 Shows the previous/next image every time you click on the button.

 Highlighted Images

 1 day time lapse

 1 hour time lapse

 10 minute time 

lapse
 1-minute time 

lapses

 The previous/next images are shown automatically one after the other. 
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Setting The Playback Speed

The Playback Speed option  allows you to speed up or slow down the playback of a recording. This also 

applies if you play back a recording backward. 

 1. Click on Playback Speed. The background of the button turns dark gray.

 2. To play the recording forward, left-click and hold the left mouse button and move the mouse pointer to 
the right. The further you move the mouse pointer down (to the right), the faster the playback speed. 

 3. To play the recording backward, left-click and hold the left mouse button and move the mouse pointer to 
the left. Again, the further you move the mouse pointer down (to the left), the faster the playback speed.

Precise Positioning by Image

If you want to examine a scene very closely, you can view the recordings one image at a time. To do so, stop 

playback (click on  or ). Now use the two buttons  (forward) and  (backward) to navigate the 

images one by one.

Searching And Playing Back In The Grid Playback

If a camera registers an event and you want to know if and what other cameras in that camera group were 
recording at that time, you can use Grid Playback to view the recordings of multiple cameras synchronously. 
The camera in the focus window is the lead camera. So, if you are browsing the recordings on this camera to 
find events or specific situations or if you are playing back recordings, the other cameras will follow the lead-
ing camera as soon as playback is paused. The program always shows the event images that are closest to 
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the time stamp of the leading camera. If the time of the other cameras differs from the leading camera, the 
difference will be displayed at the lower border of the event images.

Fig. 74: Grid Playback

 1. Open Grid Playback by right-clicking on the Navigation button and selecting Grid Playback.

 2. Drag the desired camera group from the group bar.

 3. Use the time stamp in the focus window ①  or the calendar slider ②  to set the time.
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 4. All cameras jump to the event image that is closest to the specified point in time. The time stamp 
beneath each camera image shows the time and date of the image. The difference to the reference time 
is shown at the right.

NOTE! You can also use the Grid Playback by dragging a group onto the Playback view. The original camera 
will be shown in the focus window.

Smart Data System

With the MOBOTIX Smart Data System, transactions in MxMC can be linked to the video recordings made at 
the time of the transactions. Use the Smart Data Search to search all recorded events and related images. You 
can filter the results by all kinds of events.  You can reduce the results to the events you have marked as 
"important". The search results are displayed as list and/or as preview images including camera name, time 
stamp and type of event trigger. You can play back the recording to an event directly from the event image. 
From the Smart Data Search View you can easily access  the Playback View or the Export View (see Searching 
in the Smart Data Search View, p. 167).

NOTE! In order to use the MOBOTIX Smart Data System for third party systems - e.g. cash point systems, 
you must purchase a Smart Data License. No license is required for P7 IoT App data. The MOBOTIX IoT App 
Interface is integrated into MxMC by default.

NOTE! The Smart Data Search View is not available for MOBOTIX MOVE cameras and third-party cameras 
that provide an ONVIF-S-compatible interface. For an overview of how the camera functions differ, see Cam-
era Feature Overview, p. 9.

Searching in the Smart Data Search View
With the MOBOTIX Smart Data System, transaction data can be linked to the video recordings made at the 
time of the transactions. Smart Data source can be e.g. MOBOTIX P7 Apps (no license required) or general 
Smart Data sources (license required) like POS systems or license plate recognition systems.

The  Smart Data System enables you to quickly find and review any suspicious activities. The Smart Data Bar 
and the The Smart Data Search View, p. 60 are available for searching and analyzing transactions. The Smart 
Data Bar provides a direct overview of the most recent transactions (from the last 24 hours) and for this 
reason it is convenient to use it for reviews and searches.

Smart Data Sources can be added and configured in The Components View, p. 61.

NOTE! The Smart Data Search is not available for MOBOTIX MOVE and third-party cameras that provide an 
ONVIF-S-compatible interface. For an overview of how the camera functions differ, see Camera Feature 
Overview, p. 9.
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Opening the Smart Data Bar
The Smart Data Bar is available in all views. To open the Smart Data Bar, click on the right frame border of 
the application. If the Alarm Bar will appears, click on the frame border again to switch to the Smart Data Bar. 
You can also display the Smart Data Bar from menu (View > Smart Data Bar).

Fig. 75: Smart Data view

The Smart Data Bar provides a direct overview of the most recent transactions (from the last 24 hours) and 
for this reason it is convenient to use it for reviews and searches.

Using the Smart Data Bar
If a Smart Data Source, e.g. a cashpoint is transmitting new data to the camera, the Smart Data Bar is auto-
matically updated. It enables live surveillance of the cash point and of the retail data of a camera. You can 
group transactions that belong together and display them.

 n Displayed time range: The Smart Data Bar only contains the data from the last 24 hours. To search 
data that is older than 24 hours see Defining Search Filters, p. 169.

 n Search feature / Filter feature: You can filter the entries for each cash point’s camera by search term. 
The hits are highlighted in yellow. You can jump to the next/previous search result using the two 
arrows on the lower edge.

168 / 350



 n Do not show system transactions: By default, the Smart Data Bar shows all transaction that are 
stored on the corresponding camera. Some of the transactions, e.g. from a cash point, show purchases 
and events that are directly associated with the purchases, such as the “Total sum.”  Other trans-

actions show only administrative events, such as when the cashier logs on.  Click on  to enable/dis-

able display of system transactions.

 n Do not group receipts (for VECTRON cashpoints only): Transactions are grouped by receipt number 
or purchase by default. Individual sales can be grouped if the cash point signals the conclusion of the 
transactions by creating a receipt number. Counter sales can be grouped by counter if the counter is 
settled in the cash point system. Click on  to disable display by groups. The data will be reloaded.

 n Playback transactions: Open the Playback view by double-clicking on a transaction line. The trans-
action will be played back.

Detailed search and analysis in the Smart Data View
In the Smart Data View you can search and filter data of one or more Smart Data sources.

Fig. 76: Searching in Smart Data View

Defining Search Filters
You can define and store several search filters. The search query will be automatically saved every time the 
search criteria are changed. 

 1. Open the Smart Data Search View e. g via Menu View.

 2. Click on the name ①  of the Search to change it.

 3. Select the desired Smart Data Source ② . 

 4. Specify the period of time for the search ③ . You can also enter a period of time that allows you to enter 
any start and end time stamp, in addition to a series of preset time windows (including “today”).
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 5. To add another filter criteria click on  ④ . 

The criteria can be linked using  that all or one  filter criteria must match. 
 n Select  to define that all criteria must match

 n Select  to define that one of the defined criteria must match 

 6. Click on  to delete a search criterion.

 7. To define additional search queries click on  ⑤  and repeat steps 1–5.

 8. Click on Search ⑥  to perform a search. 

Deleting Search Filters
Click on  to delete a filter.

Displaying Search Results
The search results are displayed with preview images in a list with  detailed data or in tiles, depending on the 

selected display option from the Command Bar ⑦  (List View  or Tile View ).

Switching to Post Video Motion Detection
To switch Post Video Motion Detection from the Command Bar click the button  ⑦  

Playing Back Events
Instant Playback:

In the Tile View  you can watch the recording of an event directly in the event image (instant playback). To 

do so, move the mouse pointer over the image. Three icons appear. Click on  to start the playback.

NOTE! A click into the image after starting the playback opens the recording in full screen mode in the cur-
rent program window. If only a "TV testpattern" is displayed in the image, no recording is available.

Playback View:
   You can also play back the recording in the Playback view. To do so, move the mouse pointer over the event 

image. Click on  to switch to the Playback view.

Marking Events
When browsing event images in Tile View , you can right-click on an image to mark the event as "import-

ant." The same applies to events that you have marked as "important"  in the Playback view or in the 

Alarm bar: You can view them as a collection in the Smart Data Search View.
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Error Handling
An exclamation mark ①  is displayed in the results list bar. If it is red, errors have occurred. Clicking on the 
exclamation mark opens a window in which the respective cameras and the associated errors are listed. Dis-
played errors are:

 n general communication error

 n software version too old

 n camera model is not supported

 n camera is not reachable

Fig. 77: Smart Data Search error handling

Exporting Search Results as CSV file
For example, for further research with external applications or archiving Smart Data Search Results can be 
exported as CSV file. 
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Fig. 78: Exporting Smart Data Search Results

 1. Click the export icon ① .

 2. If necessary, change the file name and the export directory.

 3. Click Save.

The Histogram Bar

The histogram illustrates the distribution of event frequency and thus provides a quick overview of the 
events of one or more cameras.
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Fig. 79: The Histogram Bar

The Histogram Bar shows events of the selected source and selected time range.

NOTE! The range of logged events may reach farther back than the recordings.

Opening The Histogram Bar
To open the Histogram bar, select Menu View - Histogram Bar or drag the blue ribbon on the bottom margin 
of MxMC upwards. To begin with, the histogram always shows the entire range of the events logged by the 
camera.

Working With The Histogram
 

Fig. 80: Histogram bar in detail
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Histogram elements

① :  Resolution of zoomed area (high / low),  set zoom range of histogram,  event filter selection.

② : Event area

③ : Time range and selected camera / group

④ : Selected event

Refined view on event frequency

Click   to switch to a refined resolution of the zoomed area in more detail.

The length of the bars indicates the frequency of logged events per time unit.  The display switches to a higher 
resolution. 

For more detailed information on a specific point in time, click on the related spot in the zoomed area or the 
overview area. If you move the mouse point over an event, a tool tip shows more information.
In the Playback view, a red marker is also displayed to indicate the current position.

Displayed Time Range

Click  to set the displayed time range (e. g. one day or six months). To define a custom time-range scroll 

the mouse-wheel on the Histogram Bar.

In the playback you can click on an event to jump to its/nearest recording.

Event Filters

Click  to select an event filter.
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These events can be selected:

 n MxActivitySensor Events

 n Video Motion Events

 n Behavioral Detection Events

 n Shock Detector Events

 n Illumination Events

 n Microphone Events

 n Passive Infrared Detector Events

 n Temperature Events

 n Internal Events

 n Message Events 

 n Meta Events

 n Signal Events

 n Time Events

 n Ringing Events

 n Mailbox Messages Events

 n Door Station Events

 n RFID Rejected Events

 n Pin Rejected Events

 n Thermal Events

 n All event types (default)

 

Searching With Post Video Motion Detection (Post VM)

Post Video Motion Detection allows searching recordings for changes in one or more image areas of a camera. 
The function is integrated as a smart search option. A legacy version function is also available.

 n Post Video Motion Detection (Post VM), p. 177

 n Post Video Motion Detection (Post VM) -legacy, p. 181
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Post Video Motion Detection (Post VM)
The post video motion detection allows searching recordings for changes in one or more image areas of a 
camera.  This is done with the help of “motion windows.”

Fig. 81: Integrated Post Video Motion Detection 
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Opening Post Video Motion Detection

 1. Open the Smart Data Search View e. g. via Menu View.

 2. In the Command Bar click the button  ① .

Creating motion windows 

Fig. 82: Creating motion windows 
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 1. Click on  ②  in the top right of the image area on the right-hand side of the settings dialog. The image 

of the selected camera with a predefined video motion window ③  shows up.

 2. You can execute the following commands:           
 n Modify the size of the video motion window: By moving the sides or the corners of the window. 

 n Create additional video motion windows: Draw a new window with the mouse. 

 n Duplicate a video motion window: Click on  .

 n Delete a video motion window: Click on  .

 n Deactivate a video motion window: Click on  .

 3. To close the editor window, click on  ④  in the top right corner of the window.

Setting the trigger conditions
The Post VM window provides options for setting different parameters that influence the motion detection res-
ults.

Fig. 83: Setting the trigger conditions

 n Trigger level: (White bar in diagram ⑤  )
Controls the trigger threshold of the video motion windows. Move the bar to the bottom to recognize a 
movement if only a few pixels change from one image to the next. Move the bar to the top to recognize 
a movement only if many pixels change.

 n  Sensitivity: ⑥
This setting controls how large the change of each pixel in a video motion window must be to count as 
movement. Together with a low threshold value, this setting can be used to fine-tune video motion 
detection. If you move the slider to the right, the detection sensitivity increases, i.e., even smaller 
changes will trigger the detection.
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 n  Correct Changes in Illumination: ⑦
Activate this option to avoid false alarms, such as when lighting conditions change rapidly (for 
example, from sun to a cloudy sky).

 n Deadtime: ⑧
This sets the amount of time after the last detected post video motion event, during which pixel 
changes in a video motion window are ignored.

 n  Median Value: ⑨
Enter a long duration (2.0 sec., for example) to improve the detection of slow movements.

Setting a value that is too high can lead to smears in the preview window.

 n  Color Filter: ⑩
Select a color to limit the motion detection to a specific range or colors. The Post VM event will trigger 
if this color changes during post video motion detection.

Searching for changes in Video Motion Windows

Once you have defined the video motion windows and have set the trigger conditions, you can search the 
recordings for changes in the video motion windows.

 1. Click on Search ⑪ .

NOTE! While search is running the "search" button becoms to a "cancel" button to stop/cancel the 
search.

 2. Click on a search result image ⑫ to show a preview image in the upper right corner ⑬ .
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Post Video Motion Detection (Post VM) -legacy
The post video motion detection allows searching recordings for changes in one or more image areas of a 
camera. This is done with the help of “motion windows.” 

Creating motion windows 

 1. Open the context menu of the plug in by right-clicking on . Select Post Video Motion detection. The 

dialog for setting up the post VM settings opens.

Fig. 84: Creating motion windows 

 2. Click on  in the image area on the right-hand side of the settings dialog. A new window with a pre-

defined video motion window opens.

 3. You can execute the following commands:           
 n Modify the size of the video motion window: By moving the sides or the corners of the window. 

 n Create additional video motion windows: Draw a new window with the mouse. 

 n Duplicate a video motion window: Click on  .

 n Delete a video motion window: Click on  .

 n Deactivate a video motion window: Click on  .

To close the editor window, click on  in the top right corner of the window.       
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Setting the trigger conditions
The Post VM window provides options for setting different parameters that influence the motion detection res-
ults.

Fig. 85: Setting the trigger conditions

 n Trigger level: (White bar in diagram)
Controls the trigger threshold of the video motion windows. Move the bar to the bottom to recognize a 
movement if only a few pixels change from one image to the next. Move the bar to the top to recognize 
a movement only if many pixels change.

 n Sensitivity:

 This setting controls how large the change of each pixel in a video motion window must be to count as 
movement. Together with a low threshold value, this setting can be used to fine-tune video motion 
detection. If you move the slider to the right, the detection sensitivity increases, i.e., even smaller 
changes will trigger the detection.

 n Correct Changes in Illumination:

 Activate this option to avoid false alarms, such as when lighting conditions change rapidly (for 
example, from sun to a cloudy sky).

 n Deadtime:

This sets the amount of time after the last detected post video motion event, during which pixel 
changes in a video motion window are ignored.
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 n Median Value:

Enter a long duration (2.0 sec., for example) to improve the detection of slow movements.
Note: Setting a value that is too high can lead to smears in the preview window.

 n Color Filter:

Select a color to limit the motion detection to a specific range or colors. The Post VM event will trigger 
if this color changes during post video motion detection.

Searching for changes in Video Motion Windows
Once you have defined the video motion windows and have set the trigger conditions, you can search the 
recordings for changes in the video motion windows. Use the playback buttons in the command bar at the 
bottom.
It is best to use the Backward/Forward playback  buttons when searching continuous recordings. For 

searching in event images, use the Previous/Next image  buttons. If MxMC detects a change within a 

video motion window, the frame of that window turns red and the search stops.

Searching And Playing Back Door Events

Door Station-specific events and recordings can be searched for and played back with MxMC, just like all 
other events and recordings. However, there are some small differences, which are discussed in more detail 
below.

NOTE! Door Station functions are not supported by MOBOTIX MOVE cameras and third-party cameras that 
provide ONVIF-S/G-compatible interface. For an overview of how the camera functions differ, see Camera 
Feature Overview.

Watching and Playing Doorbell Recordings

Bell Settings

If there were visitors ringing in your absence, you will see this by checking the counter near the Bell Settings 

 ①  in the Live view.

NOTE! The number displayed in the counter depends on the filter settings configured in the Alarm bar. 
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 1. Click on  to see who has rung. Instead of the live image, the event image for the last bell activation is 

displayed, and a red slider with the number "1" is displayed on the right side of the multislider ② . 

 2. If there are several doorbell recordings, click on the red slider and drag it to the left until the next higher 
number is displayed in the slider. At the same time, the event image also changes to the image of the pre-
vious bell activation.

 3. To play the respective  doorbell recording, click on  again. The view switches to the Playback view. 

Click on  . The recording is played back. 

Alarm Bar

A missed bell activation is also indicated by a green Alarm bar. This only happens if the Alarms option has 
been enabled for the corresponding cameras in the Camera Configuration dialog and if the bell event has 
been selected as an alarm triggering event. When the Alarm bar is opened, a green bar below the event image 
indicates a missed bell activation. You can watch the recording of the missed bell activation directly in the 
Alarm bar using the Instant Playback function. 
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 1. To do so, move the mouse pointer over the event image. Three icons appear. Click on  . The recording 

is played back directly in the Alarm bar. 

 2. You can also jump from the Alarm bar directly to the recording in the Playback view and play it back 
without having to search for it there. To do this, move the mouse pointer over the event image once 

again and click on .

Viewing and Listening to Voice Mailbox Messages

Voice Mailbox Messages                    

If visitors have left messages in your absence, this is indicated by the counter next to the voice mailbox mes-

sages  ①  in the Live view.

 1. Click on  to see who left a message. Instead of the live image, the event image for the last message is 

displayed, and a red slider with the number "1" is displayed on the right side of the multislider ② .

 2. If there are several messages, click on the red slider and drag it to the left until the next higher number is 
displayed in the slider. At the same time, the event image also changes to the image of the previous mes-
sage.

 3. To play and listen to the respective message, click on  again. The view switches to the Playback view. 

Click on  . The recording is played back.
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Alarm Bar

A voice mailbox message is also signaled to you in the Alarm bar by turning red, and the new event image is 

marked with the  icon. This only happens if the Alarms option has been enabled for the corresponding 

cameras in the Camera Configuration dialog and if the voice mailbox message has been selected as an alarm 
triggering event. To play back the message, move the mouse pointer over the event image. Three icons 

appear. Click on  . The message is played directly in the Alarm Bar (see The Alarm Bar, p. 50).

Searching and Playing Back Door Events
Like all events, door-specific events (e.g., attempts to open a door with an invalid PIN) can also be searched 
and played back. Playback and search option options are available in:

 n Searching And Playing Back In Playback View, p. 153

 n Searching And Playing Back In The Grid Playback, p. 165 

 n Searching in the Smart Data Search View, p. 167

Exporting Recordings

Using the Playback view, you can export recorded video data from one camera, while the Grid Playback 
allows exporting from several cameras at once. Use the Export bar to combine several clips to one export. You 
can save individual images with the Snapshot function.

Saving Snapshot Images
Snapshot images can be created in the Live and the Playback views for the displayed camera, and in the Grid 
view and Grid Playback for all displayed cameras.
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Fig. 86: Saving Snapshot Images

To do so, click on the Snapshot  button in the Command bar. By default, images are saved in the image 

folder of the user account. The destination path and the image settings for saved images can be selected via 
the MxManagementCenter > Settings > Snapshot Images (Mac) or File > Settings > Snapshot Images (Win-
dows) menu item.

Exporting Camera Recordings
The Playback view allows setting a time range for a recording (event recording or continuous recording) in 
order to select it for exporting.

 1. Open the Playback view.

 2. Drag the desired camera from the Camera bar or the Device bar.

 3. Find the start of the relevant recording.

 4. Specify the export range. There are two possibilities for this export:

Select export range using visual markers:

 1. Mark the start of the clip by clicking on the gray flag on the left .

 2. Play the recording until you have reached the end of the clip you want to export. Mark the end of the clip 
by clicking on the gray flag on the right. Both flags are now green.

 3. Click on Export  and select the export profile.
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 4. The Export dialog box appears. Select a target folder and enter a file name.

Manually capture export range:

First, make sure that no export area has yet been set using the "export flag." If an export area has already 
been defined, you can delete it. Do so by right-clicking on a flag and selecting Delete Time Range.

 1. Click on Export . Then click on the desired export profile ① . The dialog box used for defining the 

export range appears.
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 2. Specify the export range ② .

 3. Click on OK and then on Save.

NOTE! If you select the Automatically Import After Export checkbox in the Export dialog, the exported 
clip will be automatically added to the Camera bar and in the Device bar to the Clips & Recordings section.

Exporting Camera Group Recordings
The Grid Playback allows for setting a time range for a recording (event or continuous recording) in order to 
select it for exporting from multiple cameras.

 1. Open the Grid Playback.

 2. Drag & drop the desired camera group from the Group bar or the Device bar.

 3. Find the start of the relevant recording for the camera in the focus window. At the same, the search is 
extended to the other cameras in the group, and the recordings with the closest relevance to those in the 
focus window recording will be displayed in the tiles.

 4. Specify the export range. There are two possibilities for this export:
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Select export range using visual markers:

 1. Mark the start of the clip by clicking on the gray flag on the left .

 2. Play the recording until you have reached the end of the clip you want to export. Mark the end of the clip 
by clicking on the gray flag on the right. Both flags are now green.

 3. Instead of exporting all cameras of this group, you can also select one or more cameras for exporting. To 

do so, right-click on Export . A circle appears on the camera images in the top left corner. Select the 

desired cameras by clicking on the corresponding circles ① .

 4. Then click on Export  and select the export profile ② . The Export dialog box appears.

Fig. 87: Select export range using visual markers

 5. Select a target folder and enter a file name.

Manually capture export range:

Make sure that no export area has yet been set using the "export flag." If an export area has already been set, 
you can delete it. Do so by right-clicking on a flag and selecting Delete Time Range.

 1. Before you define the export range, you can limit the selection if you do not want to export all of the 

recordings that appear in the tiles. To do so, right-click on Export . A circle appears on the tiles in the 

top left corner. Select the desired cameras by clicking on the corresponding circles ① .
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 2. Click on Export  and select the export profile ② . The dialog box used for defining the export range 

appears.

Fig. 88: Manually capture export range

 3. Specify the export range ③ .

 4. Click on OK and then on Save.

NOTE! If you activate the Automatically Import After Export option, the exported clips are automatically 
added to the Group bar.

Exporting Recordings From The Export Bar
The Export bar provides a quick and easy way to take camera recordings and MXG clips by dragging and drop-
ping and create a list of recordings for subsequent exporting. From the bar, you can export recording time 
ranges as combined clips. You can add the clips in the Playback view, in Grid Playback and in the Smart Data 
Search View. After an export, the clips are not deleted automatically. It is deleted when the program is closed.

Adding Clips for Exporting in the Playback View

 1. Drag the desired camera or the desired clip from the camera bar or from the Device bar.

 2. Find the recording you are interested in.
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Fig. 89: Adding Clips for Exporting in the Playback View

 3. Mark the start of the time range by clicking on the gray flag on the left . Play the recording until you 

have reached the end of the clip you want to export. Mark the end of the time range by clicking on the 

gray flag on the right . Both flags are now green ① .

   You can set the end marker first (gray flag on the right), then play the recording from the beginning so 
you can set the start marker (gray flag on the left) at the desired point.

 4. Click on the image of the recording and maintain the position until you see a scaled-down image of the 
recording ② .

 5. Drag this image to the Alarm bar (regardless of whether or not it is open). The Export bar will open auto-
matically, allowing you to save the image there.

Adding Clips for Exporting in Grid Playback

The Export bar in Grid Playback is useful for combining sequential time ranges of different cameras.

 1. Drag the desired camera to the focus window in the grid and find the relevant recording.

 2. Mark the start of the time range by clicking on the gray flag on the left . Play the recording until you 

have reached the end of the clip you want to export. Mark the end of the time range by clicking on the 

gray flag on the right . Both flags are now green.
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 3. Click on the image of the recording in the focus window and maintain the position until you see a scaled-
down image. Drag this image to the Alarm bar (regardless of whether or not it is open). The Export bar 
will open automatically, allowing you to save the image there.

 4. After you have set the end marker of the time range, the recordings of all other cameras will reposition to 
show the same time. Drag the camera with the next recording in the sequence of events into the focus 
window. Mark the start and the end of the clip as described above, then drag the recording into the 
Export bar.

 5. Repeat these steps until you have added all recordings you want to export.

You can also add time ranges from several cameras in the Export bar.

 1. Simply drag the desired camera group from the Group bar or from the Device bar and search for the rel-
evant recording.

 2. Mark the start and the end of the clip as described above. The recordings of the other cameras will repos-
ition accordingly.

 3. Right-click on Export . A selection box with a checkmark appears in the top left corner of the record-

ings. If you do not want to add the recording range of a specific camera to the list, uncheck the selection 
box for that camera.

 4. Click on the image of the recording in the focus window and maintain the position until you see a scaled-
down image. Drag this image to the Alarm bar (regardless of whether or not it is open). The Export bar 
will open automatically, allowing you to save the image there. The selected clips will be copied to the 
Export bar.

 5. Repeat these steps until you have added all time ranges you want to export.

You can also add clips for the individual preview images of the selected transaction to the Export bar:

 1. Drag the transaction preview image in the Preview Image section and drop it on the Export bar.
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NOTE! If the following image is shown in the player view, there is no video data saved for the selected 
export period.

Fig. 90: No video data available for export

Editing Clips
If you have added a recording to the Export bar for which you previously used distortion correction or zoom 
features during playback, you can choose to export the clip with or without zoom. Likewise, you can export 
the clip with or without audio. To do so, move the mouse pointer over the recording in the Export bar. Three 
icons appear:
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 n : Clip is exported with zoom.

Click on  to export the clip without zoom. The icon is disabled.

 n : By default, the clips are exported with audio (provided that audio had been recorded).

To export without audio, click on . The icon is disabled.

 n : Note that you can play back the individual clips directly in the Export bar before exporting.

Click on   to do so.

Right-click on a clip to open a context menu with these functions: Manually adjust time range, activ-
ate/deactivate audio and zoom for all clips, duplicate a clip, delete one or all clips.

Exporting Clips
Click on Export , then select MOBOTIX to export an MXG clip. Select a different profile to create an AVI, 

MP4 or MKV file. However, depending on the data source (e.g. MOBOTIX NAS) not all export profiles are avail-
able.
    Select a destination path in the Export dialog and enter a file name. Activate the Automatically Import After 
Export checkbox in the file selection dialog to automatically add the MXG clips to the Export bar after export-
ing.

Using The Application
Researching in MxMC
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Using Joysticks MxMC
This section describes the usage and integration of joysticks in  MxMC.

General usage of joysticks

The range of functions of a joystick varies depending on the model. Before using the device, familiarize your-
self with the range of functionality, e.g. by referring to the manufacturer's documentation.

NOTE! Before usage joysticks and keypads need to be calibrated (see Preferences, p. 251).

MOBOTIX PTZ Keyboard integration into MxManagementCenter

The MOBOTIX PTZ Keyboard is fully integrated into MxManagementCenter. For detailed information it's 
recommended to read the manual (see www.mobotix.com > Support > Download Center > Marketing & 
Documentation ).
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Fig. 91: MOBOTIX PTZ Keyboard

NOTE! Before usage joysticks and keypads need to be calibrated (see Preferences, p. 251).

Using The Application
Using Joysticks MxMC
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MxMC related key asignment
Button 
number

Primary MxMC Function Secondary Function (after pressing a "SELECT" but-
ton

 

Middle Section

0 Previous Camera 1

1 Next Camera 2

2 Cam Sequencer 3

3 Previous Group 4

4 Next Group 5

5 Group Sequencer 6

6 Device Tree 7

7 Alarm Bar 8

8 Smart Data Bar 9

9 Cancel Cancel

10 0 0

11 Enter Enter

Right Section

12 Door Opener  

13 Light toggle  

14 Softbutton 1  

15 Softbutton 2  

16 Softbutton 3  

17 Softbutton 4  

18 Softbutton 5  

19 Softbutton SELECT * (Button Com-
bination)

 

Left Section
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Button 
number

Primary MxMC Function Secondary Function (after pressing a "SELECT" but-
ton

 

Middle Section

24 Full Window  

25 PTZ SELECT * (Button Combination)  

26 Live Recording START / STOP  

27 Snapshot  

28 Microfone On / Off  

29 Handset Pick up / Hang up  

30 Select Monitor (Button Combination  

31 Select Camera (Button Combination  

Bottom Section

20 Previous Image  

21 Backward Play  

22 Stop / Pause  

23 Forward Play  

39 Next Image  

Top Section

34 Live View  

35 Playback View  

36 Grid View  

37 Graphic View  

38 Info View  

Jog Dial

Turn right Next image  

Turn left Previous image  

Jog Wheel

Turn right increase playback speed forward 4th axis

Turn left increase playback speed backward 4th axis

Using The Application
Using Joysticks MxMC
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Management
This section addresses administrators who manage a system using MxMC.

Topics Explanation

Group Views, p. 
202

Editing the layout of the Grid view, editing the layout of the Graphic 
view, assigning group functions, storing information for a camera group, 
limiting the frame rate of live images

Door Station 
Settings, p. 209

Bell settings, voice mailbox settings

Network Envir-
onments, p. 
215

Create and manage environments, customize network data for each 
environment

Cameras And 
Camera 
Groups, p. 217

Manage cameras, manage camera groups, integrate and manage third-
party cameras

User Man-
agement, p. 
238

General user rights, manage user rights

5
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Topics Explanation

Preferences, p. 
251

General settings, network, software update, notifications, monitoring, 
audio, data volume, caches, snapshot images, live recorders, remote con-
trol, joystick PTZ, MxMessageSystem

Checking Sys-
tem Security, p. 
280

Maintenance functions, security functions

License Man-
agement

Activate licenses, manage licenses

Group Views
After the initial installation, adjustments of the group views may be necessary. This section contains inform-
ation about more detailed Grid and Graphic view configurations as well as general group parameters.           

Editing the Grid View layout
When creating the camera groups, the Grid layout - the grid in which the cameras are   arranged - is created 

based on default values that can be customized. To do so,   click             in the Command bar or in the Device bar. 

The Command bar then displays several controls for   configuring the grid layout.
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Fig. 92: Editing the Grid View layout

As a first step, before you change the format of the camera images or the size of the focus   window, decide 
whether the grid layout should automatically adjust when you resize the window,   or whether you want to 
manually define the size of the tiles and their position.         

Using Auto Grid Mode

The auto grid mode  is used by default. In auto grid mode,   MxMC always tries to distribute the available 

space as well as possible according to   the specified aspect ratio of cameras images (4:3, 16:9, 8:3), the size of 
the focus   window and the number of cameras. This causes the grid layout to automatically                adapt to any 
changes. In auto grid mode, the following sliders are available for changing   the grid layout:

 n : Format of the camera images and the focus window (4:3, 16:9, 8:3) 

 n : Size of the focus window (1x, 2x, ..., 8x the size of the camera images)

 n : Maximum number of cameras

Move the sliders to the desired settings. To close the edit mode, click on .

Selecting manual mode

In manual mode , you set the size of the individual tiles   and their position based on the selected format of 

the camera images (4:3, 16:9, 8:3). In   contrast to auto grid mode, the layout is not adjusted automatically in 

manual mode. To   switch from auto grid mode to manual mode, move the slider  to the right until you 

reach the position .   The following sliders are available in manual mode:

Management
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 n  = Format of the camera images and the focus window (4:3, 16:9, 8:3) 

 n  = Maximum number of cameras

 1. Move the sliders to the desired settings.

 2. To move a tile to a different position, move the mouse pointer over the tile. Click   on  and drag the tile 

onto the desired position. For better orientation, a blue frame indicates   the target position.

 3. To set the size of a tile based on the selected format, move the mouse pointer over   the border of the tile 
until a double arrow is shown. Drag the tile to the desired size.

 4. To close the edit mode, click on .

Editing the Graphic View layout

Changing the camera position on the background image

In the Graphic view, you can define background images such as a floor plan or a plan   layout. You can then 
arrange the cameras of the group on these according to their actual   position. When opening the Graphic view 

of a camera group for the first time, all cameras   of the group are shown as an icon  at the right-hand mar-

gin of the background image ① .

To adjust the   position of the cameras, open the edit mode ②  by clicking on . Move the mouse pointer over 

the camera image.   Two icons are shown ③ . Click on  and drag the camera icon to the desired location.   To 

close the edit mode, click on .   When you exit the edit mode, the changed settings are saved automatically.

Fig. 93: Changing the camera position on the background image
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Editing camera icons

You can change the icon size and rotate the icons to reflect the viewing direction and the angle   of view of the 
cameras.
Open the edit mode ①  by clicking on . Move the mouse pointer over the camera image. A   dotted line in 

the shape of a square is shown around the camera icon. To make the camera icon   larger or smaller, click on 
the right or bottom left corner of the square and pull it inwards or   outwards ② . To change the orientation of 
the camera icon, hover the mouse pointer over   the icon until a hand is displayed. Hold down the mouse but-
ton and turn the camera icon around its   own axis until you are satisfied with the orientation. To close the edit 
mode, click on . When you exit the edit mode, the changed settings   are saved automatically.

Fig. 94: Editing camera icons

Dragging additional camera groups onto the background image

You can position additional camera groups on the background image (floor plan) of a camera group.   If a cam-
era of an added camera group detects an event and the Background Alarm has been   enabled for this camera, 
the camera group icon turns red or green (bell event). Click on the group   icon to open the Grid view of the 
camera group.
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Fig. 95: Dragging additional camera group onto the background image

Open the edit mode            and drag the desired camera group(s) from the Group or Camera bar onto the floor 

plan. To close the edit mode,   click on . When you exit the edit mode,   the changed settings are saved auto-

matically.

Positioning controls on the background image

The Command bar at the bottom of the Graphic view contains several controls. If a camera has been set   up to 
control a light, for example, you can switch the lights of this camera in the Graphic view. You   can drag these 
controls onto the background image (floor plan) and simply click on them to execute the corresponding func-
tion for easier operation later on. 
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Fig. 96: Positioning controls on the background image

Open the edit mode . To open   the shortcut menu, right-click on the desired operating function. Then drag 

the control to the floor   plan with the mouse pointer. To close the edit mode, click on . When you exit the 

edit mode, the changed settings are saved   automatically.

Assigning group functions

NOTE! 
Group functions are not supported by MOBOTIX MOVE cameras and third-party cameras   that provide an 
ONVIF-S/G-compatible interface. For an overview of how the camera functions differ,   see Camera Feature 
Overview, p. 9.

In the Grid, Graphic and Info view, you can use group functions to turn on a light, open a door, or make an 
announcement for one camera in the currently selected group.
 In addition, the Switch Light and Open Door group functions can be assigned to multiple cameras, so you 
can switch multiple lights or open multiple doors at once with a single click.
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Fig. 97: Assigning group functions

Proceed as follows to assign group functions:

 1. Open the edit mode in the Device bar by clicking on  at the bottom of the bar.

 2. To do so, move the mouse pointer over the group name. Three icons appear. Click on  . The Group 

Functions dialog opens.

 3. Assign the desired functions to the cameras by activating the respective checkboxes. 

 4. Once you have defined all group functions, you can deactivate the edit mode by clicking on .

Adding Information For A Camera Group
You can assign an information page to a camera group in order to show special instructions for this   camera 
group, for example.

 1. Open the edit mode in the Device bar by clicking on  at the bottom of the bar. Next,   click on  and   

then on . The Group Configuration dialog   opens.

 2. Move the slider  to the right until you reach the  position.

 3. Click on the arrow in the gray field and select the file you want to use.

Limiting the frame rate of live images
If a very large number of cameras is displayed in the Grid view, the performance may decline. To avoid this, 
you can limit the frame rate of the live images within the tiles. Note that this limit does not apply to the cam-
era displayed in the focus window.
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Fig. 98: Limiting the frame rate of live images

 1. Open the Group or Camera bar by clicking on the upper gray frame border. Click on the frame border 
again to switch to the camera Group view. 

 2. Right-click on the group icon and select the maximum number of frames per second and the maximum 
image size.

 3. Use ONVIF-S/G LoRes Profile: Use this checkbox to limit the frame rate for MOBOTIX MOVE cameras and 
for third-party cameras that provide an ONVIF-S/G-compatible interface. If the checkbox is enabled, the 
settings for the live images in the tiles captured in the Bandwidth Settings as the LoRes profile for these 
cameras will be used.

Door Station Settings
There are several ways that MxMC can respond to ringing and mailbox notifications. Here you will find inform-
ation on how to set these notification options.

NOTE! Door Station functions are not supported by MOBOTIX MOVE cameras and third-party cameras that 
provide an ONVIF S-compatible interface. For an overview of how the camera functions differ (see Camera 
Feature Overview, p. 9.

See also:
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 n Operate Door Stations, p. 140

 n Door Station Wizard, p. 299

Bell Settings

Setting the ring tone

Fig. 99: Setting the ring tone

 1. Open Settings in the MxManagementCenter > Settings (Mac) or File > Settings (Windows) menu and 
click on Notifications.

 2. Select the desired ring tone and adjust the volume.

Setting bell signaling
When a bell is rung, this can be indicated in different locations in MxManagementCenter. Consult the fol-
lowing table to learn which signaling options can be combined and where they can be configured.

NOTE! The alarm signaling must be activated in the camera settings, a bell profile must be set up and the 
correct bell profile must be selected in MxMC for bell notification to work.
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Notifications Settings

Alarm bar, Alarm info bar, 
doorbell notification,
 counter on the bell icon
 in the Live view

You need to configure the alarm notification for the doorbell ringing to be 
indicated at these places.

 1. To do so, open the Camera Configuration dialog box by right-clicking on 
the corresponding camera in the Camera bar.
Another option is to open the dialog box in the Device bar by clicking on 

 and then right-clicking on the corresponding camera.

 2. Click Alarms and activate the Alarm notification and the doorbell ringing.

Ring tone off
You can switch off the ring tone of the signaling by setting its volume to "0" 
(see Setting The Ring Tone).

Counter on the bell icon only Deactivate doorbell ringing in the Alarms dialog box and only the counter on 
the bell icon will increase by one each time.              

 1. To do so, open the Camera Configuration dialog box by right-clicking on 
the corresponding camera in the Camera bar.
Another option is to open the dialog box in the Device bar by clicking on 

 and then right-clicking on the corresponding camera.

 2. Click Alarms and deactivate doorbell ringing.

Completely off Disable the Bell checkbox in the Bell Settings  to switch off the bell com-

pletely (see Turning Off The Bell Completely).

Management
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Selecting a bell profile
A bell profile basically controls the reaction if someone is ringing at the door station. The camera provides sev-
eral predefined bell profiles. 

Profile Explanation

No phone ring MxMC and all other remote stations will not react, i.e., you will not notice if someone is 
ringing (neither visually nor by sound).

Ringing You will hear if someone rings the doorbell. The visitor cannot leave a message.

Ring and Mail-
box

You will hear if someone rings the doorbell. If no configured remote station reacts within a 
given period of time, the Door Station plays back a previously recorded announcement 
and the visitor can leave a message.

Voice Mailbox After ringing, the Door Station immediately plays back an announcement and the visitor 
can leave a message.

Announcement 
only

After ringing, the Door Station immediately plays back an announcement. The visitor can-
not leave a message.

Fig. 100: Selecting a bell profile

 1. Switch to the Live view of the Door Station.

 2. In the Live view, right-click on the Bell icon  to open the Bell Settings.
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 3. Click on Bell Profile and select the profile you want from the list.

Resetting the ringing counter

The counter next to the bell icon  in the Live view is incremented each time the doorbell is rung, regard-

less of whether or not you react to the ringing. Resetting the counter will help in recognizing if you have 
missed a ringing, which is why you are encouraged to regularly reset the counter. Once you have reset the 
counter, you will be informed how long ago the last reset took place.

 1. Switch to the Live view of the Door Station.

 2. In the Live view, right-click on the Bell icon  to open the Bell Settings.

 3. Click on Reset Counter.

 4. The counter has been reset and is no longer shown next to the Bell Settings  button.

Turn bell off completely
If you do not want to be disturbed by the doorbell, you can deactivate a specific bell or contact number. This 
means that ringing is neither signaled at any of the remote stations, nor is the "ringing counter" increased. In 
this case, you will not be informed about missed visitors and visitors will not be able to leave any messages.

Fig. 101: Turn bell off completely
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 1. In the Live view, right-click on the Bell icon  to open the Bell Settings.

 2. Disable the Bell checkbox.

Mailbox settings

Selecting a voice mailbox
Depending on the installed options and the configuration of the Door Station, you may have several bell but-
tons or – in case a MOBOTIX Keypad module has been installed – several contact numbers. Each of these bells 
or contact numbers has its own mailbox. The corresponding mailboxes are presented in the list (below the 
name of the bell).

NOTE! All settings made in the Mailbox function always apply to the selected mailbox. This also means that 
the new messages counter only applies to this mailbox. To get the messages and recordings of a different 
mailbox, select that mailbox first. 

Fig. 102: Selecting a voice mailbox

 1. In the Live view, right-click on the Voice Mailbox icon  to open the Mailbox Settings.

 2. Click on Voice Mailbox to select the desired mailbox from the list.

You can select a bell profile for each voice mailbox. For instructions on how to do this, see Selecting A Bell 
Profile.
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Activating The Voice Mailbox And Selecting A Welcome Message

 1. Enable the Active checkbox.

 2. Click on the Announcement button. Select the announcement to be played to the visitor.

Enabling the Message
If visitors should be allowed to leave a message, activate the Leave Message option.

Network Environments
Using MxManagementCenter, you can access cameras from different locations. For example, you can monitor 
the cameras at home over the local area network (LAN) or while on the move via a pre-configured DynDNS 
access over the Internet. These two methods require the use of different network access data. To avoid hav-
ing to change the network access data every time, you can set up different network environments for the cor-
responding network access data in MxManagementCenter. Switching to a different environment causes the 
network address data for connecting to the cameras to be switched automatically (see Working In Different 
Network Environments, p. 146).

Creating and Managing Environments

Creating environments

 1. Click on  in the Header bar. The Projects and Network Environments dialog opens.

 2. Click on Environment and then on . This adds an environment with the name "New Environment". 

Assign a suitable name.

Management
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Fig. 103: Creating environments

Changing names and deleting environments

 1. Open the Network Environments dialog box.

 2. Editing names: Click on  . Highlight the name and overwrite it. 

 3. Deleting environments: Click on  next to the environment you want to delete. Click on the red Delete 

box to the right of the environment.

Configuring network data for each environment

 1. To set network data, open the Camera Configuration dialog. To do this, either right-click on the indi-
vidual cameras in the Camera bar or open the Edit mode in the Device bar and right-click on the indi-
vidual cameras. The Camera Configuration dialog opens.

 2. Environment: Shows the current network environment. After starting the program for the first time, it 
shows the standard environment. All existing network environments are shown in the blue bar. Click on 
the environment you want to use. Next, perform the required network settings for this environment.
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 n Background alarm calls: Specify whether a permanent event stream connection to the camera should 
be established in the selected environment or not. You can deactivate this option if a permanent event 
stream connection is not required or even unwanted (when using MxMC in low-bandwidth networks, 
for example). If this option has been deactivated, the application will only open an event stream con-
nection if necessary, such as for showing the live stream of the camera or recordings via the camera. 
In this case, alarms will only show for this camera, while the connection has been established.

 n Remote: Only activate this option if you want to access the camera from a remote location (e.g., via 
DynDNS).

 n SSL: If you rather want to use an encrypted connection for the selected environment, activate this 
option (recommended setting). Note that HTTPS needs to be activated on the camera (in the browser 
in Admin Menu > Network Configuration > Web Server > HTTPS Settings).

 n Bandwidth: Select the bandwidth to use for this environment:
HiRes: The images are transferred using the settings made in the camera. 
LoRes: Images are delivered at the frame rate, resolution and image quality as defined in the Prefer-
ences, p. 251 for LoRes.

Camera configuration
This section describes basic options to configure cameras.

Cameras And Camera Groups

Here you will find information on the administration of cameras and camera groups. This includes topics such 
as changing the network data of a camera or exchanging cameras between camera groups.

NOTE! Administrator rights are required to perform these administrative functions.

Managing cameras

Editing camera data

To change a camera's access data and network data, open the Camera Configuration, p. 223 dialog.
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Fig. 104: Editing camera data

 1. To do this, either right-click on the desired camera in the Camera bar ①  or open the edit mode in the 
Device bar and right-click on the corresponding camera ② . The Camera Configuration dialog opens.

 2. Edit the data as desired.

Editing Camera Data Of Multiple Cameras

In the Multi-Camera Configuration dialog, you can change the authentication data used by MxMC as well as 
the environment settings of multiple cameras in one step.

 1. To do this, open the edit mode in the Device bar by clicking on .

 2. Select the cameras as needed.
 Mac: CMD + click, Windows: CTRL + click

 3. Right-click on one of the selected cameras. The Multi-Camera Configuration, p. 237 dialog opens.

Activating / Deactivating camera background alarms

NOTE! Background alarms are not supported by MOBOTIX MOVE cameras and third-party cameras that 
provide an ONVIF-S-compatible interface. For an overview of how the camera functions differ (see Camera 
Feature Overview, p. 9).

An activated option means that the application maintains an active event stream connection to the camera, 
regardless of whether or not MxMC is showing the live stream. Using the event stream connection, the 
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cameras will send event information to MxMC , which will show them as alarms depending on the settings 
(see Adding Cameras, p. 75). You can deactivate this option if a permanent event stream connection is not 
required or even unwanted (due to high system loads on systems with very many cameras or when using 
MxMC in low-bandwidth networks, for example).

If this option has been deactivated, the application will only open an event stream connection if necessary, 
such as when MxMC shows the live stream of the camera or recordings via the camera. In this case, alarms 
will only show for this camera, while the connection has been established. This option is deactivated by fact-
ory default.

 1. To open the Camera Configuration dialog, either right-click on the corresponding camera in the Camera 
bar ①  or open the edit mode in the Device bar and right-click on the corresponding camera ② . The Cam-
era Configuration dialog opens. 

 2. De-/activate the Background Alarms function.
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Deleting cameras

Fig. 105: Deleting cameras

 1. Open the Camera Configuration dialog by right-clicking on the corresponding camera in the Camera bar 
①  or open the edit mode in the Device bar and right-click on the corresponding camera ② . The Camera 
Configuration dialog opens.

 2. Click on Remove.

Managing Camera Groups

Moving cameras between Camera Groups

The Device bar lets you quickly drag and drop cameras from one group to another.

 1. In the Device bar, open the edit mode by clicking on  and then drag and drop the cameras as desired.

 2. Close the Edit mode by clicking .
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Removing cameras from a Camera Group

Fig. 106: Removing cameras from a Camera Group

 1. Open the edit mode in the Device bar by clicking on .

 2. Drag and drop the camera from the appropriate group to .

 3. Once you have deleted the cameras from the groups, you can deactivate the edit mode by clicking on .

Deleting Camera Groups

Deleting a camera group will not delete the cameras that are assigned to the group.
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Fig. 107: Deleting Camera Groups

 1. Activate the Edit mode by clicking .

 2. Drag a group from the corresponding section to .

 3. Next, activate the edit mode by clicking on .
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Camera Configuration

Fig. 108: Camera Configuration

Cameras that are available in mxmshould be configured according to their intended useOpen the Camera 
Configuration dialog to enter and edit the camera data.

For bulk configuration of multiple cameras hold the SHIFT key when selecting the cameras.

Fig. 109: Bulk configuration of multiple cameras

Management
Camera configuration

223 / 350



Management
Camera configuration

Camera Access Data Configuration

224 / 350



Management
Camera configuration

225 / 350



Management
Camera configuration

Fig. 110: Camera access data configuration

Name: The camera name is displayed automatically. If required, you can enter an individual name for each 
camera.

Connection Protocol: In order for MxMC to be able to establish a connection to the camera, a suitable con-
nection protocol must be selected depending on the available interface of the camera manufacturer. If you 
have integrated the camera with the Welcome wizard, the corresponding protocol is used automatically. 
When manually adding the camera, select the appropriate protocol. The following protocols are available:

 n MOBOTIX: Select this protocol to establish a connection to a MOBOTIX IoT camera.

 n MOBOTIX with Pelco-D: The requirements to use Pelco-D protocol are:
 n MOBOTIX IoT Camera with MxBus or MxBus Module RS232

 n A PT Head with Pelco-D support 

 n The serial interface must be activated and configured in the camera software (for the parameter 
settings see the cameras reference manual the documentation of the pan and tilt head)

 n MOBOTIX MOVE: Select this protocol to establish a connection to a MOBOTIX MOVE camera.

 n ONVIF-S/G: Select this protocol to connect to an ONVIF-S/G compatible camera.

 n Axis PTZ: Select this protocol to connect to a camera with Axis PTZ control.

 n MOBOTIX Face Detect: Select this protocol to connect to a MOBOTIX P7 camera MOBOTIX Face Detect 
App running.

URL:  The IP address is either discovered automatically via Bonjour or it has been entered manually. MxMC 
supports both the IPv4 and IPv6 standards.

EXAMPLE: IPv6 address (in the square bracket) with port specification (after the last colon): [2001:d-
b8:10::1a]:16090

Remote URL: You can enter the corresponding external address of the camera (such as a DynDNS name) 
when adding it to access the camera from outside the local network. 

NOTE! Before you can access the camera from outside of the local network, you need to activate the 
Remote option in the Environment Settings, p. 227.

User name, password: Access data that had been entered when adding the camera. 
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Fig. 111: Camera network environment configuration

Environment: Shows the current network environment. After starting the program for the first time, it shows 
the standard environment. All existing network environments are shown in the blue bar. Click on the envir-
onment you want to use. Next, enter the network settings you want to use for this environment. To define 
environments, see Network Environments, p. 215.

Background Alarms: An activated option means that the application maintains an active event stream con-
nection to the camera, regardless of whether or not MxMC is showing the live stream.

Using the event stream connection, the cameras will send event information to MxMC, which will show them 
as alarms depending on the settings (see Adding Cameras, p. 75). You can deactivate this option if a per-
manent event stream connection is not required or even unwanted (e.g. due to high system loads on systems 
with very many cameras or when using MxMC in low-bandwidth networks).  

If this option has been deactivated, the application will only open an event stream connection if necessary, 
such as when MxMC shows the live stream of the camera or recordings via the camera. In this case, alarms 
will only show for this camera, while the connection has been established. This option is deactivated by fact-
ory default.       

NOTE! This option is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an 
ONVIF-S-compatible interface. For an overview of how the camera functions differ, see Camera Feature 
Overview.

Remote:  Activate this option if you want to access the camera from a remote location (via DynDNS). 

SSL: Activate this option  if you want to use an encrypted connection to the camera. By default, the con-
nection between MxMC and the camera is not encrypted. Note that HTTPS needs to be activated on the cam-
era (in the browser in Admin Menu > Network Configuration > Web Server > HTTPS Settings).       

NOTE! This option is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an 
ONVIF S-compatible interface. For an overview of how the camera functions differ, see Camera Feature Over-
view.

Bandwidth: Select whether you want to get the images from the camera in HiRes or LoRes by default. The 
values (frame rate, image size and image quality) used for HiRes and LoRes connections are set in section 
Bandwidth Settings for MOBOTIX IoT Cameras and in section Connection Settings for MOBOTIX MOVE cam-
eras. 
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Bandwidth Settings (MOBOTIX Cameras)       

Fig. 112: Bandwidth Settings (MOBOTIX Cameras)

To specify the bandwidth settings for HiRes and LowRes video profiles, you can set the following values:

 n frame rate in Frames per Second

 n Resolution

 n Image Quality

Connection Settings (MOBOTIX MOVE/ONVIF-S/G Cameras)       

CAUTION! In contrast to bandwidth settings of MOBOTIX cameras, changes to the media profiles of 
MOBOTIX MOVE / ONVIF-S/G cameras are made directly on the cameras. Therefore, these changes affect all 
applications that use these profiles.
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Fig. 113: Connection Settings (MOBOTIX MOVE/ONVIF-S/G Cameras)

You can specify:

Authentication method: Select between 

 n Username Token

 n Digest

To specify the bandwidth settings for HiRes and LowRes video profiles, you can set the following values

 n HiRes/LoRes Profile, which is defined as ONVIF-S/G profile on the camera:

 n Video Encoder profile

 n Video codec

 n frame rate in Frames per Second

 n Resolution

 n Image Quality
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Click on Create MxProfile ①  to create a profile, which is optimized for a MOBOTIX environment of the cam-
era. By default, MxManagementCenter creates two profiles named MxHiQuality for HiRes and MxLoQuality 
for LoRes.

Click on Transfer changes ②  to transfer changes on the loaded profiles to the camera.

Recording settings
Saved recordings can be accessed in a variety of ways, depending on the connection protocol.

With MOBOTIX cameras:

 n Via camera (MOBOTIX cameras): The camera is handling access to the recordings. 

 n Local Path: Local path (recordings are accessed on the local computer).

 n FileServer:File Servers are selectable when configured in MxMC (see File Server Settings, p. 303).

With MOBOTIX MOVE / ONVIF cameras:

 n MOVE Recorder: Access to recordings via a defined MOBOTIX NAS. Access data can be defined in the 
file server settings (see File Server Settings, p. 303).

Setting up and changing Alarm Notification

NOTE! The alarm feature is not supported by MOBOTIX MOVE cameras and third-party cameras that 
provide an ONVIF-S-compatible interface. For an overview of how the camera functions differ (see Camera 
Feature Overview, p. 9).

This section allows selecting the event types that will lead to an alarm if the corresponding event is triggered. 
An alarm will be indicated at the following locations: 

 n Alarm Bar turns red or green (door bell), the alarm images are shown in the Alarm bar.

 n Alarm Info Bar turns red or green (door bell) in the live images.

 n Alarm Settings allow setting up visual and sound notifications for alerting (Mac: 
MxManagementCenter > Settings, Windows: File > Settings).

 1. Click on Alarms. The Alarm Events dialog opens.
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Fig. 114: Editing Alarm Notifications

 2. Activate Alarm Signaling.

 3. Select the event types that should trigger an alarm.

 4. In addition, you can select a weekly profile for every event type that should trigger an alarm. As long as 
no other weekly profile has been selected, the setting is valid from Monday 00:00 to Sunday 24:00.
 n To create new weekly profiles, click on  . The Weekly Profiles dialog opens. Several predefined pro-

files are available, such as the Weekend profile (Saturday 00:00 to Sunday 24:00).

 n To add a profile, click on  . Enter a description. Highlight the desired active times in the table. You 

can resize an active time block by clicking on the time block and then moving the borders accordingly 
It is also possible to move a block. Click on the block to select it, then drag the block to the new pos-

ition. To delete a time block, click on  .

 n You can change the description of an existing profile. Right-click on the name and overwrite it.

 5. To select a weekly profile, click on the Weekly Profile dropdown list next to the event type and highlight 
the desired profile. The calendar icon turns white.
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 6. To easily invert the settings of the weekly profile, simply click on the calendar icon. For example, if you 
have created a profile with opening hours and would like to activate the alarms for the closing times, 

click on the calendar icon  to invert the profile. The icon turns red.
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Sensor Settings (MOBOTIX Cameras)       
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Fig. 115: Sensor Settings (MOBOTIX Cameras)

NOTE! The sensor settings are available only for MOBOTIX Cameras with two optical sensors.

You can specify how the sensors are to be integrated in MxManagementCenter.

 n Click on sensor 1 or 2 ① , to edit the sensor name.

 n Click on the Merge Sensors icon ②  to combine both sensors as one single camera to be integrated into 
MxMC.

 n Click on the Merged Sensor icon ②  to release the combination of both sensors. Each sensor will be 
integrated as individually configurable camera in MxMC.

 n Click into the Preview field ③  to set the recent video frame as preview image for the selected sensor.

Multi-Camera Configuration

The Multi-Camera Configuration dialog box allows changing authentication data used by MxMC and the 
environment settings of many cameras in one step. When opening the dialog, the application shows the cur-
rent settings of the cameras. The field is labeled with "multiple values" or a minus sign is shown in the  

checkbox if one option has several different settings.

Meaning of the setting options
The meaning of the entries can vary depending on the field type. The following table therefore gives a brief 
overview of the possible entries per field type and their meaning. 

Field type Current status

All cameras have the user name admin.

The cameras have different user names. 

This settings has been activated for all cameras.

This settings has been deactivated for all cameras.

The cameras have different settings. 

"HiRes" has been set as bandwidth setting for all cameras.

The cameras have different values. 
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Editing Settings
The fields and settings in the Multi-Camera Configuration dialog are much the same as those in the Camera 
Configuration dialog. One difference is the way settings are edited. Therefore, only the editing will be 
explained here. For more information about the general meaning of the settings, see the Entering And Editing 
Camera Access Data help topic instead. 

Unlike the Camera Configuration dialog, the Multi-Camera Configuration dialog allows you to reset settings 
that have not yet been saved. Depending on the field type, you can use different methods.

Field 
type

Explanation

If you change the text box of a setting, such as User name, a small cross appears on the right-hand 
side.  Click on the cross to reset the entry to its original value.

When closing the dialog, the previous setting will be restored. 

If you select Several Values in a selection box, closing the dialog will restore the previous setting.

Notes on the settings
When processing the following fields, these special features must be observed:

 n Recording path:
Local path: The Local Path option can be selected for all cameras. Note that you will need to enter the 
paths individually for each camera in the Camera Configuration dialog (see Recording Path in Enter-
ing and Editing Network Data).
Recording path: If you select a recording path (see Recording Path in Entering and Editing Network 
Data), MxMC automatically searches the device directory for each camera. The search has been com-
pleted if the progress bar is replaced by OK. If you close the dialog beforehand, you will have to enter 
the device directory for each camera in the Camera Configuration dialog.

 n Alarms:
The Alarms option activates or deactivates the alarm notification for all cameras. Note that you will 
have to set the alarm settings for the event types individually for each camera. Use the Camera Con-
figuration dialog to do this (see Setting up and Changing Alarm Notification).

User Management
In section user configuration of MxManagementCenter all users can be managed by an administrator. Three 
types of users can be managed:
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 n Administrator 

 n User 

 n Supervisor

For details see User Types, p. 246.

Fig. 116: Users settings

To open the User Configuration section click on  ①  in the header bar.

 Adding Users

 1. Click on the  icon ②  to add a user. 

 2. Enter the corresponding user name. 

 3. Select the  user type: User, Administrator or Supervisor.

NOTE! The user type is set to User by default.

 4. Enter a password and confirm it.

 5. The Force Complex Password option ensures that users can only set secure passwords.

NOTE! A secure password has at least eight characters, consists of lowercase and uppercase letters, 
including at least one special character, one digit and one character. Furthermore, it cannot be one of 
the last thirteen passwords used on this user account. If you are trying to set a password that does not 
meet the criteria, a red frame around the text field will appear.
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Further settings vary depending on the user type. For more details see: User Configuration, p. 241.

Deleting Users
Click on the  icon ③  and then on  next to the user you want to delete.

NOTE! The default Admin cannot be deleted

User Configuration
The User Configuration ⑦  appears when adding a new user or when clicking on an existing user. For a 
detailed description of the settings see User Configuration, p. 241

Auto Login
The Auto Login option ④  allows you to select an user which logs in automatically when 
MxManagementCenter is started.

Fig. 117: Auto Login
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Supervisors
A supervisor can execute functions for which regular user do not have access rights. These functions can be 
made available temporarily starting a Supervisor Mode. For a detailed description of the Supervisor Approach 
and Supervised Rights see details see Supervisor Configuration, p. 246

Fig. 118: Supervisor Configuration

 1. Click on  Supervisor Configuration⑥  to edit the Supervisor settings (see Supervisor Configuration, p. 

246). 

 2. In addition, you can specify after how many minutes of inactivity this user will be logged out auto-
matically.

NOTE! While a recording is being played back in Playback view or in Grid Playback, MxMC does not auto-
matically terminate the supervisor mode after the specified period of time.

 3. Select the functions that can be accessed after entering the password.

User Configuration

The User Configuration is accessable via the User Management, p. 238 dialog. The settings vary depending on 
the user type (see User Types, p. 246). 
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When adding a new user or clicking an existing user, the following settings can be edited:

Basic settings

Fig. 119: User basic settings

The following basic settings are available:

Name: Enter the user name as it should appear e.g. on the login screen.

Type: select the user type (see User Types, p. 246).

Active: Check to activate the user (default).

Password

Fig. 120: User password settings
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Password: Enter the login password.

Confirm Password: Repeat the password.

Expires: Select a period after which the password must be renewed frequently.

Force Change on Next Login: Check if the password needs to be changed the next time the user logs in.

Force Complex Password: Check if the password must meet the following requirements .

Requirements for a strong password:

 n At least eight characters

 n Includes lowercase and uppercase letters

 n Includes numbers

 n Includes at least one special character e.g. ,! @ # ? ]

 n Cannot be one of the last thirteen passwords used on this user account.

NOTE! If you are trying to set a password that does not meet the criteria, a red frame around the text field 
will appear.

Log in

NOTE! This section is not displayed when creating an administrator because the administrator always has 
all rights and access to MxMC.

Fig. 121: Login

Weekly Profile: Select a Weekly Profile to allow the user to access the system only at the times specified in 
the profile.

NOTE! The profile "24 hours" is set by default. This means the user always has access to MxMC.

Invert: Check to invert the access time which is defined in the selected weekly profile.
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Edit weekly profiles: Click to create or edit Edit weekly profiles. A dialog opens with the options Weekly 
profiles and Holidays. For details see Weekly Profiles, p. 249.

Log out

Fig. 122: Logout

Logout on inactivity: Select after how many minutes of inactivity the user will be automatically logged out.

 User Rights
Every user new has all possible user rights initially. Deactivate the rights that should not be available for a spe-
cific user in the User Rights section.

NOTE! This section is not displayed when creating an administrator because the administrator always has 
all rights and access to MxMC.

Change Password: Check to allow the user to change his login password.

Camera Groups: Select the Camera Groups that the user should have access to.
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Live: Select the functions the user should be able to use in Live mode:

 n Talk

 n Listen

 n Camera PTZ

 n Change Bandwidth

Research: Select the functions the user should be able to use in Research mode:

 n Audio Playback

 n Playback

 n Smart Data Search View

 n Histogram Bar

 n Export

 n Live Recorder

Event Handling: Select the events the user should be able to handle:

 n Confirm Alarms

 n Confirm all Alarms

 n Confirm and Comment Alarms

 n Confirm and Comment all Alarms

 n Change Event Filters

 n Event Types:
 n Selected events that will appear for the user in the The Alarm Bar, p. 50.

Device Switching: Select the devices the user should be able to switch:

 n Doors

 n Lights

 n Hyperlinks

Application Usage: Select the modules of MxManagementCenter the user should be able to use:

 n Header Bar

 n Tool Bar

 n Device Bar

 n Camera Bar

 n Group Bar

 n Alarm Bar
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 n Export Bar

 n MxThinClient Devices

 n Clips

 n Action Log

 n Switch Environments

 n Privacy Mode

 n AI Camera App

User Types

Administrator: An Administrator has all rights for configuring and using  MxMC.

User: An User can be added by an administrator only. An regular user cannot configure MxMC. Depending on 
user rights he can use the system,

Supervisor: A Supervisor can be added by an administrator only. As a Supervisor a user can execute func-
tions for which a regular user does not have the rights. He can temporally log in addition to a regular user e.g. 
if recordings only may be seen based on the four-eye-principle. A supervisor doesn't have administrative 
rights. See Supervisor Configuration, p. 246.

Also see User Management, p. 238.

Supervisor Configuration

The Supervisor Configuration is accessable via the User Management, p. 238 dialog. The settings vary depend-
ing on the user type (see User Types, p. 246). 
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Fig. 123: Supervisor Configuration

In the  Supervisor Configurationthe following settings can be made:

Basic settings
The following basic settings ①  are available:

Supervisor approach: Select the Supervisor approach

 n Disabled (default): Starting the Supervisor Mode is not possible

 n four-eye-principle: Supervisor mode can only be started when a Supervisor logs in additionally to the 
current user.

 n six-eye-principle: Supervisor mode can only be started when two Supervisor log in additionally to the 
current user.

Stop on Inactivity: Select the time period after which the supervisor mode should be automatically ter-
minated in case of inactivity.
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Supervised settings
In the Supervised Rights section ②  you can activate the functions that should be available in the Supervisor 
Mode.

Change Password: Check to allow to change the password of the current user.

Live: Select the functions the user should be able to use in Live mode:

 n Talk

 n Listen

 n Camera PTZ

 n Change Bandwidth

Research: Select the functions the user should be able to use in Research mode:

 n Audio Playback

 n Playback

 n Smart Data Search View

 n Histogram Bar

 n Export

 n Live Recorder

Event Handling: Select the events the user should be able to handle:

 n Confirm Alarms

 n Confirm all Alarms

 n Confirm and Comment Alarms

 n Confirm and Comment all Alarms

 n Change Event Filters

Device Switching: Select the devices the user should be able to switch:

 n Doors

 n Lights

 n Hyperlinks

Application Usage: Select the modules of MxManagementCenter the user should be able to use:

 n Header Bar

 n Tool Bar

 n Device Bar

 n Camera Bar
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 n Group Bar

 n Alarm Bar

 n Export Bar

 n MxThinClient Devices

 n Clips

 n Action Log

 n Switch Environments

 n Privacy Mode

 n AI Camera App

Weekly Profiles

In the User Management, p. 238 you can select for a user a Weekly Profile to grant access to MxMC according 
to profiles time schedule. The following steps describe how to edit Weekly Profiles and Holidays.

Editing Weekly Profiles
There are two predefined profiles available from the beginning: the Weekend profile (Saturday 00:00 to 
Sunday 24:00) and the Working days profile (Monday 00:00 to Friday 24:00). 

Fig. 124: Weekly Profile Editor

To edit a Weekly Profile you have the following options:

Adding a Weekly Profile
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 1. Click on  ① . 

 2. Enter a name ② . 

 3. In the time table ③  
 n define the desired active time blocks by dragging the mouse

 n resize an active time block by clicking on the time block and then moving the borders accordingly.

 n to move a block, dragit to the new position.

Editing a Weekly Profile

 1. Select the profile ② .
 n To change the name of an existing profile. Double-click on the name ②  and overwrite it.

 2. To modify the time schedule in the time table ③  
 n define the desired active time blocks by dragging the mouse

 n resize an active time block by clicking on the time block and then moving the borders accordingly.

 n to move a block,  drag it to the new position.

 n to delete a time block, select one first and then click on  ④ .

Deleting a Weekly Profile

 1. Select the profile ② .

 2. Click on the trash icon  ⑤ .

Editing Holidays                 
You can define holidays, which will be excluded from the Weekly Profile "Working Days".
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Fig. 125: Holiday editor 

Adding a holiday

 1. Enter or select the holiday date ① .

 2. Check Repeat annually ②  if required.

 3. Click on  ③ .

Editing a holiday

 1. Select the holiday ④ .

 2. Modify the holiday date ① .

 3. Check Repeat annually ②  if required.

Deleting Holiday

 1. Select the holiday ④ .

 2. Click  ⑤ .

Preferences
General program settings for MxManagementCenter can be changed in menu MxManagementCenter > 
Preferences (Mac) or File > Preferences (Windows). Settings can be edited in the following sections:
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General 

Fig. 126: General Settings

Language: Sets the program language. You may have to restart the software in order to apply your change.

Behavior: Deactivate this option to prevent that a double-click triggers the full-screen view on the main mon-
itor or on other monitors.

Display Area: If you are working with the Camera/Group bars or the Alarm/Export bars, you can change the 
width of the bars. Use this option to automatically resize the display area in such a case.

Graphics Mode: Activate to dewarp hemispheric images. A prerequisite for the OpenGL mode is a graphics 
card with OpenGL V2.1 support, since it performs the actual distortion correction of transferred hemispheric 
images. Deactivate OpenGL if your graphics card does not support this mode or if you experience problems 
when displaying the camera images.

Login: Check Do not show user list on login screen to hide the user list on the login screen.
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Fig. 127: Network

Proxy Server: Select the desired proxy here.

No Proxy, a direct connection will be established.

System Proxy will apply the proxy settings of the system, including the exceptions defined.
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Software Update

Fig. 128: Software Update

MxMC can use the update feature to automatically search for new program versions. To do this, check the 
Check for Updates checkbox and set the polling interval. The update function requires an Internet con-
nection.

The search for new versions can also be performed manually. To do so, click on Search Now. If a new pro-
gram version is available, you will see this here.
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Notifications

Fig. 129: Notifications

Alarms: In addition to the event notifications in the Alarm bar or the Alarm Info bar, you can set up an alarm 
notification and/or alarm sound that signals new alarms. Enable Alarm Notifications to receive an alert. 
Select the desired alarm sound and set its duration and volume.

Bell: When the bell is rung, a ringing notification is displayed. Select the desired ring tone for the notification 
and adjust its volume using this option (see Operate Door Stations, p. 140).
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Monitoring

Fig. 130: Monitoring

Lost Connections: If the connection to a camera is lost (e.g., due to a network failure or changed camera 
access data), the application can send a warning. 
    This is where you configure the warning. Activate the Lost Connection Detection checkbox and specify how 
you want MxMC to react if the connection to a camera is lost.

 n Play Sound: Select whether a warning sound should be played. With the HiRes only option, the warn-
ing sound is only played if the related camera is in HiRes mode (see Camera Configuration, p. 223).

 n Sound: Select a sound to be played on connection loss.

 n Show Warning: Select whether a warning should be displayed or not. With the HiRes only option, the 
warning is only displayed if the related camera is in HiRes mode (see Camera Configuration, p. 223).

 n Deadtime: Define how long the connection must be interrupted before a warning is triggered.

Action Log: MxMC can log any action, such as starting playback or export actions, activating the sound, etc. 
This means that you can log all user actions and thus deliver the entire chain of events for legal purposes.  
After enabling this feature, you must restart the application for the activation to take effect. The action log 
can be accessed from the menu File > Action Log. The Action Log can e. g. be used for troubleshooting pur-
poses (see Action Log, p. 345).

256 / 350



 n Archive and start new action log every: specify the interval at which the action log is to be archived 
and a new log is to be created.

 n Backup Path: Optionally specify a backup path to store the action log in PDF and CSV format and as 
encrypted MXL format. Leave the path blank to disable backup.

Application Error Report: After an unexpected program termination, a service report is usually created. If 
you do not want this, uncheck the Show Dialog checkbox.

Audio

Fig. 131: Audio

Use the slider to set the sensitivity for recording the sound from the camera microphone. The default setting 
has been optimized for Intercom connections and should only be touched in very noisy or very quiet door sta-
tion surroundings.

Hands-Free Talking and Push to Talk
   The Hands-Free Talking option is activated by default. If the surroundings are very noisy or if intercom prob-
lems persist, you should try to use the Push to Talk option.
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Data Volume

Fig. 132: Data Volume

Maximum Number of Events/Maximum Time Range: The number of events and the time range are con-
trolling how far into the past MxMC will look for event information after the next launch of the application. 
The settings apply to the event counter in Live View and the event preview images in Events View. This 
avoids long loading times and saves storage space when initially loading the event information.
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Caches

Fig. 133: Caches

Recording Path Cache Sizes: To improve playback performance, you can set the internal cache sizes for play-
back here. This applies to both playback via the camera and playback from a file server. Please be aware that 
the cache size set here will reduce the available RAM for other processes, which in turn can influence the per-
formance of other applications.

Event Images Harddisk Cache: To load event images faster and reduce network load, you can increase the 
disk cache for event images. If you do not want the system to save event images to disk, clear the Event 
Images Harddisk Cache checkbox.
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Snapshots

Fig. 134: Snapshot Images

You can save individual camera images as snapshot files. The settings allow to edit the destination path and 
the quality for snapshot images. If you do not specify a folder, the files will be created on the desktop. 
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Live Recorder

Fig. 135: Live Recorder

If you observe a suspicious situation that you want to record, you can start a manual recording in Live view as 
well as in Grid view. While you keep track of the situation in the live image, the images are recorded and 
saved as an MXG file. Here you can configure where the clips are stored and how long they are recorded. If 
you do not specify a folder, an MXG file will be created on the desktop.

Management
Preferences

261 / 350



Management
Preferences

Remote Control

Fig. 136: Remote Control

MxMC can be remote-controlled from other programs using HTTP requests. Activate this feature and set a 
proper port if you want to use this feature. Click on one of the example links to see a list of executable com-
mands.
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Joystick PTZ

Fig. 137: Joystick PTZ

You can adapt the joystick behavior to your personal requirements. Start by setting the PTZ type, then set the 
behavior for each axis.

PTZ Type

 n Screen PTZ: The PTZ actions are taking place in the application. This means that only the visible image 
section of the current live image is modified. Any zooming does not influence the recordings of the cur-
rent camera image that may be taking place.

 n Camera PTZ: Zooming actions are executed on the camera and also influence the recordings unless 
you are recording in full-image mode.

 n External PTZ: If you are using the camera of a different manufacturer, you can set its joystick behavior 
in this dialog.

Axes

 n X Axis: Horizontal movement

 n Y Axis: Vertical movement

 n Z Axis: Zooming
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Invert
Use this option to invert the joystick actions for that axis.

Sensitivity
If the PTZ actions are reacting too slowly, you can increase the sensitivity. If the reactions are too fast, reduce 
the sensitivity.

Progression
 Click on the  button to change the progression of the joystick movements. The default setting is linear pro-

gression. 

Calibrate Joystick
If you use a external joystick, it must be calibrated with MxMC so that the control functions exactly in the cam-
era image (see Calibrate Joystick, p. 267General usage of joysticks, p. 196).

NOTE! If you use a MOBOTIX PTZ keyboard see MOBOTIX PTZ Keyboard integration into MxMan-
agementCenter, p. 196.

MxMessageSystem

Fig. 138: MxMessageSystem
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This setting is currently required for the MxThinClient. Since the live camera images are switched to the MxTh-
inClient via the MxMessageSystem, you must first activate the MxMessageSystem here. Make sure that the 
same parameters are set as in the MxThinClient.

Customization

Fig. 139: Customization

This setting enables you to adapt MxMC optically to your needs. You can freely select the primary color of the 
headers and the font displayed there. You also can add an individual logo.

Select header color: Click to select an individual header color.

Select font color: Click to select an individual font color.

Select logo: Click to select a graphic file to be displayed as individual logo in the header. Possible file formats 
are .JPG, .PNG, .GIF
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Email Notification

Fig. 140: Customization

With the E-Mail Notification Feature MxMC can send an E-Mail Message with the Health Check results of all 
connected MOBOTIX IoT cameras. 

NOTE! The Background Alarm Feature of the related MOBOTIX IoT camera must be activated (see Camera 
Configuration).

Activate email notifications: When checked Email notifications will be sent .

Site: Enter a meaningful site name. It is used as the email sender name and in the email itself to identify the 
MxMC installation if you are receiving emails from different MxMC installations.

Recipient Address: The email address the messages are sent to

Secure (SSL-encrypted): Enable or disable the message encryption via SMTPS.

Adress: Enter the mail servers address. 

Port: The port used by the mail server.

Authentication: The authentication method used when contacting the mail server. This needs to be set to 
STARTTLS when “Secure (SSL-encrypted)” is enabled.
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Username: the username of the email account from which the emails are sent, usually the senders email 
address.

Password: The password for the users  email account.

Interval: the interval in which Health Check data should be sent.

Send test mail: Send a test email to check if the mail server is configured correctly.

 

NOTE! 
 n The email’s subject is the summary of the Health Check data, listing how many cameras are in the fol-

lowing states:
 n critical: major Health Check issues and communication / connection errors

 n warning: Health Check warnings

 n ok: everything is in order

 n noreply: the camera did not answer the Health Check request within the timeout duration, cur-
rently 10s

 n The content of the email is HTML formatted. It begins with the site, then the date of the Health Check 
and the number of cameras checked, followed by the summary. The main part of the content is a 
table containing the Health Check data for every camera checked.

 

 

Calibrate Joystick

If you use a external joystick, it must be calibrated with MxMC so that the control functions exactly in the cam-
era image.
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Calibrate Joystick

Fig. 141: Calibrate Joystick

 1. Install your joystick according to the manufacturer's instructions.

 2. Click Calibrate Joystick. A notification appears.

 3. Move all axes of your joystick, then click OK.
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Components Settings
In the  Component View, you can manage the following components:

 n Cameras which are available in MxMC (see Camera Settings, p. 269).

 n File Servers that are used to store video recordings (see File Server Settings, p. 303).

 n Smart Data Sources (license required for general sources) from which you can read transaction data, 
e.g. from MOBOTIX P7 Apps (no license required), POS systems or license plate recognition systems 
(see Smart Data Sources, p. 309).

 n MxThinClients,  which allow you to display live images from MOBOTIX cameras on a monitor or TV set 
with HDMI connection (see MxThinClient Settings, p. 312).

 n Softbuttons can be used to switch additional devices or to send HTTP requests (see Softbuttons Set-
tings, p. 315). 

Camera Settings

In the camera section of the Components View cameras can be managed.

Cameras that are available in MxMC should be configured according to their intended use. Therefore open the 
Camera Configuration dialog to enter and edit the camera data.
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Adding a Camera

 1. Click the  icon ①  to add a camera. 

 2. Configure the camera in the Camera Settings, p. 270 area ② . 

Deleting a Camera

 1. Click the  icon ①  to add a camera. 

 2. Configure the camera in the Camera Settings, p. 270 area ② . 

Camera Settings
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 1. Select the camera to be configured.

 2. Configure the camera in the Camera Setting area.

NOTE! 
For bulk configuration of multiple cameras hold the SHIFT key when selecting the cameras.

Fig. 142: Bulk configuration of multiple cameras

Name: The camera name is displayed automatically. If required, you can enter an individual name for each 
camera.

Connection Protocol: In order for MxMC to be able to establish a connection to the camera, a suitable con-
nection protocol must be selected depending on the available interface of the camera manufacturer. If you 
have integrated the camera with the Integrating cameras with the Welcome Wizard, p. 75, the corresponding 
protocol is used automatically. When manually adding the camera, select the appropriate protocol. The fol-
lowing protocols are available:

 n MOBOTIX: Select this protocol to establish a connection to a MOBOTIX IoT camera.

 n MOBOTIX with Pelco-D: The requirements to use Pelco-D protocol are:
 n MOBOTIX IoT Camera with MxBus or MxBus Module RS232

 n A PT-Head with Pelco-D support 

 n The serial interface must be activated and configured in the camera software (for the parameter 
settings see the cameras reference manual the documentation of the pan and tilt head)

 n MOBOTIX MOVE: Select this protocol to establish a connection to a MOBOTIX MOVE camera.

 n ONVIF-S/G: Select this protocol to connect to an ONVIF-S/G compatible camera.

 n Axis PTZ: Select this protocol to connect to a camera with Axis PTZ control.

 n MOBOTIX Face Detect: Select this protocol to connect to a MOBOTIX P7 camera MOBOTIX Face Detect 
App running.
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IP Address: The IP address is either discovered automatically via Bonjour or it has been entered manually. 
MxMC supports both the IPv4 and IPv6 standards.

EXAMPLE: IPv6 address (in the square bracket) with port specification (after the last colon): [2001:d-
b8:10::1a]:16090

Remote URL: You can enter the corresponding external address of the camera (such as a DynDNS name) 
when adding it to access the camera from outside the local network.  

NOTE! Before you can access the camera from outside of the local network, you need to activate the 
Remote option in the Environment Settings, p. 272.

User name, password: Access data that had been entered when adding the camera. 

Environment Settings

Environment: Shows the current network environment. After starting the program for the first time, it shows 
the standard environment. All existing network environments are shown in the blue bar. Click on the envir-
onment you want to use and enter the network settings  for this environment. To define environments, see 
Network Environments, p. 215.

Background Alarms: An activated option means that the application maintains an active event stream con-
nection to the camera, regardless of whether or not MxMC is showing the live stream.

Using the event stream connection, the cameras will send event information to MxMC, which will show them 
as alarms depending on the settings (see Adding Cameras, p. 75). You can deactivate this option if a per-
manent event stream connection is not required or even unwanted (e.g. due to high system loads on systems 
with very many cameras or when using MxMC in low-bandwidth networks).  

If this option has been deactivated, the application will only open an event stream connection if necessary, 
such as when MxMC shows the live stream of the camera or recordings via the camera. In this case, alarms 
will only show for this camera, while the connection has been established. This option is deactivated by fact-
ory default.       
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NOTE! This option is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an 
ONVIF-S-compatible interface. For an overview of how the camera functions differ, see Camera Feature 
Overview.

Remote:  Activate this option if you want to access the camera from a remote location (via DynDNS). 

SSL: Activate this option  if you want to use an encrypted connection to the camera. By default, the con-
nection between MxMC and the camera is not encrypted. Note that HTTPS needs to be activated on the cam-
era (in the browser in Admin Menu > Network Configuration > Web Server > HTTPS Settings).       

NOTE! This option is not supported by MOBOTIX MOVE cameras and third-party cameras that provide an 
ONVIF S-compatible interface. For an overview of how the camera functions differ, see Camera Feature Over-
view.

Bandwidth: Select whether you want to get the images from the camera in HiRes or LoRes by default. The 
values (frame rate, image size and image quality) used for HiRes and LoRes connections are set in section 
Bandwidth Settings for MOBOTIX IoT cameras and in section Connection Settings for MOBOTIX MOVE cam-
eras. 

Bandwidth Settings (MOBOTIX Cameras)       

To specify the bandwidth settings for HiRes and LowRes video profiles, you can set the following values:

 n Frames per Second

 n Resolution

 n Image Quality

Management
Components Settings

273 / 350



Management
Components Settings

Connection Settings (MOBOTIX MOVE/ONVIF-S/G Cameras)       

CAUTION! In contrast to bandwidth settings of MOBOTIX cameras, changes to the media profiles of 
MOBOTIX MOVE / ONVIF-S/G cameras are made directly on the cameras. Therefore, these changes affect all 
applications that use these profiles.

You can specify:
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Authentication: Select on of these authentication methods:

 n Username Token

 n Digest

To specify the bandwidth settings for HiRes and LowRes video profiles, you can set the following values

 n HiRes/LoRes Profile, which is defined as ONVIF-S/G profile on the camera:

 n Video Encoder 

 n Video codec

 n Frames per Second

 n Resolution

 n Image Quality

Click on Create MxProfile①  to create a profile, which is optimized for a MOBOTIX environment of the cam-
era. By default, MxManagementCenter creates two profiles named MxHiQuality for HiRes and MxLoQuality 
for LoRes.

Click on Transfer changes②  to transfer changes on the loaded profiles to the camera.

Recording settings
Saved recordings can be accessed in a variety of ways, depending on the connection protocol.

With MOBOTIX cameras:

 n Via camera (MOBOTIX cameras): The camera is handling access to the recordings. 

 n Local Path: Local path (recordings are accessed on the local computer).

 n FileServer:File Servers are selectable when configured in MxMC (see File Server Settings, p. 303).

With MOBOTIX MOVE / ONVIF cameras:

 n MOVE Recorder: Access to recordings via a defined MOBOTIX NAS. Access data can be defined in the 
file server settings (see File Server Settings, p. 303).

Alarms

NOTE! The alarm feature is not supported by MOBOTIX MOVE cameras and third-party cameras that 
provide an ONVIF-S-compatible interface. For an overview of how the camera functions differ (see Camera 
Feature Overview, p. 9).

This section allows selecting the event types that will lead to an alarm if the corresponding event is triggered. 
An alarm will be indicated at the following locations: 
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 n Alarm Bar turns red or green (door bell), the alarm images are shown in the Alarm bar.

 n Alarm Info Bar turns red or green (door bell) in the live images.

 n Alarm Settings allow setting up visual and sound notifications for alerting (Mac: 
MxManagementCenter > Settings, Windows: File > Settings).

 1. Click on Alarms.

 2. Select the event types that should trigger an alarm.

 3. In addition, you can select a weekly profile for every event type that should trigger an alarm. As long as 
no other weekly profile has been selected, the setting is valid from Monday 00:00 to Sunday 24:00.
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 n To create new weekly profiles, click on  . The Weekly Profiles dialog opens. Several predefined pro-

files are available, such as the Weekend profile (Saturday 00:00 to Sunday 24:00).

 n To add a profile, click on  . Enter a description. Highlight the desired active times in the table. You 

can resize an active time block by clicking on the time block and then moving the borders accordingly 
It is also possible to move a block. Click on the block to select it, then drag the block to the new pos-

ition. To delete a time block, click on  .

 n You can change the description of an existing profile. Right-click on the name and overwrite it.

 4. To select a weekly profile, click on the Weekly Profile dropdown list next to the event type and highlight 
the desired profile. The calendar icon turns white.

 5. To easily invert the settings of the weekly profile, simply click on the calendar icon. For example, if you 
have created a profile with opening hours and would like to activate the alarms for the closing times, 

click on the calendar icon  to invert the profile. The icon turns red.

Sensor Settings (MOBOTIX Cameras)

NOTE! The sensor settings are available only for MOBOTIX Cameras with multiple optical sensors.

You can specify how the sensors are to be integrated in MxManagementCenter.

 n Select sensor 1 or 2 ① , to edit the sensor name.

 n Select "Combined" ②  to combine both sensors as one single camera to be integrated into MxMC.

 n Click into the Preview field ③  to set the recent video frame as preview image for the selected sensor.
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Get SmartData Information of active camera apps     
All Smart Data information of apps available on a camera can be retrieved. The apps and related data (e. g. 
events) are then available as Smart Data Sources (see Smart Data Sources, p. 309).

NOTE! The feature requires at minimum camera firmware V7.3.1.54.

Refresh preview image     
Click to refresh the preview image of the selected camera based on the current live image.

NOTE! The feature requires at minimum camera firmware V7.3.1.54.

Camera Discovery    
When new cameras are detected in the network they appear here.

Components View - Camera Toolbar  
From the Camera Toolbar you can easily access major functions of the camera software. 

Select a camera to use the relevant functions.
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Icon Description / Function  

Reboot selected devices.  

Backup the selected devices. The current configuration of cameras or the cameras of a group can 
be stored. You can enter a name for each backup.

 

Restore Devices.  Click and select the desired backup file.  

Update the selected devices. 

Click to select and install the camera firmware from the file system.

You can apply a software version to a larger number of cameras at one time. Download the desired 
software version from the MOBOTIX download directory: www.mobotix.com > Support > Down-
load Center > Marketing & Documentation. Next, click Update Devices and open the *.mpl file. 
The new software will be uploaded to the cameras. The cameras will automatically reboot when 
the update is complete.

NOTE! The software you select to install must be compatible with all cameras in the group. 
Otherwise, the update cannot be performed.

 

Format the SD card of the selected device

You have three format options:

 n Quick Format

 n Secure Format (slow)

 n Quick Format with MxAnalytics/App Volume

NOTE! To use MxAnalytics or app functions you need to select Quick Format with MxAna-
lytics/App Volume.

 

Reset the selected device to factory settings.

During the reset process, you can select whether or not security settings (user names and pass-
words) and network settings should be reset, as well. The cameras will then automatically reboot.

NOTE! Project data will not be automatically updated when you reset the camera(s) to factory 
settings. You will need to update them manually. 

 

Health Check for the selected devices.

Click to switch to the Health Check mode.

A MOBOTIX camera independently checks its system status permanently. The results of the Health 
Check are available in a new tab in the Components View. 

Also see Health Check, p. 283.
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Icon Description / Function  

Secure System

Click to secure the selected devices.

This feature helps administrators when securing camera systems. It shows them exposed points of 
attack and prevents unauthorized or unencrypted access to cameras.

Also see Checking System Security, p. 280.

 

Initialize Door Station

This function is available only if the selected device is a door station. 

The door station wizard will guide you through the basic configuration steps of the selected door 
station.

Also see Door Station Wizard, p. 299.

 

SSL Certificates

Click to update the SSL Certificate of the selected device.

SSL is the standard technology for securing an Internet connection by encrypting the data sent 
between a website and a browser (or between two servers). This function allows an administrator 
to upload or create a SSL certificate to the selected cameras.

Also see Managing SSL Certificates, p. 284.

 

Show Live

Click to switch to show the live image of the selected camera in the web browser.

 

Show Admin

Click to show the Administration Overview page of the selected device in the web browser.

 

Show Setup

Click to show the Setup Overview page  of the selected device in the web browser.

 

Checking System Security
After completing the basic configuration of the system, it is recommended to check its security.  The Secure 
System Wizard is in the  Camera Toolbar of the The Components View, p. 61. It analyzes the security settings 
of the cameras and assesses their status based on common best practices. If test criteria are not met, pos-
sible measures to protect the cameras are provided. 

NOTE! The system security check feature is not available for MOBOTIX MOVE cameras and third-party cam-
eras that provide an ONVIF-S/G-compatible interface. For an overview of how the camera functions differ, 
see    Camera Feature Overview, p. 9   .
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Verifying Settings for System Security

 1. In menu View open the Components View.

 2. Select the desired cameras ① .

 3. In the Camera Toolbar ②  click  Secure System. The following criteria are checked:
 n Usage of the "meinsm" password with standard or ONVIF user accounts on MOBOTIX cameras. It is 

easy for cyber attackers to guess the standard "meinsm" password.

 n Enabled Public Access: If Public Access is enabled, a number of different camera functions can be 
used without a password.

 n Activated HTTP web server: It is possible for data, including user data such as passwords and images, 
to be transmitted via the network without encryption when HTTP is used. 
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The result of the check is displayed for each camera in the Secure System dialog. It will also show all cases in 
which cameras were not checked due to a connection error, for example.

Status Explanation

 Not secured There was at least one criterion that was listed as not secure.

 Software too 

old

Please check the camera software and update it, if necessary.

 Connection 

error

Check your network connection to the camera and perform the security check again. 

 Not supported The camera (s) cannot be analyzed or secured using the wizard.

 Secured Camera is secure; no further action is necessary.

 4. In the Secure System dialog, click on Next. Cameras resulting in a Not secure status are displayed 
together with whichever of the three criteria that were fulfilled as well as the measures that need to be 
taken to properly secure the cameras: 

Criterion Explanation

Password Changes the password of all user accounts on the cameras that use the standard “meinsm” 
password. It also include ONVIF users whose passwords have never been changed.
      Enter a new password and confirm it. A suitable password has at least eight characters. It can 
consist of lowercase and uppercase letters, digits and special characters (see ). If you set a 

password that does not meet these criteria, a red frame appears around the text field. The 
frame turns green once you have entered a valid password.
     The new password is automatically entered in the MxMC project data. 

SSL encryp-
tion

Disables camera connections via unencrypted HTTP and configures the cameras to accept 
HTTPs connections only.
      The TCP port and the SSL setting will be automatically updated in the MxMC project data, if 
necessary. 
      The TCP port will not be updated for cameras that are connected via a remote URL. For 
remote URL connections, you may need to change port forwarding in the router to the appro-
priate setting.
Please note that different services, such as network messaging etc., will no longer work when 
you disable HTTP. 

Public 
Access

Disables access that does not require password entry to the web interface and the APIs of the 
cameras. 
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 5. Click on OK in the dialog box. The selected security measures will be performed. The security status for 
the selected camera or camera group will be analyzed once again and the result for each camera is dis-
played. 

Health Check
A MOBOTIX camera independently checks its system status permanently. The results of the health check are 
available in the The Components View, p. 61.

Fig. 143: Health Check

 1. Click on Health Check.

 2. The camera-internal checking data is now queried and listed in tabular form.

The Health Check dialog provides a  overview of the proper operation or functional status of your MOBOTIX 
cameras. The Health Check is divided into two areas:
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Area Explanation

Overview Summary of the examined areas of the polled cameras by means of a color-coded system status 
report:

Red = error
at least one functional area signals an error condition.

Orange = Warning
one or more functional areas signal a warning.

Green = OK
all functional areas are working properly.

The overview area shows how many of the polled cameras are in an error state or warning state 
① . The table lines indicate the system health for each camera, including a summary of the error 
messages and warnings for each scanned area ② .

Details Detailed listing of the system state of the camera in the checked areas, which is displayed by 
clicking on the Camera bar in the overview area ③ .

NOTE! The Health Check is a background process. It can only collect data from cameras that are currently 
connected, therefore the background Alarm Feature of the according MOBOTIX IoT cameras must be activ-
ated (see Camera Configuration).

Managing SSL Certificates
SSL is the standard technology for securing an Internet connection by encrypting the data sent between a 
website and a browser (or between any two computers). This function allows an administrator to upload or 
create an SSL certificate to the selected cameras. 
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Upload an SSL certificate to a camera

 1. In menu View open the Components View.

 2. Select the desired cameras ① .
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 3. In the Camera Toolbar ②  click  Secure System. The SSL Certificate Wizard appears:

 4. If the status of the camera is OK click Next.

 5. Click Upload to upload an existing SSL Root Certificate including the private key.
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 6. Select an existing certificate, the private key and enter the certificate password.

 7. Click Verify Data. If data verification was successful click Next. 

NOTE! If data verification fails check your certificate.
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 8. Click Upload. A summary of successful uploads or errors appears and the camera will be rebooted. See 
Summary about successful uploads and errors, p. 295.
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Create a SSL certificate

 1. In menu View open the Components View.

 2. Select the desired cameras ① .
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 3. In the Camera Toolbar ②  click  Secure System. The SSL Certificate Wizard appears:

 4. If the status of the camera is OK click Next.

 5. Click Create to create a new SSL Root Certificate including private key.
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 6. Enter a Key Name and a Key Password for the private key and click Create and Save.

 7. After saving the private key click Next. The dialog Create Certificate Authority appears.
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 8. Fill out at least the mandatory fields and click Generate Cert.
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 9. Optionally you can create a backup of the SSL certificate. When clicking on Backup Cert, you can select a 
directory to save the certificate file.

NOTE! A backup of your certificate is recommended, e.g., if you need to distribute it on other 
MxManagementCenter installations within your project.

 10. Click Next.

 11. Enter the certificate password you defined in Enter a Key Name and a Key Password for the private key 
and click Create and Save., p. 291.

 12. Click Verify Data. If data verification was successful click Next.

NOTE! 
If data verification fails check your certificate. 
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 13. Click Upload. A summary of successful uploads or errors appears and the camera will be rebooted. See 
Summary about successful uploads and errors, p. 295.

Summary about successful uploads and errors

The certificate could not be verified

There is no matching root certificate in the MxMC “Certificates“ folder.
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The certificate hostname does not match the camera hostname

This can happen if the camera still has the MOBOTIX factory certificate but is connected using a different host-
name than the factory-supplied one.

Four or more cameras report SSL errors.

When four or more camera connections report SSL errors at the same time a list of untrusted cameras is 
shown.
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Display the SSL certificate information
If an SSL error occurs it is now possible to display detailed certificate information.
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SSL error on one camera

 1. Click View certificate information.
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List of multiple cameras with SSL errors

 1. Select a camera in the camera list.

 2. Click on the exclamation mark icon on the right ① . The related certificate information appears.

 

Door Station Wizard
The Door Station wizard will guide you through the basic configuration of a selected door station.  It is 
accessable from the  Camera Toolbar of the The Components View, p. 61. 

Also see:

 n Door Station Settings, p. 209

 n Operate Door Stations, p. 140

Basic requirements

 n Make sure that the devices run the latest software otherwise the configuration could fail.

 n Additional door stations (including S1x, S2x cameras) to be configured must be listed in the Device 
Bar.

 n Apply the default password "meinsm" to all door stations. To do so, you can use the Secure System 
Wizard.

 n Apply the default password "meinsm" to MxDisplay devices to be configured.

Step by step

 1. Open Components in menu View.

 2. Select the related door station (camera) Device bar or the Camera/Group bar and click  Initialize Door 

Station. The Door Station Wizard starts up.
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 3. Read the introduction text and make sure you meet the basic requirements for the further configuration. 
Click Continue.
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 4. Select the devices you want to configure and click Continue. The Selected devices will be configured. 
This can take while.

NOTE! Only devices with suitable software can be selected. The Master door station cannot be deselec-
ted.
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 5. Check the summary of the configured devices and click Continue.
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 6. Follow the next remaining configuration steps and click Finish.  
 n Initialization of door station RFID module

 n Add MxBell as remote Station

 n Define all relationships between addresses and remote stations

 n Configure I/O wiring

 n Final configuration of all door station (cameras)

 n Setup MxDisplay

File Server Settings

Stored images can be accessed in two ways: Access via the camera or directly to a file server where the 
recordings are stored. If access is to be direct, you can create recording paths here that can be assigned to 
the cameras. (See Recording settings, p. 232 or Recording settings, p. 275 ).
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Adding a File Server

 1. Click the  icon ①  and select a File Server type. 

 2. Configure the file server in the File Server Settings area ② . 

Configuring File Servers 
Name:
Enter a name for the file server here. Use this name to select the path in the Camera Configuration dialog as 
recording path.

Type:

 n Local: Contains a local directory on this computer or on a connected network drive. You can either 
enter the directory path manually, drag&drop a directory to the text box or select the directory.

 n Network Share: The program directly accesses a shared folder on a file server. In this case, you need 
to enter the computer, the folder and the access data. 

 n MOBOTIX NAS: Data is accessed directly on a shared folder on a MOBOTIX NAS. 

 n MOBOTIX NAS (ONVIF-S/G): The ONVIF-S/G recordings are accessed by the QVR Pro video man-
agement software, which  must be installed on a MOBOTIX NAS.
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     Local

Path: select the path that contains the recording folders created by the camera.

Network Share

  File Server (IP): IP address or DNS name of the file server with the share.

  Directory: Name of the share on the file server.

NOTE! Make sure that the path ends before the folder containing the factory IP address of the camera.

  User Name/Password: Access data for the network share.

Management
Components Settings

305 / 350



Management
Components Settings

MOBOTIX NAS
Data is accessed directly on a shared folder on a MOBOTIX NAS. 

  File Server (IP): IP address or DNS name and port of the MOBOTIX NAS.
  Directory: Name of the share on the MOBOTIX NAS. 

NOTE! Make sure that the path ends before the folder containing the factory IP address of the camera.

  User Name/Password: Access data for the MOBOTIX NAS.

MOBOTIX NAS (ONVIF)
The ONVIF-S/G recordings are accessed by the QVR Pro video management software, which must be installed 
on a MOBOTIX NAS.
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Fig. 144: MOBOTIX NAS settings

  File Server (IP): IP address or DNS name of the file server.
  User Name/Password: Access data for the file server.
  Use Expert settings (ONVIF-S/G access): If special access data are required for ONVIF-S/G access, enter them 

here.
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MOBOTIX NAS Configuration

Fig. 145: MOBOTIX NAS Configuration

The following functions are available for configuring and maintaining a MOBOTIX NAS or MOBOTIX NAS 
(ONVIF) system.

Quick Guides 

Links to download installation or configuration manuals for MOBOTIX NAS systems

Installation and Configuration 

 n Open Device Finder: The Device Finder finds MOBOTIX NAS systems in the network, making initial con-
figuration easy.

 n Configure NAS: Opens the web interface of the MOBOTIX NAS system with which you can configure the 
NAS device.

 n QVR Pro Settings: Opens the web interface of the video management software QVR Pro. This software 
must be installed on the MOBOTIX NAS system first.

 n Recording Storage Space: Opens the web interface of the MOBOTIX NAS system with the interface for 
setting up the storage space for video recordings.
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 n Troubleshooting: Here you can download the log files of the MOBOTIX NAS system or the QVR Pro soft-
ware.

 n Download links: Links to useful resources for installation, configuration and maintenance. 
  Container App: You need the Container App to install the QVR Pro App on a MOBOTIX NAS system.
  QVR Pro App: The software for managing recordings from MOBOTIX MOVE or ONVIF cameras on a 

MOBOTIX NAS system.
  Device Finder App - macOS: Use the Device Finder App to find MOBOTIX NAS systems in the network.
  2Bay and 4Bay NAS Firmware: The latest firmware for your MOBOTIX NAS system.
  8Bay NAS Firmware: The latest firmware for your MOBOTIX NAS system.

Smart Data Sources

With the MOBOTIX Smart Data System, transaction data, for example from POS systems or native MOBOTIX 
IOT apps, can be linked to the video recordings of transactions in MxMC. Smart Data can extensively be com-
bined, searched and filtered (see Searching in the Smart Data Search View, p. 167).

NOTE! A license is required to activate the general Smart Data interface from which you can read trans-
action data, e.g. from POS systems or third party license plate recognition systems.            

No license is required to use Smart Data from MOBOTIX IOT Apps. 

Fig. 146: Smart Data settings

Management
Components Settings

309 / 350



Management
Components Settings

Adding a Smart Data Source

 1. Click the  icon ①  and select a Smart Data type. 

 2. Configure the Smart Data Source in the Smart Data Settings area ② . 

Configure Smart Data Sources

NOTE! For external Smart Data Sources (e.g. Cash Points) a license is required.

Edit the  general settings and define how Smart Data should be displayed in the Smart Data Bar.

Fig. 147: Settings for Smart Data sources
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NOTE! To use MOBOTIX P7 Apps as Data Sources the minimum firmware version on the MOBOTIX IoT Cam-
era is 7.1.2.24.

 

Follow these steps in the camera user interface to prepare the camera to run properly with the Smart Data 
interface of MxMC:

 1. Go to Admin Menu > Smart Data Configuration and click Add Smart Data source.

 2. Enter the specific identifier for a P7 App - e.g.:

  Vaxtor: VaxALPR.plate

  FF Group: FFLPR.plate

  Visage: VT_Face.face

 3. Click Set.

 4. Store and reboot the camera.

 5. Go to Setup Menu > General Event Settings and enable Arming.

 6. Click Set.

 7. Go to Setup Menu > Recording and select:

  Arming = Enabled

  Recording (REC) = Continuous Recording,  2 fps

 8. Click Set.

 9. Go to Setup Menu > Certified App Settings and check "Active"

 10. Click "Set" button

Smart Data Settings

 n Version

Select the corresponding version of the Smart Data Source.

 n Description

Enter a meaningful name for the Smart Data Source here. Under this name, the source can be iden-
tified and selected in the MxMC for research.

 n Show Results in Search

Check this option if you want the data to be displayed in the search results (see Searching in the Smart 
Data Search View, p. 167).
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Smart Data Bar Setting

 n Show in Smart Data Bar

Check this option if you want the data to be displayed in the Opening the Smart Data Bar, p. 168.

 n Left Column

Select the data to be displayed in the left column.

 n Right Column

Select the data to be displayed in the right column.

 n Cameras

Drag & drop on the field the cameras or camera groups whose event data should be displayed in the 
Smart Data Bar. if multiple devices were added their names will be displayed in the Cameras field split-
ted by semicolons.

Hold the CTRL-key to select multiple cameras or camera groups. 

NOTE! The video source and the data source do not have to be identical.

MxThinClient Settings

MxThinClient devices allow displaying live images from MOBOTIX cameras on a monitor or TV set with HDMI 
connection.
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Fig. 148: MxThinClient settings

Adding a MxThinClient

 1. Click the  icon ①  . 

 2. Configure the MxThinClient in the Thin Client Settings area② . 

MxThinClient Settings
Edit the MxThinClient settings here. 
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Fig. 149: MxThinClient settings

Name
Enter the name for the MxThinClient (no spaces).

URL
Enter the URL or IP address of the MxThinClient.

User Name
Enter the user name of the MxThinClient user here.

Password
Enter the password of the ThinClient user here.

Display resolution
Select the resolution of the camera image to be displayed on the monitor of the MxThinClient.

Camera display
Select here how long the assigned camera image should be displayed on the monitor of the ThinClient. After 
the selected time period the ThinClient will display the configured setting (e. g. sequences, still images etc.).

Softbuttons Settings

Softbuttons can be used to send HTTP requests to camera or other external devices. When editing Soft-
buttons, you can select an individual button icon for the hyperlink or set one button from which to run all 
hyperlinks.

Fig. 150: Softbuttons settings
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         Adding a Softbutton

 1. Click the  icon ①  . 

 2. Configure the Smart Data Source in the Softbutton Settings area ② . 

Configure Softbuttons
Edit Softbuttons here.

Fig. 151: Settings for Softbuttons

 n Name: Enter a meaningful name for the Softbutton.

 n HTTP Command: Enter here the HTTP command to be sent to an external device or to a group of 
devices.
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 n Type: Select the type of HTTP Command. Available types are:
 n Static Link: A full URL is required here, e. g. "https://www.mobotix.com")

 n Camera Command: The HTTP Command is sent only to the selected camera.

 n Group Command: The HTTP Command is sent to the selected camera group.

 n SSL: Activate to use a secure connection.

 n Host Name: The IP address of the network device to be connected. MxMC supports both the IPv4 and 
IPv6 standards.

EXAMPLE: IPv6 address (in the square bracket) with port specification (after the last colon): [2001:d-
b8:10::1a]:16090

 n User Name: This field is available only if Type "Static Link" is selected. If required enter a user name.

 n Password: This field is available only if Type "Static Link" is selected. If required enter a password.

 n Camera Group: Select the camera groups in which the Softbutton should be displayed.

 n Show result: Check if the result of the HTTP request should be displayed in a separate browser win-
dow by clicking the Softbutton.

 n Seperate Button: Check if the Softbutton is to be shown in the Toolbar instead of the Softbutton 
menu.

 n Icon: Select an icon to be displayed with the Softbutton.

 Predefined Commands
Predefined Commands are a collection of Softbutton functions with predefined names and HTTP Commands.

Fig. 152: Settings for Softbuttons

Management
Components Settings

317 / 350



Management
Licensing

To add a Predefined Command click on  then configure the button (see Configure Softbuttons).

Licensing
Activation or purchase of a license is required to use certain features. This includes licenses for the following 
features:

 n Smart Data: industry-specific solutions and special features, such as integration with POS systems.

 n H.264 De-/Encoder: for displaying and exporting videos in H.264 format.

 n Cameras from third-party manufacturers: Integrate cameras from other manufacturers than 
MOBOTIX.

 n Advanced Config: Collection of functions for simplified configuration of cameras.

For license activation see MxMC Licensing, p. 318.

For camera models from the MOBOTIX P7 series there is the possibility to use apps. Apps, for example, offer 
extended functions for image analysis which may be supported by algorithms of artificial intelligence. Various 
apps are pre-installed on the camera and must be activated for use with a valid license key (see Camera App 
Licensing, p. 320).

MxMC Licensing

Activate licenses
After purchasing and receiving the activation IDs, enable them in MxMC as follows:

 1. Open the License Management (Window > Licenses menu item) and click on Activate Licenses.

Activate license

 2. Enter a valid activation ID and establish the number of licenses that will be installed on this computer. 
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 3. Click on  if you want to license an additional product. Enter the corresponding activation ID in the new 
line and enter the number of desired licenses.

 4. Click on  to delete a line.

 5. When you are finished entering all activation IDs, click on Activate. MxMC connects to the license server 
for activation. It needs to establish an Internet connection.

Fig. 153: Entering license key

 n Successful activation
If the activation was successful, you will need to sign in again to apply the changes. Alternatively, you 
can also return to License Management .

 n Activation failed (no Internet connection)
MxMC connects to the license server for activation. It needs to establish an Internet connection. An 
error message appears if there is no Internet connection. It will then save an offline request file (*.lic). 
This file enables the partner/installer from whom you purchased the licenses to generate a func-
tionality response (.bin file) on the license server. If you have received such a response, open the Activ-
ate Licenses window (Window > Licenses > Activate Licenses menu). Click on Load Functionality 
Response File. 
Once you have loaded the functionality response file, you will need to log back in to apply the 
changes. Alternatively, you can also return to License Management .

Management
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Managing Licenses

Fig. 154: Managing licenses

You can view a list of all licenses that have been activated on this computer in License management. To open 
the License Management, click on Window > Licenses in the Menu bar.

Designation Explanation

Product Name of the licensed function.

Expiration 
date

This column indicates whether the license is temporary and when the licensing period may 
end. 

Number Number of licenses that were purchased for a product. 

Device ID Unique identifier that is determined by MxMC for the used device. Note the device ID and keep 
it accessible if you should run into any problems during licensing.

Synchronizing licenses with the server
  When launching the program, it does not automatically compare the licenses on the computer with the 
license server. For this reason, you need to click on Update to reload the licenses from the server. 

Updating licenses
  To update temporary licenses, click on Activate Licenses. The dialog box used for updating/activating 
licenses is shown.

NOTE! You need administrator rights to synchronize and update licenses.

Camera App Licensing

For camera models from the MOBOTIX P7 series there is the possibility to use apps. Apps, for example, offer 
extended functions for image analysis which may be supported by algorithms of artificial intelligence. Various 
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apps are pre-installed on the camera and must be activated for use with a valid license key.

There are two ways to activate Camera Apps:

 n Online Activation, p. 321 is recommended if the camera is connected to the Internet.

 n Use Offline Activation, p. 323 if the camera is not connected to the Internet.

Online Activation

NOTE! For online activation, the camera must be connected to the Internet and the license server must be 
reachable. Alternatively, you have the option to activate the camera offline (see Offline Activation, p. 323).

After receiving the activation IDs, activate them in MxMC as follows:

 1. Select from the menu Window > Camera App Licenses.

 2. Select the camera on which you want to license apps and click Select.

Management
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 3. An overview of the licenses installed on the camera may be displayed. Click Activate License.

NOTE! If necessary, correct the time set on the camera.

 4. Enter a valid Activation ID and specify the number of licenses to install on this computer.

 5. If you want to license another product, click on . In the new row, enter the appropriate Activation ID 

and the number of licenses you want.

 6. If necessary, click  to remove a line.
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 7. When you have entered all Activation IDs, click Activate License Online. During activation, MxMC con-
nects to the license server. This requires an Internet connection.

Successful activation

After successful activation, a new log in is required to apply the changes. Alternatively, you can return to 

license management .

Offline Activation

NOTE! If the camera is connected to the internet Online Activation, p. 321 is recommended.

For offline activation, the partner/installer from whom you purchased the licenses can generate a capability 
response (bin file) on the license server to activate their licenses.
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 1. Select from the menu Window > Camera App Licenses.

 2. Select the camera on which you want to license apps and click Select.

 3. An overview of the licenses installed on the camera may be displayed. Click Activate License.

NOTE! If necessary, correct the time set on the camera.

 4. Enter a valid Activation ID and specify the number of licenses to install on this computer.

 5. If you want to license another product, click on . In the new row, enter the appropriate Activation ID 

and the number of licenses you want.

 6. If necessary, click  to remove a line.
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 7. When you have entered all Activation IDs, click Download Capability Request File (.lic). and send it to 
your partner/installer. This file allows the partner/installer from whom you purchased the licenses to gen-
erate a capability response file (.bin ) on the license server.

 8. Click Load Capability Response File and follow the instructions.

Successful activation

After successful activation, a new login is required to apply the changes. Alternatively, you can return to 

license management .

Manage licenses
In the license management screen, you get a tabular overview of all licenses that have been activated for a 
camera. 
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 1. Select from the menu Window > Camera App Licenses.

 2. Select the camera on which you want to license apps and click Select.

 3. An overview of the licenses installed on the camera may be displayed.

Field name Explanation

Name Name of the licensed app.

Product The feature of the licensed app

Expiration the time limit of the license 

Quantity Number of licenses purchased for a product.

Serial num-
ber

Unique identification determined by MxMC for the device used. If problems occur during licens-
ing, please have the device ID ready.
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Synchronize licenses with server

When the program starts, there is no automatic comparison of licenses between the computer and the license 
server. Therefore, click on Update to reload the licenses from the server.

Update licenses

to update temporary licenses, click Activate Licenses. The dialog for updating/activating licenses opens.

NOTE! You need administrator rights to synchronize and update licenses.

Integrating MOBOTIX Storage Devices
With MxManagementCenter, you can access a MOBOTIX storage device connected to the USB port with record-
ings in MxFFS format (see Adding Devices and Sources). To do this, MxManagementCenter must be started 
with administrator rights. Without administrator rights, the storage medium will not be recognized.

NOTE! To remove an SD card from a MOBOTIX camera, refer to the camera manual.

MAC
The following procedure assumes that the logged on user is allowed to manage the computer or has the 
required administrator privileges. Otherwise, contact your system administrator.

Management
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 1. Connect the MOBOTIX storage device with a USB port to your MAC.

 2. Start the Terminal App (e.g. via the spotlight search with CMD+space key).

Fig. 155: Starting the Terminal App

 3. Enter the following command line: sudo "/Ap-
plications/MxManagementCenter.app/Contents/MacOS/MxManagementCenter". Confirm with ENTER.

 4. Enter the password for the current user. Confirm with ENTER.

Terminal

MxManagementCenter starts with the administrator profile and is not yet configured, as with a new 
installation.
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 4. Start a new project.

MxMC in administrator profile

 5. Open the editing mode by clicking on  at the bottom of the device bar.
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 6. Click  . The Add and Import menu opens.

Fig. 156: Add / Import menu

 7. Click MxFFS Medium. The USB ports are searched for storage media that contain recordings in MxFFS 
format.

NOTE! This process can take several minutes for data carriers with large storage volumes.

Windows
The following procedure assumes that the logged on user is allowed to manage the computer or has the 
required administrator privileges. Otherwise, contact your system administrator.
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 1. Connect the MOBOTIX storage device with a USB port to your MAC.

 2. Right-click the executable file or a shortcut of the MxManagementCenter.

Fig. 157: Windows start menu
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 3. If necessary, activate the User Account Control query with Yes.

Fig. 158: Windows User Account control

MxManagementCenter starts with the administrator profile and is not yet configured, as with a new 
installation.

 4. Start a new project.

MxMC in administrator profile

 5. Open the editing mode by clicking on  at the bottom of the device bar.
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 6. Click  . The Add and Import menu opens.

Add / Import menu

 7. Click MxFFS Medium. The USB ports are searched for storage media that contain recordings in MxFFS 
format.

NOTE! This process can take several minutes for data carriers with large storage volumes.
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System Configuration
MxManagementCenter allows you to configure MOBOTIX cameras directly. This section 
addresses administrators and system installers. It provides an overview of the operation 
of the Configuration view and the Configuration bar and provides information on how to 
operate the graphical elements. 

Topics Explanation

Configuration: Over-
view, p. 336

Overview of the structure and working with the Configuration view 
and the Configuration bar

Graphical Operation, 
p. 344

Explanations of how to operate the graphical configuration ele-
ments.

6



System Configuration
Configuration: Overview

Configuration: Overview
The Configuration view you to directly access and make settings for MOBOTIX cameras. In general, the view is 
divided into a Basic Settings section and an Advanced Configuration section containing Configuration 
Groups.
The controls at the bottom can be used for actions such as storing the changed settings permanently or reset-
ting the parameter values to their factory settings.
The settings are made for one camera at a time. The Configuration bar on the right margin also offers the pos-
sibility to change the settings of several cameras of a group simultaneously without having to change the cam-
era or the camera group.

NOTE! The Configuration view is not supported by MOBOTIX MOVE cameras and third-party cameras that 
provide an ONVIF-S/G-compatible interface. For an overview of how the camera functions differ, see Cam-
era Feature Overview, p. 9.

Structure of the camera configuration view

Fig. 159: Structure of the camera configuration view
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Basic Settings
The Basic Settings ①  contain basic configuration settings that are important for the setup of cameras and 
camera system. The Basic Settings include the following areas: 

 n General Settings,

 n Network,

 n Time,

 n Image Settings,

 n MxActivitySensor and Recording.

The parameters of the respective topic areas are grouped in tabs. For information about each tab, see Con-
figuring Basic Camera Settings, p. 92.

Fig. 160: Basic settings

Advanced Configuration
The available configuration parameters are thematically grouped in tiles ② . Clicking on a tile opens the topic 
area and tabs for the associated sub-topics.
Some of the topics contain graphical configuration items, such as those for defining exposure windows or 

System Configuration
Configuration: Overview
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detection areas. For more information on how to operate these configuration items see Graphical Operation, 
p. 344.

Extensive information on the setting options and parameters of the individual subject areas are currently 
available only via the help pages of the camera. You can access the camera help table of contents directly 
from MxMC by pressing CMD+Shift+H (Mac) / CTRL+Shift+H (Windows).

Fig. 161: Advanced Configuration
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Fig. 162: Advanced Configuration - Users and Groups

Configuring Advanced Settings

CAUTION! By modifying User Settings, you can loose access to your cameras. Make sure you do not delete 
or move user or passwords you do not know!

 1. Click on the respective tab to open the corresponding topic area.

 2. Make your settings as required by topic. 

NOTE! Clicking on the relevant topic area in the table opens an information page for the individual 
topic areas of the Advanced Configuration settings. 
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Configuration: Overview

339 / 350



System Configuration
Configuration: Overview

Fig. 163: Advanced Configuration - Users and Groups

Applying and saving changed settings

CAUTION! By modifying User Settings, you can loose access to your cameras. Make sure you do not delete 
or move user or passwords you do not know!
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Fig. 164: Applying and saving changed settings

You can use the controls at the bottom of the view to permanently save changed settings or to reset the para-
meter values to factory settings, among other things:

Resetting To Factory Settings

Click on  to reset all parameters for the current camera tab to the factory settings.

Undo/Redo Last Change

Click on  to undo the last change. Click on   to redo the change you previously undid.

Apply Changes

You can make changes by pressing Enter or selecting the new value in the Configuration view. The changes 
made here are not automatically adopted because it could potentially cause problems with the network set-
tings.
    When a value is changed, the checkmark in the Command bar turns red, indicating that the change has not 

been implemented yet. Click  to make this change.

Saving Configurations

If parameter values are changed, the Store Configuration  icon turns red in the Command bar. Initially, 

changes are always temporarily stored in the camera. To ensure that the current settings are also used after 
the next restart, the changes must be saved permanently.

System Configuration
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 1. To do so, click on Store configuration . The program opens a system prompt. In the prompt, click on 

Store.

 2. If you do not want to keep the changes, click on Discard. This discards the changes and restores the last 
permanently saved overall configuration.

Expert Settings

Various sections of the configuration provide additional settings that can be used to change parameters that 
are not necessary for the daily work with MxMC. Note that these settings have been combined as expert set-

tings in the different sections. Click on    to open the expert settings.

Changing Parameter Values For Multiple Cameras In The Configuration 
Bar

CAUTION! By modifying User Settings, you can loose access to your cameras. Make sure you do not delete 
or move user or passwords you do not know!

You can enter parameters for a single camera in the Configuration view. You can use the Configuration bar to 
check which parameter values are available for the other cameras in the group. There you can also change 
the settings of one or multiple cameras in the group without having to switch to a different camera or cam-
era group.

Checking parameter values of other cameras in the group

Fig. 165: Checking parameter values of other cameras in the group
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EXAMPLE: 
Check arming for multiple cameras

 1. Click on the relevant parameter name ① .

 2. It turns yellow and the Configuration bar shows all values associated with this parameter that were 
defined for cameras in this group ② .

Changing a value for one camera or for multiple cameras

Fig. 166: Changing a value for one camera or for multiple cameras

EXAMPLE: 
Change a value using the Configuration bar

 1. Click the appropriate parameter name in the Configuration view ① . It turns yellow and the Con-
figuration bar shows all values associated with this parameter for this group ② . The cameras for which 
this value is set are assigned to the individual values.

 2. Highlight the desired camera and drag it onto the parameter value you want to set. The destination 
area turns yellow.

 3. If the same value is set for several cameras and you want to change this value, click on the parameter 
selection field in the Configuration bar ③ . Then select the desired value.

System Configuration
Configuration: Overview
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Graphical Operation
In the configuration, graphical elements such as exposure windows and detection areas can now be easily 
edited with the mouse. The processing of these graphic elements is subject to a uniform operating concept, 
which is explained in the following table.        

Action Explanation

Create expos-
ure/detection win-
dow

Draw a window using the mouse pointer.

Move the exposure 
window/detection 
area

Left-click on the exposure window / detection area and move it to the desired pos-
ition.

Change the expos-
ure win-
dow/detection area

Move the mouse pointer over one of the white "handles" until the  icon is dis-

played. Left-click with the mouse and drag the window making it larger or smaller.

Rotate the exposure 
window/detection 
area

Click on  and, while holding the mouse button down, rotate the green area clock-

wise or counterclockwise.

Change the shape of 
the exposure win-
dow/detection area

Switch to polygon mode by clicking on . You will see white corner points on the 

corners. Drag the corner points to the desired position. You can insert new corner 
points by right-clicking on the white line or in the green area. Right-click on a dot to 
delete a corner point. Then click on .

Delete expos-
ure/detection win-
dow

Click on  .

Exclude area from 
analysis

Pull open a window of the appropriate size at the position that should be excluded 
from the analysis. Click in the window and keep the mouse button depressed until two 
icons appear. Click on  to determine the exclusion window. The window turns 

red. 

NOTE! The processing status of graphical window elements is indicated by a yellow or a green window 
color. If a window is yellow, it cannot be edited. An example of this are predefined exposure windows. On 
the other hand, green windows, such  as custom exposure windows, can be graphically edited.
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Troubleshooting
This section provides approaches to solutions, e.g. in dealing with the Action Log.

Action Log
All user actions in MxMC are stored chronologically in the Action Log. It is saved as an encrypted XML stream 
as “MxManagementCenter.xml“. The target directory can be set in the Preferences under Monitoring, p. 256 > 
Action Log. It can be exported as CSV and PDF file. The following actions are logged in the Action Log.

Name Id LogCategory Used in Text

GoodbyeLogEntry GdBy elcSystem Application Leaving 
MxManagementCenter.

WelcomeLogEntry Helo elcSystem Application Launching 
MxManagementCenter

LoginLogEntry Lgin elcAccess ProjectUser <TYPE> Login Successful for 
<USER> (<USERROLE>).

UserPasswordChangeEntry Uspc elcAccess ProjectUser Password for user <USER> 
changed.

LogoutLogEntry Lgot elcAccess ProjectUser Logged out <USER> 
(<USERROLE>).

SwitchPageLogEntry Page elcViewing HomeWindow Switching to view <VIEW>.

SwitchViewLogEntry View elcViewing HomeWindow Switching to camera 
<CAMERA>.

SwitchCameraLogEntry Came elcViewing HomeWindow Switching to camera 
<CAMERA>.

SwitchGroupLogEntry Grou elcViewing HomeWindow Switching to 
group<GROUP>.

AutoLogoutEntry AuLo elcAccess Application User logged out due to 
<MINUTES> minutes 
without activity.

SupervisorOnEntry Svon elcAccess SecurityManager Supervisor mode activated.

Troubleshooting
Action Log
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Name Id LogCategory Used in Text

SupervisorOffEntry Svof elcAccess SecurityManager Supervisor mode deac-
tivated.

ExportRangeEntry ExRa elcExport ExportSettingCategory Recording on <CAMNAME> 
will be exported  from 
<STARTDATE> to 
<ENDDATE>.

AudioEntry Audi elcAudio SceneStream <SOURCE> for <CAMNAME> 
(<CAMURL>) was switched 
to <STATUS>.

TriggerEntry Trig elcSoftbutton Cam-
eraActionController

<CAMNAME> (<CAMURL>): 
<TARGET> triggered.

SoftbuttonEntry Sotr elcSoftbutton Cam-
eraActionController

Softbutton <SOFTBUTTON_
NAME> pressed. 
<SOFTBUTTON_URL>)

InstantPlaybackEntry IPla elcPlayback EventPlayerController Playback on camera 
<CAMNAME> started at: 
<TIMESTAMP>.

UserCreatedEntry Uscr elcAccess ProjectUser <USER> (<USERROLE>) cre-
ated.

UserRemovedEntry Usre elcAccess ProjectUser <USER> (<USERROLE>) 
deleted.

SingleAlarmConfirmation SCfm elcAlarm EventTableView Camera alarm confirmed: 
<CAMNAME>, <DATE>, 
<ALARMTYPE>, 
<COMMENT>.

AllAlarmsConfirmation ACfm elcAlarm EventTableView Camera alarms confirmed: 
<CAMNAME>, 
<STARTDATE>...<STOPDAT-
E>, <COMMENT>.

AlarmTypeConfirmation TCfm elcAlarm EventTableView Camera alarms confirmed: 
<CAMNAME>, 
<STARTDATE>...<STOPDAT-
E>, <ALARMTYPE>, 
<COMMENT>.
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ThinClientTrigger TCSw elcViewing Cam-
eraActionController

MxThinClient 
<THINCLIENTNAME>: switch-
ing to camera 
"<CAMNAME>".

ThinClientStop TCSt elcViewing Cam-
eraActionController

MxThinClient 
<THINCLIENTNAME>: resum-
ing normal operation.

LiveRecorderStarted LRSa elcExport LiveRecorder Live recording for 
<CAMNAME> started. 

LiveRecorderStopped LRSo elcExport LiveRecorder Live recording for 
<CAMNAME> stopped. 

LiveRecorderChanged LRCh elcExport LiveRecorder Live recording switched to 
<CAMNAME>. 

LicenseUpdateLogEntry LiUp elcAccess LicenseHandler Licenses have been updated 
with License Server. 

LicenseFileWroteLogEntry LiWr elcAccess LicenseHandler Capability Request file writ-
ten to disk.

LicenseFileReadLogEntry LiRe elcAccess LicenseHandler Capability Response file 
read from disk.

FlashConfigLogEntry Flsh elcSystem ConfigViewWidget Configuration of 
"<CAMNAME>" stored.

DeviceDirtyLogEntry Dirt elcSystem KuratorViewWidget Configuration of 
<CAMNAME> changed.

SecureSystemCheck SeCh elcSystem SecureSystemManager Performing security check 
on device <CAMNAME>.

SystemSecured SySe elcSystem SecureSystemManager System secured for device 
<CAMNAME>.

ActionLogContextSwitchEntry ALog elcGeneral ActionLog Switched logging from 
<LOGNAME1> to 
<LOGNAME2>.

ActionLogReadingFail ALer elcGeneral ActionLog File is corrupt or missing; 
creating a new file. 

Troubleshooting
Action Log
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Name Id LogCategory Used in Text

InvalidPasswordLogEntry Cred elcAccess StartupDialog Invalid password entered 
for <USER> (<USERROLE>).

Super-
visorPasswordChangeEntry

Svpw elcAccess ProjectUser Password for supervisor 
changed.

CameraPlaybackEntry CPla elcPlayback PlayerViewWidget Playback on camera 
"<CAMNAME>" started. 

GroupPlaybackEntry GPla elcPlayback PlayerViewWidget Playback on group 
"<GROUPNAME>" started. 

ActionLogReconnectEntry, ReCo elcSystem Application Action Log Backup Path 
Reconnection. Path was not 
available from 
<STARTDATE> to 
<ENDDATE>.

ActionLogDisconnectEntry Disc elcSystem Application Action Log Backup path not 
available since <DATE>.

IdentifyLogEntry WSID elcSystem Application Action Log created by work-
station = <MACHINENAME>.

ChangeALPathLogEntry Chan elcSystem PreferencesDialog Action Log path changed to 
<NEW= PATH>.

PathNotFoundLogEntry PaNA elcActionLog ActionLogFileWriter Path <PATH> not found. 
Could not write Action Logs.

DefaultPathUsedLogEntry PaNa elcActionLog ActionLogFileWriter Path <PATH> not found; 
default path 
<DEFAULTPATH> used.

AutomaticAlarmConfirmation AtCm elcAlarm EventTableModel Camera alarm confirmed: "

<CAMNAME>, <TIMESTAMP>, 
<TYPE>.

EmailAdapterMailSent MSen elcActionLog EmailAdapter Email has been sent to: 
<ADDRESS>, Subject: 
<SUBJECT>.

SnapshotLogEntry Snap elcSystem HomeViewWidget Snapshot saved.

SnapshotErrorLogEntry SErr elcSystem HomeViewWidget Failed to save snapshot.
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SnapshotAutomaticLogEntry Saut elcSystem HomeViewWidget Automatic snapshot gen-
eration (for non-event-
stream streams).

ParseXMLLogEntry XmlP elcError LogEntry Error '%1' reading action 
log '= %2' in line '%3', 
column '%4'.

ExportReasonEntry ExCo elcExport ExportManager Comment for Export: %1

ResearchViewReasonEntry SwCo elcViewing HomeWindow Comment for switch to 
research view: %1

Troubleshooting
Action Log
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